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Assalamualaikum Warahmatullahi Wabarakatuh dan Salam Sejahtera. 

Syukur ke hadrat Ilahi kerana dengan izin-Nya Modul Pembelajaran Kurikulum Standard Sekolah 

Menengah (KSSM) Mata Pelajaran Vokasional (MPV) Tingkatan 5 dapat disempurnakan 

penerbitannya. 

 
Dalam menangani hala tuju serta pembangunan dunia pendidikan hari ini, Bahagian Sumber dan 

Teknologi Pendidikan (BSTP), Kementerian Pendidikan Malaysia berusaha menyediakan bahan 

pembelajaran ini sebagai satu dokumen sumber rujukan utama para murid dan guru MPV yang 

dapat memenuhi keperluan semasa dalam bidang pendidikan kemahiran vokasional. Modul 

pembelajaran ini dibina berasaskan kandungan Dokumen Standard Kurikulum dan Pentaksiran 

(DSKP) bagi membantu murid menguasai bidang pengetahuan dan kemahiran yang berkaitan di 

samping dapat melahirkan insan yang produktif serta seimbang dari segi intelek, rohani, emosi 

dan jasmani. Bagi merealisasikan hasrat ini, modul pembelajaran ini juga menjadi panduan 

kepada guru dalam melaksanakan pengajaran dan pembelajaran (PdP) yang berkesan. 

 
BSTP amat menghargai segala idea dan usaha yang telah digembleng bersama semasa 

menerbitkan modul pembelajaran ini. Setiap kejayaan dasar pendidikan dan program yang 

menyokong dasar tersebut hendaklah dilaksanakan dengan kefahaman dan kerjasama yang 

kukuh daripada semua pihak terutamanya warga pendidik. Semoga usaha murni ini dapat 

mencapai objektif dan matlamat yang diharapkan. BSTP berharap agar modul ini dapat menjadi 

antara sumber rujukan dan panduan penting bagi menentukan garis utama hala tuju pendidikan 

di Malaysia. 

 
Akhir kata, BSTP mengambil kesempatan ini untuk mengucapkan syabas dan setinggi-tinggi 

tahniah dan jutaan terima kasih kepada panel penulis, panel kawalan mutu, Pejabat Pendidikan 

Daerah (PPD), Jabatan Pendidikan Negeri (JPN), pegawai mata pelajaran Bahagian Pendidikan 

dan Latihan Teknikal Vokasional (BPLTV), pegawai BSTP dan juga semua pihak yang telah 

bekerjasama menjayakan penerbitan modul pembelajaran MPV ini. 

 
Sekian, terima kasih. 

Pengarah 

Bahagian Sumber dan Teknologi Pendidikan 

Kementerian Pendidikan Malaysia 

KATA PENGANTAR 
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Modul Pengajaran dan Pembelajaran (PdP) ini dibangunkan berdasarkan 

Dokumen Standard Kurikulum dan Pentaksiran (DSKP) Mata Pelajaran Vokasional 

(MPV) Produksi Multimedia bertujuan untuk membantu guru merancang dan melaksana 

pelbagai strategi pengajaran dan pembelajaran di dalam bilik darjah dengan efektif dan 

berkesan. Modul PdP ini dibangunkan sebagai panduan dan guru boleh merancang 

sendiri atau mengubahsuai strategi PdP mengikut tahap penguasaan murid di sekolah 

masing-masing. 

Guru perlu merancang PdP mengikut Standard Kandungan, Standard 

Pembelajaran dan Standard Prestasi dengan menyediakan Bahan Bantu Mengajar 

(BBM) untuk kegunaan murid bagu aktiviti PdP yang terdapat dalam Modul PdP KSSM 

MPV Produksi Multimedia. 

Justeru itu, adalah diharapkan hasrat yang terkandung dalam kurikulum Produksi 

Multimedia dapat difahami dan dilaksanakan dengan baik oleh guru dengan 

menggunakan Modul PdP Produksi Multimedia. Sesi PdP yang terancang dapat 

mematikan objektif pembelajaran yang dirancang tercapai bagi menghasilkan murid yang 

berilmu pengetahuan, berkemahiran, serta mempunyai nilai dan etika profesionalisme 

dan seterusnya dapat melahirkan murid yang mampu menjana idea kreatif dan inovatif, 

bijak membuat keputusan serta berdaya saing untuk menyumbang kepada 

pembangunan dan kemajuan negara dalam aspek multimedia.

PENGENALAN 
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MODUL 6 : 
 

ELEMEN ANIMASI 
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MODUL 6.0  
 

Standard 

Kandungan: 

 

6.1 Asas Animasi 

Standard 

Pembelajaran:  

6.1.1 Menjelaskan keperluan animasi dalam 

persembahan multimedia. 

6.1.2 Menerangkan konsep animasi. 

6.1.3 Membezakan jenis dan teknik animasi: 

(i) Tradisional 

(ii) Digital 

6.1.4 Menghasilkan animasi tradisional flipbook. 

 

Objektif 

Pembelajaran 

1. Menyatakan keperluan animasi dalam 

persembahan multimedia. 

2. Menjelaskan konsep animasi. 

3. Membanding beza jenis dan teknik animasi 

4. Menghasilkan animasi tradisional flipbook 

bertema. 

 

Masa: 

 

 

 

6 jam 
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NOTA RUJUKAN 
 
6.1.1 Keperluan Animasi Dalam Persembahan Multimedia 

 

Dalam persembahan multimedia, animasi merupakan salah satu elemen yang 

mampu meningkatkan lagi daya tarikan sesebuah produk atau perisian multimedia. 

Animasi merujuk kepada paparan visual yang bersifat dinamik. Antara keperluan 

animasi dalam persembahan multimedia ialah  

 

• Menjadikan objek atau teks kelihatan hidup tetapi pada asalnya adalah statik.  

• Dapat menerangkan sesuatu yang sukar disampaikan dengan lebih mudah 

dan berkesan. 

• Mampu memberi penegasan bagi membolehkan penonton fokus pada isi 

kandungan yang ingin disampaikan. 

 

6.1.2 Konsep Animasi 

 

Animasi secara ringkasnya merujuk kepada kaedah untuk memberikan ilusi 

pergerakan optik kepada urutan imej statik. Animasi juga boleh merujuk kepada set 

grafik yang dipaparkan dengan pantas dalam bentuk siri bingkai (frame). 

 

6.1.3 Jenis-Jenis Animasi 

a. Animasi Tradisional 

ü Sebelum berkembangnya teknologi animasi komputer, semua animasi 

tradisional dilaksanakan menggunakan tangan.  

ü Setiap satu saat animasi memerlukan sekitar 20 bingkai.  

ü Bagi penghasilan animasi selama dua minit , seseorang juruanimasi 

memerlukan sekitar 2400 helaian imej.  
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b. Animasi Digital 

ü Dikenali juga sebagai animasi komputer. 

ü Dua jenis animasi digital iaitu animasi 2D dan 3D. 

ü Animasi 2D merupakan animasi yang melibatkan objek dengan 

dimensi mendatar (paksi-x) dan dimensi menegak (paksi-y). Contoh 

perisian yang boleh digunakan untuk membuat animasi 2D ialah 

Macromedia Flash, Swish Max, Toonz, Toon Boom Studio dan lain-lain. 

ü Animasi 3D pula merupakan animasi yang melibatkan objek dengan 

dimensi mendatar (paksi-x), dimensi menegak (paksi-y), dan dimensi 

kedalaman (paksi-z). Contoh perisian yang boleh digunakan untuk 

membuat animasi 3D ialah MAYA, 3Ds Max, Light Wave, 3D Cinema 

4D, Blender dan lain-lain. 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Digital 

Animasi laluan (path animation) 

Animasi skrin atau transisi objek 

Animasi aksara dan ikon 

Animasi morphing 

Tradisional 

Animasi  lukisan tangan( handrawn) 

Animasi model  stop motion 

Animasi thaumatrope 

Teknik-teknik animasi 
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Teknik Animasi Tradisional 

 
• Animasi Lukisan Tangan (Handrawn) 

Animasi lukisan tangan adalah proses penghasilan helaian imej yang 
menunjukkan objek sedang bergerak. 

 

 
Rajah 6.1.1: Animasi lukisan tangan 

 
• Animasi  Model  Stop Motion 

 
Animasi ini menggunakan model yang diperbuat daripada tanah liat, boneka, 

potongan kertas dan lain-lain lagi. Juruanimasi akan menggerakkan model pada 

pelbagai posisi berbeza dan setiap pergerakan tersebut akan diambil gambar. 
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Rajah 6.1.2: Animasi model stop motion 
 
 

• Animasi Thaumatrope 

Menggunakan cakera atau kad dengan meletakkan dua gambar yang berbeza 

di setiap sisi yang diikat pada seutas tali.  Ketika tali diputar dengan cepat antara 

jari, dua gambar muncul untuk bergabung menjadi satu gambar. 

 

 

 

 

 

 

 

 

 

Rajah 6.1.3: Animasi thaumatrope 

Teknik animasi  Digital  

• Animasi laluan (path animation) 

Merupakan animasi yang mudah untuk dipelajari dan dihasilkan.  Objek mudah 

digerakkan di sepanjang laluan yang telah ditetapkan pada skrin. Laluan boleh 

merupakan garisan lurus atau lengkung. Kebiasaannya, objek yang bergerak 

tidak akan berubah kepada objek lain namun ia berubah dari sudut saiz dan 

bentuk. 



7 

 

 
Rajah 6.1.4: Animasi laluan (path animation) 

• Animasi skrin atau transisi objek 

Dikenali sebagai transisi atau transition yang merujuk kepada peralihan dari satu 

persembahan kepada satu persembahan yang lain. Contohnya, skrin 

berterbangan dari suatu arah ataupun skrin semakin kabur sebelum digantikan 

dengan skrin persembahan yang baharu. Transisi boleh diletakkan pada 

keseluruhan skrin atau pada objek-objek yang dipilih. 

 

 

 

 

 

 

 

 

Rajah 6.1.5: Animasi skrin atau transasi objek 
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• Animasi Aksara Dan Ikon  

Animasi aksara merupakan animasi pada aksara terpilih dan mampu 

menghidupkan sesuatu persembahan elektronik. Animasi ikon atau animasi 

sprite melibatkan pertukaran ikon yang sedia ada kepada ikon yang lain 

apabila ditekan oleh pengguna. Animasi ini banyak digunakan dalam 

pembangunan perisian multimedia, internet, kiosk dan sebagainya.  

 
 
 

 

 

 

 

Rajah 6.1.6: Animasi ikon 

• Animasi morphing  

Animasi morphing adalah proses yang membolehkan peralihan dari satu 

gambar ke gambar yang lain dengan lancar. Ia juga menunjukkan perubahan 

pada saiz dan bentuk. Animasi ini menggunakan perisian khas yang boleh 

mengesan ciri-ciri tertentu dalam gambar seperti wajah, mulut, mata, hidung 

dan sebagainya. Kemudian akan memadankan dengan gambar yang 

seterusnya. Oleh itu, gambar utama akan berubah perlahan-lahan menjadi 

gambar yang baharu. 

 

 

 

 

Rajah 6.1.7: Animasi morphing 
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6.1.4 Penghasilan Animasi Tradisional Flipbook 

 

Animasi flipbook atau kineograph adalah satu teknik animasi tradisional yang 

menghasilkan illusi pergerakan dengan memaparkan urutan imej statik secara pantas. 

Animasi flipbook boleh dihasilkan dengan menyediakan sebuah buku kecil yang 

mempunyai beberapa helaian muka surat yang mengandungi  imej atau teks yang 

sama tetapi memiliki posisi yang berbeza pada setiap helaian untuk memberi illusi 

pergerakan. 

 

 

 

 

 

 

 

 

Animasi tradisional flipbook 

Rajah 6.1.8: Flipbook 
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Lankah-langkah untuk menghasilkan animasi tradisional flipbook HAPPY BIRTHDAY 
 
1. Bahagikan kertas A4 pertama kepada 4 bahagian. 

2. Potong keempat-empat bahagian. 

3. Ulang langkah 1 dan 2 untuk kerjas A4 kedua dan ketiga (12 kepingan kecil 

kertas A4 terhasil) 

 
 
 
 
 
 
 
 
 
 
 

4. Lukis lakaran awal teks yang ingin dianimasikan. 
 

 
 
 
 
 
 
 
 
 

 
 

5. Buka pad penekap LED (LED tracing pad) dan mula menekap teks demi teks. 
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6. Tekapkan teks yang sama berulang-ulang tetapi pada posisi yang berbeza- 
beza. 

 
 
 
 
 
 
 

 
 
 
 
 

7. Teks yang telah ditekap berulang kali pada pelbagai posisi siap untuk 
dianimasikan dengan cara menyelak helaian tersebut dengan cepat. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Sumber rujukan : https://www.youtube.com/watch?v=SU3zexN_h1I 
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1. Kertas A4   
2. Pensel 2B 
3. Gunting / alat pemotong 
4. Pelapik pemotong (Cutting mat) 
5. Pembaris 
6. Pemadam 
7. Klip kertas 
8. Pad Penekap LED (LED tracing pad) 

 

TUGASAN  

 
- Murid menghasilkan animasi flipbook bertema (rujuk   
           nota sebelum ini) 
- Murid mempersembahkan hasil kerja di hadapan guru   
           dan rakan-rakan. 
 

 
 

LANGKAH KERJA (TUGASAN 1) 
 
1. Sediakan tiga helai kertas A4 yang sama saiz untuk dijadikan flipbook. 

2. Lukis imej berdasarkan tema pada setiap helaian kertas tadi. 

3. Himpunkan setiap helaian kertas yang telah dilukis imej  secara berturutan. 

4. Gerakkan setiap helaian kertas dengan pantas untuk mendapatkan animasi 

flipbook. 
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Rajah 6.1.9: Contoh lakaran imej bagi animasi flipbook 

 

Sumber : https://www.wikihow.com/Make-a-Flipbook 
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LATIHAN/ PENILAIAN 
 

1. Nyatakan teknik animasi yang betul sama ada animasi tradisional atau digital bagi 

contoh animasi di bawah. 

 

Contoh Animasi Teknik Animasi 

Animasi laluan (path animation)  

Animasi thaumatrope  

Animasi model  stop motion  

Animasi aksara dan ikon  

 

2. Padankan teknik animasi berikut mengikut ciri-ciri yang betul. 

 

Animasi morphing  Objek digerakkan disepanjang 

laluan yang telah ditetapkan 

pada skrin. 

Animasi model  stop 

motion 

 

 Menggunakan cakera atau kad 

dengan meletakkan dua 

gambar yang berbeza di setiap 

sisi yang diikat pada seutas tali.   

Animasi laluan (path 

animation) 

 Menggunakan perisian khas 

yang boleh mengesan ciri-ciri 

tertentu dalam gambar. 

Animasi thaumatrope  Menggunakan model yang 

diperbuat daripada tanah liat 

atau boneka.   
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  
Tahun:  
Kelas  

 
Standard 
Kandungan: 

6.1 Asas Animasi 

Standard 
Pembelajaran: 

6.1.1 Menjelaskan keperluan animasi dalam persembahan 

multimedia. 

6.1.2 Menerangkan konsep animasi. 

6.1.3 Membezakan jenis dan teknik animasi: 

(i) Tradisional 

(ii) Digital 

6.1.4 Menghasilkan animasi tradisional flipbook. 

 

Bil Perkara yang dinilai 

Pencapaian 

Catatan 
Terampil 

Belum 

Terampil 

1 
Menyatakan keperluan animasi 

dalam persembahan multimedia. 
   

2 Menjelaskan konsep animasi.    

3 
Membanding beza jenis dan teknik 

animasi. 
   

4 
Menghasilkan animasi tradisional 

flipbook bertema. 
   

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 

 
Nama Guru:  Tandatangan & 

Tarikh 
 

Disahkan 
oleh: 

 Tandatangan & 
Tarikh 
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MODUL 6.2 A 

 
 
 
 

Standard 

kandungan: 

 

6.2 Animasi 2D 

Standard 

pembelajaran:  

6.2.1 Menerangkan konsep frame dan keyframe. 

6.2.2 Mengenal pasti fungsi alat dan fitur asas yang 

digunakan dalam perisian animasi 2D. 

6.2.3 Menghasilkan dan mewarna objek dengan 

menggunakan alat dan fitur yang sesuai dalam 

perisian animasi 2D. 

6.2.4 Membuat suntingan objek dan teks dengan 

menggunakan alat dan fitur yang sesuai. 

Objektif 

Pembelajaran : 

1. Menyatakan konsep frame dan keyframe dalam   

perisian animasi 2D. 

2. Menyenaraikan fungsi alat dan fitur asas yang 

digunakan dalam perisian animasi 2D 

3. Menghasilkan dan mewarna objek dengan 

menggunakan alat dan fitur yang sesuai dalam 

perisian animasi 2D  

4. Menghasilkan suntingan ke atas objek dan teks. 

 

Masa: 10  jam 
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NOTA RUJUKAN 
 
Konsep Frame, Keyframe Dan Blank Keyframe Dalam Flash  

 

Frame adalah komponen pada tetingkap kerja Flash yang berfungsi 

untuk  menentukan durasi animasi  sesebuah objek. Semakin banyak frame, semakin 

lama objek akan dimainkan/dianimasikan. Frame ditanda dengan kotak putih 

dengan garis hitam dalam Flash. 

 

Frame per second disingkat FPS adalah jumlah frame yang dimainkan setiap saat, 

sama seperti dalam video. 

 

Keyframe adalah kunci frame. Keyframe berfungsi untuk menentukan bila sebuah 

objek akan muncul pada sesebuah animasi. Keyframe mempunyai sebuah objek 

atau lebih. Keyframe ditanda dengan bulatan berwarna hitam. Keyframe yang tidak 

mempunyai objek dikenali sebagai Blank keyframe. 

 

Blank keyframe adalah sebuah kunci frame kosong. Blank keyframe berfungsi untuk 

menempatkan  sebuah objek atau lebih pada frame. Blank keyframe ditanda 

dengan lingkaran berwarna putih dengan garis berwarna hitam. 

 

Perisian Menghasilkan Animasi 2D 

(Perisian Flash) 

 

Macromedia Flash MX ialah satu perisian yang berupaya diaplikasikan dalam 

pelbagai aras pengarangan multimedia, khususnya interaktif menerusi web. Ia adalah 

perisian yang berasaskan Timeline yang dapat memenuhi keperluan perisian 

pengarangan multimedia, perisian grafik dan perisian animasi. Ia juga berupaya 

membenarkan elemen interaktif digunakan dengan mudah dan berkesan.  
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Modul ini menyediakan beberapa kemudahan kepada pengguna, supaya dapat 

mempelajari aspek-aspek utama yang terdapat dalam Macromedia Flash MX.  Pada 

akhir modul ini pengguna akan dapat menghasilkan satu persembahan interaktif yang 

mudah.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Rajah 
6.2.1: 

Antaramuka Flash MX 
 
 
1. Menu bar (bar menu) 
 Mengandungi arahan-arahan kawalan serta fungsi-fungsi asas. 
 
2. Toolbox (kotak alatan) 
 Mengandungi alatan kerja yang mempunyai fungsi dan peranan yang tertentu. 

Ia dapat digunakan dengan cara mengaktifkannya. Setiap item yang dipilih 
boleh ditentukan spesifikasi atau ciri-cirinya pada pilihan option. 

 
3. Timeline (garisan masa) 
 Ia mengandungi bilangan nombor yang mewakili setiap frame (bingkai).  Ia juga 

mengandungi layer (lapisan) untuk susunan kerja. Kawasan Timeline ini digunakan 
untuk elemen-elemen didalam aplikasi Flash disusun serta ditentukan peranan 
dan arahannya. 

 
 
 
 

 

2 

4
1 

1 

3
1 

5
1 
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4. Stage (pentas kerja) 
 Merupakan kawasan atau lokasi untuk meletakkan isi kandungan suatu 

persembahan dan dipaparkan kepada pengguna. Stage ini boleh diubah 
saiznya mengikut keperluan persembahan yang hendak dibangunkan. 

 
5. Tetingkap 

Tetingkap bagi : 
 
  color mixer  – menentukan tahap campuran warna 
  color swatches  – pemilihan warna 
  components  – pilihan alatan bagi antaramuka  

   pengguna 
  answers   – maklumat berkaitan  
        Macromedia Flash MX 
   actions     – pilihan arahan action  
  properties   – maklumat tentang suatu pilihan  
        kerja yang dibuat 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

  Rajah 6.2.2: Toolbox 
 

 

arrow 

line 

pen 

subselection 

lasso 

text 

rectangle oval 

pencil 

free transform Fill transform  
ink bottle 

eyedropper 
paint bucket 

eraser 

zoom hand 

stroke color fill color 

brush 
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Berikut  adalah tools yang terdapat di dalam flash yang digunakan untuk melukis. 

 

-    Arrow Tool 

Ikon arrow tool d ig u n a k a n u n t u k m e n g a k t i f k a n s e s u a t u g a r i s a n a t a u  objek.   

Ia sering digunkan untuk mengubahsuai bentuk sesuatu garisan atau objek serta 

memindahkannya dari satu lokasi ke satu lokas i  yang lain . 

 

-    Line Tool 

Untuk membina suatu garisan yang menarik , anda boleh menggunakan  ikon line 

tool. Garisan yang dibina boleh berbentuk lurus , melengkung , condong dan 

sebaginya . 

Nota :  mengubahsuai  warna , ketebalan  dan  rupa bentuk  garisan boleh 

dilaksanakan dengan membuat pilihan pada panel stroke . 

 

-    Oval Tool 

Oval tool digunaka n untuk membina  objek berbentuk bulatan atau bujur . Bentuk 

objek yang dilukis akan terdiri daripada fill dan juga stroke berdasarkan 

pemilihan warna pada bahagian color toolbox . 

 

-    Rectangle Tool 

Rectangle tool digunakan untuk membina objek berbentuk segiempat sa mada 

mempunyai  bucu  yang tajam atau berbentuk  separa  membulat  dengan 

memasukan nilai radius bagi Ro und Re ctagles Radius pada bahagian option 

toolbox . Seperti oval tool, bentuk objek yang dilukis akan terdiri daripada fill 

dan juga stroke berdasarkan pemilihan warna pada bahagian colo r toolbox . 

 

-    Pen Tool 

Ikon pen tool  sering  digunkan untuk membina garisan yang  lurus  dan juga 

melengkung.  Ikon ini mempunyai fungsi yang sama dengan line tool tetapi ia 
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mempunyai titik (dot) yang membenarkan garisan tersebut diubahsuai bentuknya 

setelah ia siap dibina .  Sekira n y a garisan yang dibina membentuk satu objek 

yang mempunyai garisan yang tertutup (bersambung) , objek tersebut akan 

mempunyai warna mengikut warna yang ditetapkan pada kotak fill di Toolbox 

atau ditetingkap panel fill . 

 

-   Pencil Tool 

Ikon  penci l tool sering digunakan  untuk membina garisan  atau  objek yang 

seakan-akan terhasil menerusi lakaran pensel. Tool ini membenarkan  anda melukis  

dengan bebas secara  manual. Warna  bagi  garisan atau objek yang terbentuk 

adalah berdasarkan pilihan warna stroke . 

Ikon pensil tool mempunyai 3 mod pada bahagian option  toolbox : 

• Straighten – garisan yang dilukis akan diluruskan seboleh  yang mungkin 

secara automatik. 

• Smooth   - garisan yang dilukis akan dilicinkan secara automatik . 

• Ink  - garisan yang d ilukis akan diubahsuai sedikit dan  dilicinkan  secara 

automatik . 

 

-    Lasso Tool 

Ikon lasso tool digunakan untuk membina kawasan pilihan yang  tertentu pada 

sesuatu objek dengan kadar yang lebih bebas. Ikon ini mempunyai 2 jenis 

mod:  

• Magic Wand – sesuai digunakan untuk membina kawasan  pilihan 

berdasarkan keserataan warna (biasanya digunakan untuk imej bitmap) 

• Polygon M ode - sesuai digunakan untuk membina kawasan  pilihan yang 

berbentuk polygon atau bersegi . 

 

-    Eraser Tool 

Eraser Tool di gunakan untuk memadam bahagian tertentu pada objek yang 

tidak d igunakan lagi . Ikon erasaer tool mempunyai 5 mod pada bahagian  
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Option Toolbox : 

• Erase Normal – membolehkan garisa n yang membentuk objek dan warna 

yang memenuhi objek dipadam jika berada dalam layer yang sama. 

• Erase Fill – membolehkan hanya bahagian dalaman sesuatu objek 

dipadam. 

• Erase Lines – membolehkan hanya garisan yang membentuk  objek  

sahajaakan dipadam. 

• Erase Selected Fills – membolehkan hanya bahagian yang  dipilih atau 

diaktifkan sahaja dipadam . 

• Erase Inside – membolehkan keseluruhan bahagian dalaman objek yang 

dilingkungi garisan yang tertutup  sahaja dipadam . 

 

Melukis sesuatu imej di dalam  Flash melibatkan dua  elemen yang utama iaitu 

strokes dan fills .  Anda boleh  melukis garisan yang hanya melibatkan stroke atau 

boleh juga melukis objek tanp a  stroke atau kedua-duanya sekali . 
                                    N o t a : 

 
 

Sebelum melukis dan mewarna , adalah penting untu k memahami bahawa 

melukis , mewarna dan mengubahsuai objek akan memberi kesan kepada objek 

yang lain di dalam layer yang sama sekiranya  objek terebut diletakkan secara  

berlapis . 

Untuk mengelakan ini berlaku , pastikan setiap objek yang telah dilukis 

disatukan  terlebih dahulu (Modify  > Group @ Ctrl+G). 
 
Dan sekiranya ingin mengubahsuai objek yang telah disatukan , objek tersebut 

perlu dipisahkan (Modify > Ungroup @ Ctrl+Shift+G  atau Modify > Break @ Ctrl+ B . 

 

Stroke 

Fill 
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AKTIVITI : MEMBUAT TETAPAN (SETTING) ASAS DALAM FLASH 
 

BAHAN DAN PERALATAN  

1. Komputer 

2. Perisian Macromedia Flash 

 

TUGASAN  

Murid membuat tetapan (setting) asas dalam Macromedia Flash. 
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Aktiviti 1: Saiz Dan Warna Latar Stage 

 

Langkah-Langkah: 

1. Buka perisian Macromedia Flash MX dengan cara klik pada butang   

 Start > Program > Macromedia > Macromedia Flash MX. 

2. Satu paparan antaramuka Macromedia Flash MX muncul (seperti Rajah 6.2.1). 

3. Klik pada tetingkap properties. 

4. Satu tetingkap document properties akan muncul.  

 
 
 
 
 
 
 
5. Pilih tab size dan tentukan dimensions pada aras 800 px width dan  

 600 px height. 

 

 

 

 

 

 

 

6. Seterusnya pilih tab background color untuk menentukan pemilihan warna latar 

stage (hijau- #00FFCC). 
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Aktiviti 2 : Menamakan Scene Dan Layer 
 
Langkah-Langkah : 

1. Klik menu Modify pada menu bar dan pilih scene 

 

 

 

 

 

 

 

 

2. Tetingkap scene muncul dan klik dua kali pada “scene  1” kemudian taipkan 

nama scene yang baru “teks”. 

 
3. Ulangi langkah 1 dengan pilihan layer untuk memaparkan tetingkap layer 

properties dan pada tab Name taipkan “menu” untuk memberi nama pada 

layer. 
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Aktiviti 3: Tambah scene 

 

Langkah-Langkah : 

1. Anda masih dalam fail “ belajarflash “ scene “teks”. 

2. Klik menu Insert pada menu bar dan pilih Scene untuk tambahkan scene baru.  

 

 

 

 

 

 

 

 

 

 

3. Namakan scene baru sebagai “grafik”. 

4. Namakan layer 1 sebagai “grafik1”. 

5. Timeline kelihatan seperti berikut. 

 

 

 

 

 

 

 

 

 

 

 

paparan nama scene 

nama layer 
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Aktiviti 4 : Menyimpan hasil kerja 

 

Langkah-Langkah : 

1. Anda masih dalam scene kerja di aktiviti 1 dan 2. 

2. Klik menu File > save as untuk menyimpan hasil kerja anda. 

 
3. Simpan hasil kerja anda dengan nama fail “belajarflash”. 

 

 

 

 

 

 

 

 

 

 

4. Hasil kerja bagi aplikasi Flash boleh disimpan dalam 2 keadaan: 

• Flash MX Document(*.fla) 

 Dalam keadaan ini persembahan yang dibina masih lagi dapat diubah suai. 

• Flash Movie(*.swf) 
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 Dalam keadaan ini, suatu persembahan yang siap dibina untuk 

dipersembahkan dalam bentuk movie. Ia tidak lagi boleh diubah suai. 

Langkahnya ialah pilih menu File > Export Movie dan masukkan nama fail. 

 

AKTIVITI : MENGHASILKAN DAN MEWARNA OBJEK 
 

BAHAN DAN PERALATAN  

1. Komputer  

2. Perisian Macromedia Flash 

 

TUGASAN  

Murid menghasilkan dan mewarna objek asas menggunakan tool 

dalam Flash. 
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Aktiviti 1: Objek Segi Empat 

 

Langkah-Langkah: 

1. Anda bekerja dengan fail “belajarflash” dalam scene “grafik” dan layer 

“grafik1”. 

2. Taipkan satu teks “GRAFIK” pada stage untuk dijadikan sebagai tajuk 

persembahan dalam scene ini dan laraskan mengikut kesesuaian. 

3. Tambahkan layer baru dan namakan “segiempat”. 

Aktifkan Rectangle Tool          pada Toolbox.  

4. Klik pada tetingkap Properties. 

5. Tetingkap Properties Rectangle Tool dipaparkan dan laraskan seperti rajah di 

bawah dengan cara klik pada setiap tab yang diperlukan. 

 

 

 

 

 

 

6. Klik dan seretkan tetikus ke kanan pada stage untuk mendapatkan saiz segi 

empat yang sesuai. 

 

 

 

 

 

 

 

 

Stroke Color Fill Color Stroke Height Stroke Style 
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Aktiviti 2 : Objek Bulat 

 

Langkah-Langkah: 

1. Anda masih dalam fail “belajarflash” dan scene “grafik”. 

2. Tambahkan layer baru pada timeline dan namakan sebagai “bulat “. 

3. Aktifkan Oval Tool           pada Toolbox (rujuk Rajah 6.2.2) dan laraskan mengikut 

keperluan pada tetingkap properties seperti dalam Tugasan 1, aktiviti 2. 

4. Klik dan seretkan kursor pada stage untuk menghasilkan sebuah bulatan. 

 

 

 

 

 

 

 

 

 

Aktiviti 3: Objek Segi Tiga 

 

Langkah-Langkah: 

1. Anda masih dalam fail “belajarflash” scene “grafik”. 

2. Tambahkan layer baru dan namakan sebagai “ segitiga “. 

3. Aktifkan Line Tool            pada Toolbox (rujuk Rajah 6.2.2) laraskan mengikut 

keperluan pada tetingkap properties seperti dalam Tugasan 1, aktiviti 2. 

4. Sebelum membina segitiga menggunakan arahan line tool, pastikan anda 

memilih menu View > snap to objects pada menu bar untuk mempastikan setiap 

garisan akan bersambung. 
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5. Bina tiga garisan yang bersambung untuk membentuk sebuah segi tiga. 
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Aktiviti 4 : Objek Oval 

Langkah-Langkah: 

1. Anda masih dalam fail “belajarflash” dan scene “grafik”. 

2. Tambahkan layer baru dan namakan “oval”. 

3. Aktifkan Rectangle Tool pada Toolbox (rujuk rajah aktiviti 2) dan hasilkan satu 

lagi segi empat pada stage. 

4. Laraskan mengikut kesesuaian pada tetingkap properties. 

5. Bina sebuah segi empat pada stage. 

 

 

 

 

 

 

 

 

6. Aktifkan Arrow Tool pada Toolbox . 

7. Gerakkan kursor kepada sisi sebelah kanan segi empat sehingga muncul satu 

tanda lengkung            bersama kursor. 

8. Klik pada sisi tersebut dan seretkan ke kanan untuk menghasilkan garis tepi yang 

melengkung. 

9. Dalam keadaan Arrow Tool masih aktif, ulang langkah 7dan 8 untuk garis tepi 

sebelah kiri. 

 

 

 

 

 

 

 k 
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10. Simpan hasil kerja anda. 

Aktiviti 5 : Ubah Suai Warna Objek 

 

Langkah-Langkah: 

 

1. Anda masih lagi dalam fail “ belajarflash “ dan scene “grafik”. 

2. Aktifkan layer “ segiempat “. 

3. Klik pada tab Stroke Color  pada Toolbox (rujuk rajah unit 1) dan pilih warna 

kuning. 

4. Klik pula pada tab Fill Color pada Toolbox dan pilih warna ungu. 

 

 

 

 

 

 

 

 

 
 
 
 
 

 

 

 

 

 

 

 

 

stroke color 

fill color 
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NOTA RUJUKAN 
 
Alat teks ( Text Tool )  
Alat teks ( Text Tool ) adalah salah satu alat yang digunakan untuk memasukkan teks 

dalam Flash, Ianya membolehkan kita menentukan aksara yang ingin dipaparkan 

mengikut pilihan jenis fon, saiz, penjajaran, gaya dan ciri – ciri.  

 

Alat   ini membolehkan anda menambah teks stage anda. Anda memulakan 

dengan klik + seret untuk membuat pemilihan saiz segi empat tepat. Apabila 

melepaskan klik teks lalai (default text)  akan dipaparkan dan tetingkap editor teks 

akan muncul. Berlegar atas bentuk teks lain, menonjolkan sempadan kotak dan teks 

akan jadi teks yang aktif. 
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AKTIVITI : MEMASUKKAN DAN MENYUNTING TEKS 
 

BAHAN DAN PERALATAN  

1. Komputer dengan perisian Macromedia Flash. 

TUGASAN  

 
Murid memasukkan dan menyunting teks menggunakan Text Tool 
serta Properties. 
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Aktiviti 1: Memasukkan Teks 

 

Langkah-Langkah: 

 

1. Buka fail “belajarflash” dengan cara pilih menu File > Open. Seterusnya pilih fail 

tersebut dan klik butang open.  

 

 

 

 

2. Aktifkan frame 1 pada layer “menu”. 

 

                                    

 

 

 

 

3. Aktifkan Text Tool               pada Toolbox (Rajah 6.2.2: Toolbox) dan kursor 

kelihatan              pada stage. 

 

4. Klik sekali pada stage dan taipkan teks “FLASH MX “ dan klik sekali lagi pada 

mana-mana ruang stage. 

 

 

 

 

 

 

+ A      

 nama layer 
frame 
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5. Pilih menu Insert pada menu bar dan pilih Layer untuk menambah layer baru 

pada Timeline dan namakan “teks1”. 

 

 

 

 

 

 

 

 

 

 

6. Aktifkan frame 1 pada layer “teks1”. 

 

7. Ulang langkah 2, 3, 4 dan taipkan “TEKS” 

 

8. Tambahkan beberapa layer baru untuk teks seperti di bawah: 

• nama layer “teks2” taipkan “GRAFIK” 

• nama layer “teks3” taipkan “ANIMASI” 

• nama layer “teks4” taipkan “AUDIO” 

• nama layer “teks5” taipkan “ VIDEO” 

 

9. Timeline akan kelihatan seperti berikut: 
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10. Paparan pada stage adalah seperti rajah di bawah. 

 

 

 

 

 

 

 

 

 

 

11. Simpan hasil kerja anda dalam fail “ belajarflash “. 
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Aktiviti 2: Menyunting Teks 

 

Langkah-Langkah : 

1. Anda masih bekerja dalam fail “belajarflash” scene “teks”. 

2. Klik frame 1 pada layer “ menu “ untuk memilihnya pada Timeline. 

 

3. Aktifkan Arrow Tool            pada Toolbox Flash MX. 

4. Klik dan gerakkan teks “ FLASH MX “ pada stage untuk kedudukan yang sesuai 

dengan menggunakan tetikus atau arrow key (kekunci panah) pada papan 

kekunci. 

5. Buka tetingkap Properties pada bahagian bawah stage . 

 

6. Satu tetingkap Properties dipaparkan. 

 

 

 

 

 

 

 

 

 

 

7. Klik pada tab “ A “ untuk pilihan jenis font 

dan pilih font “ Arial Black “. 

 

 

 

 

 

 

 

Jenis font Saiz font Warna teks  Jajaran teks  
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8. Klik pada tab warna teks untuk pilihan warna dan pilih warna merah atau lain 

warna yang sesuai. 

 

 

 

 

 

 

9. Seterusnya pilih tab size font untuk pilihan saiz fon (font )dan pilih saiz 28 atau saiz 

lain yang sesuai. 

 

 

 

 

 

 

10. Pada tab alignment  pilih center untuk jajarkan teks di tengah ruangnya. 

 

 

 

11. Ulang langkah 2 hingga 10 untuk teks di bawah: 

• layer “teks1” untuk teks “TEKS” 

• layer “teks2” untuk teks “GRAFIK” 

• layer “teks3” untuk teks “ANIMASI” 

• layer “teks4” untuk teks “AUDIO” 

• layer “teks5” untuk teks “VIDEO” 

 

12. Berikut adalah contoh teks yang terhasil setelah disunting dari segi jenis fon 

(font), saiz fon (font), warna fon (font), jajaran dan kedudukannya. 
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13. Simpan hasil kerja anda dalam fail yang sama. 
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LAPORAN PENCAPAIAN MURID 
 
 

Nama Murid:  

Tahun:  

Kelas  

 

Standard 
Kandungan: 

6.2     Animasi 2D 
 

Standard 
Pembelajaran: 

6.2.1 Menerangkan konsep frame dan keyframe. 
6.2.2 Mengenal pasti fungsi alat dan fitur asas yang 

digunakan dalam perisian animasi 2D. 
6.2.3 Menghasilkan dan mewarna objek dengan 

menggunakan alat dan fitur yang sesuai dalam 
perisian animasi 2D. 

6.2.4 Membuat suntingan objek dan teks dengan 
menggunakan alat dan fitur yang sesuai. 

 

Bil Perkara yang dinilai 
Pencapaian 

Catatan 
Terampil Belum 

Terampil 

1 
Menyatakan konsep frame dan 
keyframe dalam perisian animasi 
2D. 

   

2 
Menyenaraikan fungsi alat dan fitur 
asas yang digunakan dalam 
perisian animasi 2D 

   

3 

Menghasilkan dan mewarna objek 
dengan menggunakan alat dan 
fitur yang sesuai dalam perisian 
animasi 2D  

   

4 Menghasilkan suntingan ke atas 
objek dan teks    

KEPUTUSAN (CAPAI / TIDAK CAPAI) TARIKH 
 

Nama Guru:  Tandatangan & 
Tarikh 

 

Disahkan oleh:  Tandatangan & 
Tarikh 
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MODUL 6.3 (A) 
 

Standard 

kandungan: 

6.3 Animasi 2D 

Standard 

pembelajaran: 

6.3.1 Menjelaskan fungsi dan watak avatar dalam 

produk multimedia. 

6.3.2 Melakar reka bentuk watak avatar dalam 

perisian animasi 2D. 

 

Objektif 

Pembelajaran 

1. Menjelaskan fungsi dan watak avatar dalam 

produk multimedia. 

2. Menghasilkan lakaran watak 

berdasarkan kajian olahan idea. 

3. Membuat lukisan turn around watak 

berdasarkan ciri-ciri watak. 

4. Melukis watak dengan menggunakan 

perisian animasi.  

 

Masa: 8  jam 
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NOTA RUJUKAN 
 
6.3.1 Fungsi dan Watak Avatar dalam Produk Multimedia 

Setiap watak mempunyai ciri personaliti dan emosi tertentu yang boleh digambarkan 

dalam sesebuah animasi. 

  

 Rajah 6.3.1 : Contoh watak avatar 

Kini, peranan watak yang dikenali sebagai avatar kerap digunakan di dalam aplikasi 

permainan multimedia. Watak avatar ini turut digunakan dalam pelbagai aplikasi 

multimedia lain bagi menghidupkan lagi suasana persembahan seperti yang 

terdapat dalam aplikasi perisian pembelajaran iThink. 

 

Rajah 6.3.2: Salah satu watak avatar dalam perisian pembelajaran iThink 
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  Reka Bentuk Watak 

 

Reka bentuk pelbagai watak perlu dihasilkan berpandukan jalan cerita karya animasi 

yang dibangunkan.  Watak yang menarik akan dipilih untuk proses clean-up drawing. 

Kesempurnaan reka bentuk watak akan disemak semula bagi memastikan watak 

yang dilukis dapat menggambarkan ciri-ciri watak yang ingin dibangunkan. 

 

 
Rajah 6.3.3: Proses menghasilkan karya watak avatar 

 

Setelah membangunkan watak yang dipilih, pelukis akan melukis turn around watak 

untuk proses staging.  Lukisan turn around ini menggambarkan posisi watak secara 

keseluruhan dari arah pandangan depan, sisi dan belakang. 

 
                                             Rajah 6.3.4: Lukisan turn around 
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Nisbah Komposisi 

 

Setiap watak yang dihasilkan akan dilukis pada aras garisan horizontal yang sama 

untuk memastikan kesinambungan nisbah ketinggian bagi setiap watak atau juga 

objek dalam animasi yang dibangunkan. 

 

 

Rajah 6.3.5: Nisbah komposisi watak dalam satu animasi 

 

Mengilustrasi dan Mewarna Watak 

 

Illustrasi watak akan dihasilkan apabila lakaran watak yang dipilih telah dikemaskinikan 

agar lukisan garisan watak tersebut kelihatan lebih jelas dan difahami. 

 
                                       Rajah 6.3.6: Contoh ilustrasi watak 
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1. Kertas dan alat tulis  

2. Perisian grafik (jika perlu) 

 

TUGASAN  

Fikirkan satu karakter yang sesuai digunakan dalam aplikasi 

pembelajaran. Hasilkan lakaran watak karakter tersebut mengikut 

kreativiti anda.   

 

LANGKAH KERJA 

1. Buat kajian lapangan watak dan karakter yang sesuai dengan aplikasi 

pembelajaran. 

2. Buat lakaran beberapa karakter dan pilih watak yang terbaik. 

3. Hasilkan lukisan turn around bagi karakter tersebut dan nisbah komposisi 

sekiranya melibatkan pelbagai karakter dan objek. 

4. Pindahkan lakaran ke dalam bentuk digital dengan menggunakan perisian 

animasi.   

5. Warnakan lakaran watak yang dipilih mengikut kesesuaian karakter. 
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6.3.2 Melakar Reka Bentuk Watak Avatar dalam Perisian Animasi 2D 

1. Murid mengenal pasti tool yang 

digunakan. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Murid menyediakan lakaran watak ‘chicky’ seperti rajah di sebelah. 

 

 

 

 

 

 

 

 

Selection tool 

Subselection tool 

Free Transform tool 

Lasso tool 

Pen tool 

Text tool 

Line Tool 

Oval Tool 
 
Brush Tool 
 Ink Tool 
 Paint Bucket Tool 
 Eye dropper Tool 
 
Eraser Tool 
 
Hand Tool 
 Zoom Tool 
 

Stroke Tool 
 

Paint Bucket Tool 
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Langkah menghasilkan bahagian badan Chicky. 

 

1. Dwi klik pada layer 1, namakan sebagai badan. 

2. Pada frame 1, lukis bentuk bujur menggunakan oval tool atau pen tool. 

3. Ubah bentuk menggunakan selection tool. 

 

 
 

Langkah menghasilkan bahagian sayap Chicky. 

 

4. Klik menu insert, pilih layer. 

5. Dwi klik pada layer 2, namakan sebagai sayap. 

6. Pada frame 1, lukis bentuk segitiga menggunakan polygon tool atau pen tool. 

7. Ubah bentuk menggunakan selection tool. 
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Langkah menghasilkan bahagian paruh Chicky. 

 

8. Klik menu insert, pilih layer. 

9. Dwi klik pada layer 3, namakan sebagai paruh. 

10. Pada frame 1, lukis bentuk segitiga menggunakan polygon tool atau line tool. 

11. Klik fill color, pilih warna kuning untuk mewarnakan paruh. 

 

 
 

Langkah menghasilkan bahagian mata Chicky. 

 

12. Klik menu insert, pilih layer. 

13. Dwi klik pada layer 4, namakan sebagai mata. 

14. Pada frame 1, lukis bentuk bulat menggunakan oval tool. 
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  

Tahun:  

Kelas:  
 

Standard 

Kandungan: 

6.3 Animasi 2D 

Standard 

Pembelajaran: 

6.3.1  Menjelaskan fungsi dan watak avatar dalam produksi  

Multimedia. 

6.3.2  Melakar reka bentuk watak dalam perisian animasi 2D. 

 

Bil 

 

Perkara yang dinilai 

Pencapaian Catatan 

Terampil 
Belum 

Terampil 

1 
Menjelaskan fungsi dan watak avatar 

dalam produk multimedia. 
   

2 
Menghasilkan lakaran watak 

berdasarkan kajian olahan idea. 
   

3 
Membuat lukisan turn around 

watak berdasarkan ciri-ciri watak. 
   

4 
Melukis watak dengan 

menggunakan perisian animasi. 
   

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 

 

Nama Guru:  Tandatangan & 

Tarikh 

 

Disahkan 

oleh: 

 Tandatangan & 

Tarikh 
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MODUL 6.3 (B) 

 

Standard 

kandungan: 

 

6.3 Animasi 2D 

Standard 

pembelajaran:  

6.3.3   Menentukan key poses watak avatar. 

6.3.4   Menilai kelancaran pergerakan in between 

watak avatar. 

 

Objektif 

pembelajaran 

1. Melakar pergerakan watak key poses. 

2. Melakar pergerakan watak in between. 

3. Menghasilkan key poses dan in between watak 

di dalam perisian animasi. 

4. Menilai kelancaran pergerakan watak avatar. 

 

Masa: 16 jam 
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Key poses 

NOTA RUJUKAN 
 

6.3.3 Menentukan Key Poses Watak Avatar 

 

Key poses dan In between 

 

Key poses merujuk kepada pergerakan-pergerakan utama yang harus ditonjolkan 

dalam sesuatu scene animasi. Tanpa pergerakan utama ini, jalan cerita atau aksi yang 

ditunjukkan akan kelihatan tidak realistik.  

 

In between pada asasnya merujuk kepada bingkai-bingkai yang menghubungkan 

key poses dengan  key poses yang lain 

       In between 

 

 

 

 

 

 

Rajah 6.3.7 : Key pose dan in between pada animasi Pin-ping yang sedang berjalan. 

 

Hasilnya adalah sebagai berikut: 

 

Key Pose: 

1. Kaki kiri melangkah ke depan. 

2. Kaki kanan menghala ke depan melangkahi kaki kiri. 

In-between: 

1. Gerakan langkah kaki kanan yang sejajar dengan kaki kiri. 

2. Gerakan langkah kaki kanan yang menyusul kaki kiri ke arah depan 
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6.3.4 Menilai Pergerakan in between Watak Avatar 

 

Langkah menghasilkan pergerakan watak key poses 

 

1. Aktifkan layer sayap, klik kanan tetikus, pilih convert to symbol 

 

 
 

2. Klik pada graphic, taipkan nama ‘sayap’. Klik butang OK. 

3. Klik transform tool, gerakkan titip pusat ke hujung atas sayap seperti rajah di 

bawah. 
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4. Aktifkan pada frame 20 bagi layer badan, paruh, mata. Klik menu Insert.Pilih 

frame. 

 
5. Klik frame 10 pada layer sayap, klik kanan tetikus, pilih keyframe. 

6. Klik transform tool, gerakkan sayap ke atas sebanyak 45 ̊. 

 
 

7. Klik frame 20 pada layer sayap, klik kanan tetikus, pilih keyframe. 

8. Klik transform tool, gerakkan sayap ke atas sebanyak 80 ̊. 

9. Tekan Enter untuk memainkan pergerakan. 
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Langkah menghasilkan pergerakan in between watak.  

 

10. Klik frame 5 pada layer sayap, klik kanan tetikus, pilih keyframe. 

11. Klik transform tool, gerakkan sayap ke atas sebanyak 20 ̊. 

 

 
12. Klik frame 15 pada layer sayap, klik kanan tetikus, pilih keyframe. 

13. Klik transform tool, gerakkan sayap ke atas sebanyak 60 ̊. 

 
 

14. Tekan Enter untuk memainkan pergerakan. 
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Penilaian pergerakan animasi dibuat setelah pergerakan key-poses dan in-between 

dihasilkan sebelum animasi penuh dihasilkan.  Analisis pergerakan ini perlu dibuat 

setiap kali berlakunya perubahan pergerakan bagi memastikan setiap pergerakan 

adalah tepat dan lancar.    

 

Proses penghasilan animasi dilakukan secara berulang untuk melengkapkan sesuatu 

scene.  Pembinaan animasi pergerakan watak perlu mengambil kira langkah-

langkah yang telah ditunjukkan sebelum ini.   

Mainkan semula animasi dan perhatikan pergerakan dan perbaiki agar pergerakan 

kelihatan lancar.  
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  

Tahun:  

Kelas:  

 

Standard 

Kandungan: 

6.3 Animasi 2D 

Standard 

Pembelajaran: 

6.3.3 Menentukan pergerakan watak (key poses). 

6.3.4 Menilai kelancaran pergerakan watak (in between). 

 

Bil 

 

Perkara yang dinilai 

Pencapaian Catatan 

Terampil 
Belum 

Terampil 

1 
Melakar pergerakan watak key 

poses. 
   

2 
Melakar pergerakan watak in 

between. 
   

3 

Menghasilkan key poses dan in 

between watak di dalam perisian 

animasi. 

   

4 
Menilai kelancaran pergerakan 

watak avatar. 
   

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 

 

Nama Guru:  Tandatangan & 

Tarikh 

 

Disahkan 

oleh: 

 Tandatangan & 

Tarikh 
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MODUL 6.3 (C) 

 

Standard 

kandungan: 

 

6.3 Animasi 2D 

Standard 

pembelajaran:  

6.3.5 Menghasilkan animasi watak avatar. 

6.3.6 Menghasilkan animasi akhir dengan membuat 

proses rendering menggunakan perisian 2D. 

 

Objektif 

pembelajaran 

1. Menghasilkan animasi watak avatar yang ringkas. 

2. Mengenal pasti format fail akhir animasi. 

3. Menjana animasi akhir melalui proses rendering. 

  

Masa: 8 jam 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



60 

 

6.3.5 Menghasilkan Animasi Watak Avatar 

 

Contohnya kita ingin hasilkan seekor lebah yang sedang menggerakkan kepaknya.  

 

1. Bina satu layer baru dan namakan sebagai “BADAN LEBAH”. 

2. Klik Oval Tool dan lukiskan badan lebah di atas stage (pentas kerja). 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Klik Line Tool untuk membuat garisan menegak (belang badan lebah).  

4. Klik Paint Bucket Tool untuk memasukkan warna hitam dan kuning untuk setiap 

belangan badan lebah. 
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5. Klik Oval Tool untuk membuat muka lebah. Gunakan Paint Bucket Tool untuk 

mengisi warna kuning ke dalam muka lebah. 

6. Klik Oval Tool untuk membuat mata dan anak mata lebah. 

7. Klik Pencil Tool untuk membentuk sesungut lebah serta mulut lebah. 

8. Klik Line Tool untuk membentuk bahagian sengatan lebah di bahagian 

belakang. 

 

 

 

 

 

 

 

 

 

 

 

9. Klik layer BADAN LEBAH. Klik Insert>Convert to Symbol. Tetingkap Convert to 

Symbol akan dipaparkan. 

 

 

 

 

 

 

 

 

 

Name : Symbol 1 
Behaviour : Movie 
Clip 
Klik OK 
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10. Klik Insert>Layer dan namakan layer tersebut sebagai “SAYAP KIRI”. 

11. Klik Oval Tool untuk membentuk sayap kiri lebah. 

12. Klik Insert>Layer dan namakan layer tersebut sebagai “SAYAP KANAN”. 

13. Klik Oval Tool untuk membentuk sayap kanan lebah. 

 

 

 

Klik bulatan kecil di sini untuk ke 
bahagian seterusnya 

Bahagian ini menunjukkan 
anda telah berada di bahagian 
seterusnya 
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14. Klik layer SAYAP KANAN dan dengan menggunakan Free Transform Tool, 

gerakkan sayap kanan menyenget ke kanan di bahagian atas kepak. 

 

 

 

 

 

 

 

 

 

 

 

 

15. Klik layer BADAN LEBAH, klik frame ke 5>klik Insert>pilih Keyframe. Klik frame ke 

10>klik Insert>pilih Keyframe. 

16.  Untuk menggerakkan sayap kanan, klik layer SAYAP KANAN, klik frame ke 5, klik 

Free Transform Tool dan kecilkan kelebaran sayap lebah. Klik pada frame ke 

1>klik kanan tetikus>Copy Frame. Klik pada frame ke 10>klik kanan tetikus>Paste 

Frame. 
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17. Untuk menggerakkan sayap kiri, klik layer SAYAP KIRI, klik frame ke 5, klik Free 

Transform Tool dan kecilkan kelebaran sayap lebah. Klik pada frame ke 1>klik kanan 

tetikus>Copy Frame. Klik pada frame ke 10>klik kanan tetikus>Paste Frame. 

 

 

 

 
  

 

 

 

 

 

 

18. Uji fail anda dengan klik Control>Test Movie/(Ctrl+Enter). Simpan fail anda sebagai 

persembahan. 
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6.3.6 Menghasilkan Animasi Akhir dengan Membuat Proses Rendering 

 

Untuk suatu hasil kerja dipersembahkan dalam bentuk multimedia yang lengkap, 

ianya hendaklah dijana dalam format .swf , .exe atau .html. 

 

Hasil kerja yang dijana dalam format .swf , .exe dan .html tidak boleh diubahsuai. 

 

Format .swf dan .html memerlukan Flash Player yang terdapat dalam Flash MX untuk 

memainkannya manakala format .exe tidak memerlukan Flash Player dan anda boleh 

memainkannya pada mana-mana komputer. 

 

Anda boleh melihat persembahan anda dalam format .swf atau .exe dengan mencari 

lokasi fail tersebut melalui Windows Explore atau My Computer. 

 

Langkah menjana fail akhir animasi 

 

1. Pilih File > Publish Settings untuk membuat penetapan fail akhir. 

2.  Tetingkap Publish Setting kelihatan dan lengkapkan seperti berikut. Sila buat 

pilihan pada : 

• Flash (swf) untuk format .swf 

3. Klik Publish > OK. 
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LATIHAN / PENILAIAN 
 

1. Dengan menggunakan pengetahuan dan kemahiran yang dipelajari, hasilkan 

satu karakter avatar untuk digunakan dalam aplikasi kiosk pelancongan. 

 

2. Lakarkan karakter tersebut dan nyatakan ciri-cirinya. 
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  

Tahun:  

Kelas:  

 

Standard 

Kandungan 

6.3  Animasi 2D 

Standard 

Pembelajaran: 

6.3.5 Menghasilkan animasi watak avatar. 

6.3.6  Menghasilkan animasi akhir dengan membuat proses 

rendering menggunakan perisian 2D. 

 

 

Bil Perkara yang dinilai 

Pencapaian Catatan 

Terampil 
Belum 

Terampil 

1 
Menghasilkan animasi watak avatar 

yang lengkap. 
   

2 
Mengenal pasti format fail akhir 

animasi. 
   

3 
Menjana animasi akhir melalui 

proses rendering. 
   

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 

 

Nama Guru:  Tandatangan & 

Tarikh 

 

Disahkan oleh:  Tandatangan & 

Tarikh 
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KEPUTUSAN STANDARD PRESTASI 

Nama Murid:  

Tahun:  

Kelas :  

 

Modul: Elemen Animasi 

Standard 

Kandungan: 

6.1 Asas Animasi 

6.2 Animasi 2D 

6.3 Animasi Karakter 2D 

 

Standard Prestasi Terampil 

Tahap 

Penguasaan 
Tafsiran 

Ya Belum 

1 
Menyatakan keperluan animasi dalam 

persembahan multimedia. 

  

2 
Menjelaskan konsep pergerakan berdasarkan 

penghasilan animasi flipbook. 

  

3 

Menghasilkan animasi objek dan teks 

menggunakan konsep pergerakan dan teknik 

asas movement, morphing dan masking. 

  

4 

Menganalisis pergerakan animasi objek dan 

teks yang dihasilkan dan membuat hubungkait 

pergerakan watak avatar yang dicadangkan. 

  

5 

Menilai key poses dan in between watak 

avatar serta membuat penambahbaikan 

pergerakan watak bagi animasi yang 

dihasilkan secara rasional. 
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Standard Prestasi Terampil 

Tahap 

Penguasaan 
Tafsiran 

Ya Belum 

6 

Menghasilkan animasi 2D watak avatar 

dengan mengaplikasikan konsep pergerakan 

dan teknik asas animasi melalui proses 

rendering animasi dengan menggunakan 

perisian animasi 2D secara beretika, sistematik, 

bermakna dan kreatif. 

  

 

Keputusan Tahap  

 

Nama Guru:  Tandatangan & 

Tarikh 

 

Disahkan oleh:  Tandatangan & 

Tarikh 
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MODUL 6.4A  
 

Standard 

kandungan: 

 

6.4 Animasi 3D 

Standard 

pembelajaran:  

6.4.1 Menjelaskan keperluan animasi 3D dalam produk 

           multimedia. 

6.4.2 Mengenal pasti fungsi alat dan fitur asas yang 

digunakan dalam perisian animasi 3D. 

6.4.3 Menyenaraikan langkah mengimport objek 3D 

yang telah dihasilkan. 

6.4.4 Menentukan key poses objek 3D. 

 

Objektif 

Pembelajaran 

1. Menyatakan keperluan animasi 3D dalam produk 

multimedia.  

2. Mengenal pasti antara muka, menu, toolbox dan 

panel kawalan dalam perisian 3D. 

3. Mengetahui fungsi fitur-fitur yang terdapat dalam 

panel toolbar utama, tool dan toolbar status. 

4. Menyenaraikan langkah mengimport objek 3D 

yang telah dihasilkan. 

5. Mengenal pasti  key poses objek 3D dalam sesuatu 

scene yang direka. 

 

 

Masa: 
 
 

6  jam 
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NOTA RUJUKAN 
 

6.4.1 MENJELASKAN KEPERLUAN ANIMASI 3D DALAM PRODUK MULTIMEDIA. 

 

Antara keperluan animasi 3D dalam produk multimedia adalah : 

• Menyediakan persekitaran pembelajaran yang sangat menyeronokkan . 

• Menarik minat dan perhatian seseorang dalam proses pengajaran dan 

pembelajaran. 

• Kartun, iklan, filem dan klip video muzik yang disokong dengan animasi 3D 

lebih menarik. 

• Memberi latihan simulasi kepada pengamal perubatan untuk melakukan 

pembedahan dalam bentuk visual yang dinamik dan realistik. 

• Memberi latihan simulasi kepada tentera dan juru terbang untuk melaksanakan 

tugas-tugas berisiko dan bahaya. 
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6.4.2 Mengenal Pasti Fungsi Alat Dan Fitur Asas Yang Digunakan Dalam Perisian 

Animasi 3d 

 

Antaramuka 

Secara umumnya apabila perisian animasi 3D dibuka, ia akan memaparkan 

antaramuka seperti berikut. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Rajah 6.4.1: Antaramuka 3D Studio Max. 

 

 

Main Menu Bar 

Command Panel 
(Panel Arahan) 

Main Toolbar 

Reactor Tool 

Viewport 

Timeline 

Animation Control Viewport 
Navigation 

Control 
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Bar Menu Utama 

Bar Menu Utama ini menyediakan arahan-arahan untuk membuka fail yang baru, 

menyimpan dan membuka fail yang sedia ada, menyunting dan sebagainya. 

 

Rajah di bawah menunjukkan contoh Bar Menu Utama ( Main Menu Bar ) yang 

terdapat pada perisian 3D. 

 

 
Rajah 6.4.2: Bar Menu utama. 

 

Toolbar Utama 

Toolbar adalah alat yang sangat penting bagi perisian 3D, kerana pengguna 

mengakses arahan-arahan penyuntingan untuk objek dengan mudah.  Berikut adalah 

ikon toolbar yang terdapat dalam perisian ini. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Rajah 6.4.3: Toolbar. 

Ikon-ikon ini boleh ditambah atau dikeluarkan dari Toolbar mengikut keperluan. 

Undo  

Redo 

Select 
and Link 

Unlink 
Selection 

 

Bind to 
Space 
Wrap 

Rectangular 
Selection 
Region 

 

Selection 
Filter 

Select By 
Name 

Select 
And 
Move 

Select 
And 
Rotate 

Select And 
Scale 

Reference 
Coordinate 
System 

Select 
Object 

Window/ 
Crossing 
toggle 

Select And 
Manipulate 

Pivot 
Selection 

Snap 
Toggle  

Named 
Selection 
Sset 

Selection 
Set 
Pulldown 

Align 
Flyout 

Mirror 
Selected 

Curve 
Editor 

Schematic 
View 

Material 
Editor 

Render 
Scene 

Layer 
Manager 

Quick 
Render 

Render 
Type 

Angle 
Snap 
Toggle 

Percent 
Snap 
Toggle 

Spinner 
Snap 
Toggle 
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Layout 

1. Secara umumnya apabila perisian 3D dibuka, ia akan memaparkan empat petak 

yang berasingan yang dipanggil Viewport. 

2. Viewport ini terbahagi kepada Top Viewport, Front Viewport, Left Viewport dan 

Perspective Viewport. 

 

 

 

 

 

 

 

 

 

 

              

Rajah 6.4.4: Pandangan Viewport 

 

3. Viewport ini boleh di paparkan dalam pelbagai susunan mengikut keselesaan 

pengguna. 

Untuk mengubahsuai paparan viewport, klik menu Customize > Viewport 

Configuration. Satu kotak dialog Viewport Configuration akan dipaparkan. 
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Rajah 6.4.5: Tab Layout dalam kotak Viewport Configuration. 

 

4. Klik pada tab layout, pilih jenis scene yang disukai dan klik OK. 

 

Panel Arahan ( Command Panel ) 

Untuk membuat sesuatu bentuk objek, kita perlu menggunakan alat-alat yang ada 

pada Panel Arahan ( Command Panel ) seperti dalam rajah di bawah. 
 

 

 

 

 

 

Rajah 6.4.6: Panel Arahan. 

 

Create Panel 
 

 
 
 
 
 
 

Rajah 6.4.7: Create Panel. 

Create Panel 

Geometry 

Shape 
Light 

Camera 

Helper 

Space Wrap 

Systems 

Create Display Hierarchy 

Modify Utility Motion 
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Pada tab Create terdapat beberapa alat yang biasa digunakan untuk membina 

objek. 

 

Geometry Tool 

Dalam pilihan ini, pengguna diberikan beberapa pilihan alat untuk menghasilkan 

bentuk geometri asas tiga dimensi bagi objek primitif standard seperti kotak (Box), sfera 

(Sphere), kon (Cone), silinder (Cylinder), tiub (tube), torus (Torus) dan piramid 

(Pyramid). 

 

Rajah 6.4.8: Geometry Tool. 

 

Shape Tool 

Dalam pilihan ini, pengguna diberikan beberapa pilihan alatuntuk menghasilkan rupa 

dua dimensi yang dibentuk menggunakan objek Spline seperti garisan (line), segi 

empat (Rectangle), bulatan (Circle), elips (Ellipse), lengkungan (Arc), dua bulatan 

(Donut), poligon (NGon), bintang (Star), teks (Text), spring (Helix) atau objek pecahan 

segiempat (Section). 
 

Geometry Tool 

Pilihan Tool Geometry 
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Rajah 6.4.9: Shape Tool. 
 

Menghasilkan Sfera menggunakan Geometry Tool 

1. Aktifkan panel Create pada Panel Arahan (Command Panel) dan klik Geometry. 

 

2. Pada Drop Down menu, pilih Standard Primitives. 

 

3. Klik pada butang Sphere. Penunjuk tetikus bertukar kepada 

bentuk cross hair. 

 

 

 

 

 

4. Di tengah-tengah petak Top Viewport, klik dan heret tetikus ke bawah kemudian 

lepaskan. Sebuah sfera terbentuk. Saiz sfera yang ingin kita bentuk terpulang 

kepada pengguna. 

Shape Tool 

Pilihan Tool Shape 
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Rajah 6.4.10: Menghasilkan sfera mengguna Geometry Tool. 

 

5. Di bahagian bawah Panel Arahan (Command Panel), klik Panel Modify tercatat 

butir-butir berkenaan dengan sfera yang telah dibentuk. Pengguna boleh 

mengubah butir-butir model yang dibentuk disini. 

 

6. Taipkan nama bagi objek yang dihasilkan. Secara umumnya perisian 3D akan 

memberikan nama objek yang dibentuk sebagai sphere.  

 

7. Tukarkan jejari (Radius) kepada 50 dan segmennya kepada 32. Objek yang terhasil 

bertambah besar. 
 

8. Klik pada butang Zoom Extents All di sebelah kanan bahagian untuk menetapkan 

kedudukan objek di tengah-tengah semua viewport seperti rajah 6.4.11. 
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Rajah 6.4.11: Butang Zoom Extents All. 

 

9. Simpan fail dengan memberi nama sfera.max  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

butang Zoom 
Extents All  
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6.4.3 Menyenaraikan Langkah  Mengimport Objek 3D Yang Telah Dihasilkan 

 

Membuka Fail Baru 

1. Klik pada menu File > New… 

    

2. Kelihatan satu kotak dialog yang memberi kita pilihan seperti berikut: 

 

 

 

 

 

 

 

Rajah 6.4.12: Kotak dialog New Scene. 

 

 

 

a. Keep Objects and Hierachy 

Arahan ini digunakan untuk membuka satu fail baru tetapi dengan 

mengekalkan objek-objek dan susunatur yang sedia ada pada fail 

sebelumnya. 

 

b. Keep Objects 

Arahan ini digunakan untuk membuka satu fail baru tetapi dengan 

mengekalkan objek-objek sahaja tanpa susunatur yang sedia ada pada fail 

sebelumnya. 

 

c. New All 

Arahan ini digunakan untuk membuka satu fail baru tanpa apa-apa objek 

dan semuanya adalah mengikut default setting. 

3. Pilih salah satu pilihan dan klik OK. 
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Mengimport Objek 3D yang telah dihasilkan 

1. Klik pada menu File > Open… 

 

2. Kelihatan satu kotak dialog seperti berikut: 

 

 

 

 

 

 

 

 

Rajah 6.4.13 Kotak dialog Open File. 

 

3. Pilih fail yang ingin dibuka (mempunyai sambungan .max) dan klik butang Open. 

 

4. Fail yang dikehendaki akan dibuka di dalam scene. 
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6.4.4 Menentukan Key Poses Objek 3D 

 

Key Poses 

Key poses merujuk kepada pergerakan-pergerakan utama yang harus ditonjolkan 

dalam sesuatu scene animasi 3D. Tanpa pergerakan utama ini, jalan cerita atau aksi 

yang ditunjukkan akan kelihatan tidak realistik.  

 

   
Rajah 6.4.14: Tiga key poses. 

 

Pada Rajah 6.4.14, kita dapat melihat tiga key poses dalam scene lantunan bola. Key 

poses pertama, keadaan bola berada pada permukaan rata. Key poses kedua, 

keadaan bola berada pada puncak tertinggi dan pada key poses ketiga, keadaan 

bola semasa mendarat dan menyentuh permukaan rata sekali lagi.  

 

Ini merupakan contoh key poses paling mudah yang terdapat pada sesuatu scene 

lantunan bola. Sekiranya proses pergerakan itu lebih kompleks, maka tentunya lebih 

banyak key poses yang perlu difikirkan oleh juruanimasi. 

 

 

 

 

 

 

 

2 

3 1 
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In between  

In between pada asasnya merujuk kepada bingkai yang menghubungkan key poses 

dengan key poses yang lain.  

 

 
Rajah 6.4.15: Pergerakan In between. 

 

Pada Rajah 6.4.15, kita dapat melihat In between yang wujud antara key poses satu 

dengan key poses dua dan key poses dua dengan key poses tiga.  Apabila key poses 

dilakukan dengan baik dan pecahan diselaraskan dengan betul, juruanimasi akan 

dapat menghasilkan animasi yang realistik. In between ini menyempurnakan lagi 

pergerakan yang berlaku antara key poses tersebut. Pergerakan in between ini boleh 

dihasilkan menggunakan fitur transformasi : 

 

• Translasi (Translation) 

• Putaran (Rotation) 

• Penskalaan (Scaling) 

 

 

 

 

 

 

 

 

 

In between 

1 

2 

3 
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1. Perisian 3D  

 

TUGASAN  

Murid menghasilkan karya illustrasi objek 3D bertema menggunakan  

perisian 3D mengikut kesesuaian.   

 

 

 

 

LANGKAH KERJA  

1. Murid menghasilkan objek 3D menggunakan perisian 3D. 
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LATIHAN/ PENILAIAN 
 

 

1. Nyatakan dua keperluan animasi : 

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________

________________________________________________________________________________ 

 

2. Namakan ikon-ikon yang dilabelkan di bawah : 
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3. Namakan ruang viewport pada rajah di bawah : 

 

 

4. Lakarkan key poses bagi sesuatu objek. 
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  
Tahun:  
Kelas  

 

Standard 
Kandungan: 

6.4 Animasi 3D 

Standard 
Pembelajaran: 

6.4.1 Menjelaskan keperluan animasi 3D dalam produk 
           multimedia. 
6.4.2 Mengenal pasti fungsi alat dan fitur asas yang 

digunakan dalam perisian animasi 3D. 
6.4.3 Menyenaraikan langkah mengimport objek 3D yang 

telah dihasilkan. 
6.4.4 Menentukan key poses objek 3D. 

 
 

Bil Perkara yang dinilai 
Pencapaian 

Catatan 
Terampil Belum 

Terampil 

1 
Menyatakan keperluan animasi 3D 
dalam produk multimedia.     

2 
Mengenal pasti antara muka, 
menu, toolbox dan panel kawalan 
dalam perisian 3D. 

   

3 
Mengetahui fungsi fitur-fitur yang 
terdapat dalam panel toolbar 
utama, tool dan toolbar status. 

   

4 
Menyenaraikan langkah 
mengimport objek 3D yang telah 
dihasilkan. 

   

5 Mengenal pasti  key poses objek 3D 
dalam sesuatu scene yang direka.    

KEPUTUSAN (CAPAI / TIDAK CAPAI) TARIKH 
 

Nama Guru:  Tandatangan & 
Tarikh 

 

Disahkan oleh:  Tandatangan & 
Tarikh 
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MODUL 6.4B  
 

Standard 
kandungan: 
 

6.4       Animasi 3D 

Standard 
pembelajaran:  

6.4.5 Menghasilkan pergerakan in between dengan 
menggunakan fitur transformasi: 
(i) Translasi (Translation) 
(ii) Putaran (Rotate) 
(iii) Penskalaan (Scale) 

 
Objektif: 
 

1. Menghasilkan pergerakan in between objek 3D 
dengan menggunakan fitur transformasi translasi 
(Translation), fitur putaran (Rotate) dan fitur 
penskalaan (Scale). 

 
Masa: 
 

3 jam 
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NOTA RUJUKAN 

 

6.4.5 Menghasilkan Pergerakan In Between Dengan Menggunakan Fitur 

Transformasi Translasi (Translation), Putaran (Rotate) Dan Penskalaan (Scale). 

 

Transformasi dalam animasi 3D adalah satu proses membuat pergerakan objek, 

perubahan pada sudut pandangan dalam sesuatu ruang dan jarak atau 

perubahan ukuran objek mengikut tiga satah utama iaitu paksi-X, paksi-Y dan paksi-

Z.  

Sebagai contoh seperti dalam rajah di bawah, kedudukan objek A dengan 

koordinat asalnya (x,y,z) telah berubah jarak ke kedudukan yang baru (x1,y1,z1) 

melalui proses transformasi translasi sepanjang paksi-Z. 

 
Rajah 6.4.15: Transformasi translasi 

 

Dalam persekitaran 3D, setiap objek mempunyai nilai koordinatnya sendiri. Melalui 

nilai koordinat ini seseorang yang membina objek 3D mengetahui kedudukan 

objek-objek tersebut di dalam ruang tiga dimensi. Nilai-nilai koordinat inilah yang 

akan diubah untuk menghasilkan pergerakan atau perubahan pada objek 3D 

dengan menggunakan fitur transformasi yang dikehendaki. 
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Rajah 6.4.16: Proses transformasi translasi objek A 

 

Terdapat tiga jenis transformasi asas yang boleh diaplikasikan pada objek 3D iaitu: 

 

 
 

 

 

Translasi (Translation) 
 

Transformasi translasi adalah proses memindahkan objek dari satu kedudukan ke 

kedudukan lain dalam satah 3D. 
 

Transformasi 3D

Translasi 
(Translation)

Putaran 
(Rotation)

Penskalaan  
(Scaling)
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Rajah 6.4.17: Translasi Objek. 
 

Putaran (Rotation) 
 

Putaran 3D adalah proses memutar objek mengikut sudut putaran dalam satah tiga 

dimensi sama ada putaran pada paksi-X, paksi-Y atau paksi-Z. 

 

 

 

 

 

 

 

 

      Putaran pada paksi-X           Putaran pada paksi-Y         Putaran pada paksi-Z 

Rajah 6.4.18: Proses transformasi putaran. 

Penskalaan (Scaling) 

Penskalaan adalah proses mengubah ukuran objek 3D.  

 

 

 

 

 

Rajah 6.4.19: Penskalaan Objek. 
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Ketiga-tiga jenis transformasi ini adalah transformasi asas yang boleh digunakan 

pada objek 3D. Di dalam sesuatu perisian animasi 3D, fitur transformasi disediakan 

bagi memudahkan juruanimasi menghasilkan animasi pergerakan objek dan 

animasi pergerakan kamera yang lebih teliti dan nampak lebih realistik.  

Sebagai contoh, di dalam perisian animasi 3D Studio Max, alat seperti Select and 

Move, Select and Rotate dan Select and Scale disediakan pada toolbar utama 

bagi mengaplikasikan transformasi pada objek 3D yang dibina.  

 

 

 

 

 

 

Rajah 6.4.20: Alat Transform. 

Bagi menetapkan nilai transformasi dengan lebih terperinci, fitur Transform Toolbox 

juga boleh digunakan dalam 3D Studio Max dengan cara klik menu Edit> pilih 

Transform Toolbox.  

 

 

 

 

 

 

 

 

 

 

 

Rajah 6.4.21: Fitur Transform Toolbox bagi transformasi putaran 

 

 

Select and Rotate 

Select and Move Select and Scale 
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Animasi pergerakan in between objek 3D menggunakan fitur transformasi. 

Prinsip kerja dari animasi pergerakan in between adalah membina key poses 

utama objek 3D bermula pada pergerakan awal hingga pergerakan akhir seperti 

dalam rajah di bawah.  

 

Rajah 6.4.22: Contoh pergerakan in between objek 3D. 
 

 

Manakala frame di antara key poses itu akan terbentuk secara automatik di 

sepanjang laluan (path)animasi. Sekiranya dalam laluan animasi itu terdapat 

beberapa pergerakan yang berbeza bentuk dan rupa maka keyframe akan 

diletakkan. Pada keyframe inilah fitur transformasi seperti translasi, putaran dan 

penskalaan dilakukan bagi menampakkan hasil animasi itu lebih realistik. 

 
 

Menghasilkan animasi pergerakan in between objek 3D menggunakan fitur 

transformasi 
 

1. Buka semula fail mejateko.max. 

2. Aktifkan Left Viewport. 

3. Klik menu File > pilih Merge….Klik pada menu Merge… 

4. Satu kotak dialog Merge File terpapar dan pilih fail ‘sphere.max’ yang telah 

dicipta sebelum ini. Klik butang Open. 

5. Kotak dialog Merge-sphere.max terpapar. Aktifkan objek sphere dari senarai 

pilihan dan klik butang OK.   

 

Key pose 1 

Key pose 2 

Key pose 3 

In between 

In between 



94 

 

 

 

Secara langsung objek sphere berada di tengah viewport seperti rajah di 

bawah. 

 
Rajah 6.4.23: Objek sphere pandangan kiri. 

 

6. Aktifkan objek sphere dan klik alat Select and Scale pada Main Toolbar. 

7. Klik tetikus dan seret tetikus ke arah dalam objek sphere untuk mengecilkan 

saiznya. 

 
Rajah 6.4.24: Objek sphere yang telah dikecilkan. 

 

8. Di dalam Left Viewport, letakkan objek planet tersebut ke atas sedikit dari 

paras teko yang terletak di atas meja dengan menggunakan Move tool.  

Lihat rajah 6.4.24 
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Rajah 6.4.24: Objek sphere berada di posisi baru. 

 

7. Pada bar Animation Control klik pada butang Time Configuration yang 

ditunjukkan pada rajah dibawah. 

 

 
Rajah 6.4.25: Butang Time Configuration. 

 

8. Satu kotak dialog Time Configuration terpapar.  Pada bahagian Animation 

Masukkan angka 0 pada ruangan Start Time dan angka 100 pada End Time. Ini 

akan menetapkan laluan animasi anda kepada 100 frame. Klik OK untuk 

menutup kotak dialog. 

 

 

 

 

 

 

 

Rajah 6.4.26: Kotak Time Configuration. 
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9. Aktifkan objek sphere.  

10. Pada bar Animation Control, klik butang Auto Key.  

 

11. Dengan menggunakan Time Slider, klik anak panah ke kanan untuk bergerak 

ke frame 50. Anda juga boleh menaipkan terus angka 50 ke dalam kotak 

Current Time. 

 

 
Rajah 6.4.26: Time Slider. 

 

 

 

 

Rajah 6.4.27: Butang Auto Key dan kotak Current Time. 

12. Klik ikon Move Tool dan aktifkan Front Viewport. Gerakkan objek sphere 

sehingga ia mengenai bahagian atas teko di atas meja.  Lihat rajah di bawah. 

 

 
Rajah 6.4.28: Pergerakan objek sphere. 

Current Time 
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13. Dengan menggunakan Time Slider klik anak panah ke kanan untuk bergerak ke 

frame 70 atau menaipkan terus angka 70 ke dalam kotak Current Time. 

 

14. Gerakkan objek teko dalam bentuk putaran dengan menggunakan Rotate 

Tool pada paksi-z dan gerakkan sedikit ke depan dengan menggunakan Move 

Tool.  

 

  Bagi objek sphere pula, gerakkan sedikit ke atas. Lihat rajah di bawah. 

 

 
Rajah 6.4.29: Pergerakan teko. 

 

15. Dengan menggunakan Time Slider klik anak panah ke kanan untuk bergerak ke 

frame 100 atau menaipkan terus angka 100 ke dalam kotak Current Time. 

 

16. Gerakkan objek sphere jauh ke kanan. Dan gerakkan juga teko ke depan 

dengan keadaan seperti yang asal. Lihat rajah di bawah. 
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Rajah 6.4.30: Pergerakan objek 3D sphere dan teko. 

 

Cuba mainkan animasi yang telah anda buat dengan menggerakkan Time Slider 

atau butang play pada bar Animation Controller. 

 

 

 

 

 

 

 

Rajah Rajah 6.4.31: Butang Animation Controller. 

 

17. Untuk menyunting animasi, aktifkan objek 

sphere. 

 

18. Klik panel Motion pada Command Panel. 

 

19. Klik pada butang Trajectories.  

Rajah 6.4.32: Butang Trajectories. 

 

Go to Start Go to End 
Play 

Previous Frame Next Frame 
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20. Dalam Left viewport, kita akan lihat laluan (path) pergerakan objek sphere 

dalam animasi kita seperti rajah di bawah.  

 

 

 
Rajah 6.4.33: Laluan pergerakan objek sphere. 

21. Anda boleh menyunting pergerakan dan kedudukan objek dalam animasi 

dengan menggerakkan keyframe-keyframe pada laluan (path) dan 

mengubah kedudukan objek tersebut.  

 

22.  Simpan fail ‘animasimejateko.max’ anda. 
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1.  Komputer  

2.  Perisian 3D Studio Max 

3.  Fail ‘sphere.max’ 

4.  Tekstur imej yang sesuai dengan tema 

TUGASAN  

Tema: Permainan Boling 

Murid menghasilkan pergerakan in between pada objek 3D 

dengan menggunakan fitur transformasi Translasi 

(Translation), Putaran (Rotate) dan Penskalaan (Scale). 

 

LANGKAH KERJA (TUGASAN) 

1.      Buka perisian 3D Studio Max. 

2. Murid hasilkan beberapa objek 3D yang dinamakan sebagai ‘bowling pin’ 

pada Left Viewport. 

3. Murid susunkan objek tersebut pada kedudukan yang sesuai. 

4. Murid mengimport objek sedia ada ke dalam scene iaitu objek sfera dari fail 

‘sphere.max.’ 

5. Murid mengubah saiz objek sfera mengikut kesesuaian dan meletakkan pada 

kedudukan di hadapan objek ‘bowling pin’. 

6. Murid meletakkan tekstur yang sesuai pada objek sfera dan ‘bowling pin’. 

7. Murid menghasilkan animasi pergerakan in between objek sfera 

menjatuhkan ‘bowling pin’ menggunakan fitur transformasi Translasi 

(Translation), Putaran (Rotation) dan Penskalaan (Scaling). 

8. Murid memainkan animasi. 

9. Murid menyimpan fail sebagai ‘permainanboling.max’. 
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LATIHAN/ PENILAIAN 
 

3. Nyatakan tiga jenis transformasi yang boleh digunakan dalam menghasilkan 

animasi 3D. 

i. _____________________________________________________________ 

ii. _____________________________________________________________ 

iii. _____________________________________________________________ 
 

4. Padankan transformasi putaran yang ditunjukkan pada rajah di bawah dengan 

paksi putarannya yang betul. 

  

 

 

 

 

 

 

 

 

 

 

5. Namakan alat transformasi berdasarkan rajah di bawah. 

 

 

 

 

 

 

 

 

 

 

• Putaran pada paksi-X 

• Putaran pada paksi-Y 

• Putaran pada paksi-Z 
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6. Berpandukan kedudukan awal objek teko, nyatakan paksi dan transformasi 

yang terlibat bagi menghasilkan animasi pergerakan in between di bawah. 

 

 
 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

Paksi:  
Transformasi:  

 

Paksi:  
Transformasi:  

 

Paksi:  
Transformasi:  

 

Paksi:  
Transformasi:  
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  
Tahun:  
Kelas:  

 

Standard 
Kandungan: 

6.4 Animasi 3D 
 

Standard 
Pembelajaran: 

6.4.5   Menghasilkan pergerakan in between dengan     
           menggunakan fitur transformasi: 

(i) Translasi (Translation) 
(ii) Putaran (Rotate) 
(iii) Penskalaan (Scale) 

 
 

Bil Perkara yang dinilai 
Pencapaian 

Catatan 
Terampil Belum 

Terampil 

1 

Menghasilkan pergerakan in 
between objek 3D dengan 
menggunakan fitur transformasi 
translasi (Translation). 

   

2 

Menghasilkan pergerakan in 
between objek 3D dengan 
menggunakan fitur transformasi 
putaran (Rotate). 

   

3 

Menghasilkan pergerakan in 
between objek 3D dengan 
menggunakan fitur transformasi 
penskalaan (Scale). 

   

KEPUTUSAN (CAPAI / TIDAK CAPAI) TARIKH 
 

Nama Guru:  Tandatangan & 

Tarikh 

 

Disahkan oleh:  Tandatangan & 

Tarikh 
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MODUL 6.4C  
 

Standard 

kandungan: 

 

6.4 Animasi 3D 

Standard 

pembelajaran:  

6.4.6  Membezakan penggunaan jenis cahaya dalam 

persekitaran animasi 3D. 

 

Objektif 

Pembelajaran: 

1. Memahami konsep cahaya dalam animasi 3D. 

2. Meletakkan cahaya ke dalam scene. 

 

 

 

Masa: 

 

 

6 jam 
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NOTA RUJUKAN 
 

6.4.6  MEMBEZAKAN PENGGUNAAN JENIS CAHAYA DALAM PERSEKITARAN ANIMASI 

3D 

 

Pencahayaan adalah teknik yang digunakan untuk mensimulasikan cahaya dalam 

persekitaran animasi 3D. Teknik pencahayaan animasi 3D digunakan mengikut 

fungsi dan tahap kesukaran yang berbeza. Penggunaan cahaya boleh dipilih dari 

pelbagai sumber cahaya, alat dan teknik yang sesuai dengan keperluan animasi 

3D.  

 

Jenis-jenis cahaya dalam aplikasi 3D berbeza-beza antara satu dengan yang 

lain bergantung kepada jenis perisian, namun konsepnya adalah serupa iaitu untuk 

menghasilkan satu kesan yang realistik dan menyerupai situasi yang sebenar. 

Misalnya: 

• cahaya yang boleh menghasilkan bayang. 

• cahaya yang datangnya dari sumber semula jadi. 

• cahaya yang datangnya dari lampu. 

• cahaya yang bertumpu.  

 

Terdapat beberapa teknik pencahayaan dalam animasi 3D: 

 

1. Cahaya Omni/Titik (Point/ Omni Light) 

• Memancarkan pencahayaan ke setiap arah dari satu sumber cahaya 

yang sangat kecil. 

• Menumpukan lokasi tertentu dalam pemandangan 3D.  

• Berguna untuk mensimulasikan sebarang sumber cahaya 

omnidirectional seperti mentol lampu, lilin dan lampu pokok Krismas. 
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Rajah 6.4.34: Cahaya Omni/Titik – The Incredibles. 

 

2. Cahaya Berarah (Directional light) 

• Mewakili sumber cahaya yang sangat jauh seperti matahari atau 

bulan.  

• Sinar yang dipancarkan dari cahaya berarah selari dalam satu arah.  

• Mensimulasikan cahaya matahari atau bulan.  

 

 
Rajah 6.4.35: Cahaya Berarah – Monster Inc. 

 

3. Cahaya Spot (Spot light) 

• Terdapat 2 jenis iaitu target spot dan free spot. 

• Target spot - memancarkan sinar cahaya yang berfokus.  

• Free spot - tidak mempunyai objek sasaran. 

• Mensimulasikan lampu seperti lampu meja atau lampu jalan. 
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Rajah 6.4.36: Cahaya Spot – Monster University. 

 

4. Cahaya Kawasan (Area Light) 

• Memancarkan cahaya mengikut sempadan yang ditetapkan dalam 

ukuran dan bentuk tertentu seperti segi empat atau bulat.  

• Menvisualkan seni bina objek 3D dan pencahayaan produk.  

• Menghasilkan bayangan lembut yang menjadikan animasi 3D 

kelihatan lebih realistik. 

 
Rajah 6.4.37: Cahaya Kawasan – La Luna. 

5. Cahaya Isipadu (Volume Light) 

• Menyinari cahaya ke semua arah dari titik tertentu.  

• Mempunyai bentuk dan ukuran tertentu.  

• Menerangi permukaan berdasarkan nilai yang ditetapkan.  

• Memberikan kesan khas seperti asap, kabut, dan sebagainya. 

 
Rajah 6.4.38: Cahaya Isipadu – Wreck It Ralph. 
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6. Cahaya Sekililing (Ambient Light) 

• Memancarkan sinar lembut ke semua arah. 

• Tidak memiliki arah tertentu dan tidak memancarkan bayangan di 

tanah.  

• Ia boleh dibandingkan seperti waktu senja setelah matahari terbenam.  

• Menjadi sumber tambahan kepada warna sumber cahaya utama 

untuk pemandangan 3D. 

 

 

 

 

 

 

Rajah 6.4.39: Cahaya Sekeliling – Pixar Up. 

 

Meletakkan Cahaya Di Dalam Scene  

1. Buka perisian animasi 3D. 

 

2. Bina objek teko dan meja pada Perspective Viewport. 

 
Rajah 6.4.40: Objek 3D- teko dan meja. 

 

3. Klik dalam Left Viewport untuk mengaktifkannya. 
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4. Pada Command Panel > klik panel Create.  

 
5. Pilih pada ikon Lights. 

 
6. Ada dua jenis kaedah cahaya: 

• Standard 

• Photometric 
7. Pilih Standard. 

 

8. Pada bahagian Object Type, pilih jenis cahaya 

Target Spot. 

Rajah 6.4.41: Panel Create. 

 

9. Klik di dalam Left Viewport. Kursor akan bertukar kepada bentuk Crosshair. 

 

10. Klik butang kiri tetikus di bahagian atas teko dan tarik tetikus ke arah teko. Satu 

bentuk kon bergaris biru akan terbentuk.  Bulatan ini adalah mewakili cahaya 

spot light yang dibentuk.  
 

 

Rajah 6.4.42: Kedudukan lampu pandangan kiri. 

 

 

Spot light 

Kon 
bergaris 
biru (arah 
cahaya) 

Kedudukan 
arah cahaya 
yang ingin 
diubah 
menggunakan 
move tool. 

Panel Create 

Light
s 
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11. Garis kon ini tidak akan kelihatan setelah proses rendering dibuat. Yang kelihatan 

hanya kesannya sahaja. Kedudukan cahaya ini boleh diubah-ubah 

kedudukannya dengan mengalihkan kedudukan spot light dengan 

menggunakan move tool seperti rajah di atas. 

 

12. Aktifkan spot light, pilih panel Modify dan ubah nama Spot01 sebagai cahaya1. 

 

  
Rajah 6.4.43: Panel Modify. 

 

13. Di bawah menu General Parameter pada bahagian Shadows parameters: 

- Klik dan tandakan pada kotak On dan Use Global Settings.  

- Pada bahagian drop down list, pilih 

Shadows Maps untuk meletakkan bayang 

pada objek di dalam scene tersebut. 

- Bayang ini hanya akan kelihatan apabila 

proses render dilaksana. 

 

 

 

Rajah 6.4.44: General Parameter. 
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14. Bina satu lagi cahaya di dalam Left Viewport menggunakan jenis cahaya Omni.  

Letakkan ke bawah sedikit dari aras permukaan meja. Cuba lihat hasilnya dari 

Perspective View.  

 

  
Rajah 6.4.45: Cahaya Omni dan kedudukannya. 

 

15. Simpan fail dengan memilih File > Save. 

 

16. Simpan sebagai cahayamejateko.max 

 

  

Perletakan Cahaya Target Spot Perletakan Cahaya  

Target Spot dan Omni 

Rajah 6.4.46: Perletakan cahaya. 
 

 

 

 

 

Cahaya Omni 



112 

 

 

Jadual 1: Jenis dan Bentuk Cahaya. 

Jenis Cahaya Bentuk Cahaya 

Target Spot 

 

Free Spot 

 

Target Direct 

 

Free Direct 

 

Omni 

 

Skylight 
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mr Area Omni 

 

 

mr=mental ray 

 

 

mr Area Spot 

 
 

 

Sumber: 

http://ohelstudio.blogspot.com/2015/07/pencahayaan-dalam-3d-animasi.html 

https://3d-ace.com/press-room/articles/how-light-3d-scene-overview-lighting-techniques 
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1.   Komputer 

2. Perisian Animasi 3D 

 

TUGASAN  

- Murid meneroka dan mengenali jenis cahaya dalam perisian 

animasi 3D.  

- Murid membina dan membezakan dua cahaya yang 

dihasilkan yang mempunyai kedudukan yang berbeza. 

 

 

LANGKAH KERJA (TUGASAN 1) 

1. Buka perisian animasi 3D. 

2. Kenal pasti dan terokai Lights pada perisian 3D. 

3. Bina objek 3D yang baharu. 

4. Bina cahaya Target Direct pada objek 3D. 

5. Simpan fail 3D sebagai cahaya_direct1.max. 

 

LANGKAH KERJA (TUGASAN 2) 

1. Buka perisian animasi 3D. 

2. Bina objek 3D yang baharu. 

3. Bina cahaya Skylight pada objek 3D. 

4. Simpan fail 3D sebagai cahaya_skylight1.max. 
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LATIHAN/ PENILAIAN 
 

1. Pada rajah di bawah bulatkan ikon cahaya (lights icon)  

 

2. Pada command panel ikon cahaya (lights Icon)  terdapat beberapa jenis 

cahaya yang boleh dihasilkan. Namakan jenis-jenis cahaya tersebut. 

 

a _________________________ 

 

b __________________________ 

 

c __________________________ 

 

d __________________________ 

 

 

3. Berdasarkan kepada soalan 2, pilih tiga dan nyatakan perbezaan ciri-ciri 

cahaya dalam ruang yang disediakan 

 

1. 2. 3. 
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LAPORAN PENCAPAIAN MURID 
 

 

Nama Murid:  
Tahun:  
Kelas  

 

Standard 
Kandungan: 

6.4  Animasi 3D  

Standard 
Pembelajaran: 

6.4.6  Membezakan penggunaan jenis cahaya dalam 
persekitaran animasi 3D. 
 

 

Bil Perkara yang dinilai 
Pencapaian 

Catatan 
Terampil Belum 

Terampil 

1 
Memahami konsep cahaya dalam 
animasi 3D.    

2 
Meletakkan cahaya ke dalam 
scene.    

3 
Membezakan penggunaan teknik 
cahaya dalam persekitaran animasi 
3D. 

   

KEPUTUSAN (CAPAI / TIDAK CAPAI) TARIKH 
 

Nama Guru:  Tandatangan & 
Tarikh 

 

Disahkan oleh:  Tandatangan & 
Tarikh 
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MODUL 6.4D  
 

Standard 
kandungan: 
 

6.4 Animasi 3D 

Standard 
pembelajaran:  

6.4.7  Menentukan kesesuaian kedudukan dan sudut            
 pandangan kamera dalam persekitaran animasi 3D. 

6.4.8  Menghasilkan animasi gerakan kamera dalam 
persekitaran animasi 3D mengikut kesesuaian. 

 
Objektif: 
 

1. Memahami konsep gerakan kamera dalam animasi 3D. 
2. Mengenal pasti jenis-jenis kedudukan dan sudut 

pandangan kamera dalam persekitaran 3D. 
3. Mengenal pasti jenis-jenis pergerakan kamera dalam 

persekitaran 3D. 
4. Meletakkan kamera ke dalam animasi 3D. 
5. Mengerakkan kamera untuk menghasilkan animasi 3D. 

 
Masa: 
 

9 jam 
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NOTA RUJUKAN 
 

6.4.7 Menentukan Kesesuaian Kedudukan dan Sudut Pandangan Kamera 

Dalam Persekitaran Animasi 3D. 

 

 Kamera berfungsi untuk mensimulasikan gambar pegun, gambar bergerak 

atau rakaman dari kamera video dalam dunia nyata. Dalam konsep 3D, apabila 

kita meletakkan objek kamera ke dalam persekitaran 3D, pemandangan yang 

dihasilkan adalah dari sudut pandangan kamera yang ditetapkan. 

 

 

 

 

 

 

 

 

 

 

Rajah 6.4.47: Contoh kedudukan kamera yang diletakkan dalam scene 3D. 
 
 

 

 

 

 

 

 

 

 

Rajah 6.4.48: Sudut pandangan kamera yang dihasilkan. 

Sudut pandangan kamera bukan sahaja dapat membantu proses penyuntingan 

pada objek 3D malah ia juga dapat membantu dalam menghasilkan satu bentuk 
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animasi yang kompleks dan menarik dengan membuat pergerakan-pergerakan 

pada kamera tersebut. 

 

Dengan meletakkan beberapa kamera dalam satu scene yang sama, pelbagai 

sudut pemandangan yang berbeza dapat dihasilkan. Seperti kamera biasa, 

kamera maya dalam konsep 3D juga boleh melakukan teknik-teknik kamera seperti 

zoom, pan dan dolly.  

 

Sebagai contoh dalam Rajah 6.4.49 di bawah, kamera diletakkan pada kedudukan 

atas sedikit dari objek dengan menghasilkan sudut pandangan kamera antara 

objek dan kamera. Kemudian lensa kamera digerakkan dengan teknik Zoom In lalu 

menghasilkan sudut pandangan kamera yang semakin dekat atau besar seperti 

dalam Rajah 6.4.50. 

 
Rajah  6.4.49: Kedudukan kamera yang diletakkan dalam scene 3D 

(sebelum zoom in). 

 

 
Rajah 6.4.50: Hasil akhir selepas zoom in dari sudut pandangan kamera. 
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Kedudukan kamera dan sudut pandangan kamera dalam persekitaran 3D 
 

 

 

 

 

 

 

 

 

 

 

 

Rajah 6.4.51: Contoh kedudukan kamera. 

 

Kedudukan kamera dan sudut pandangan kamera dalam persekitaran 3D 

berfungsi memberi impak kepada subjek/objek yang dihasilkan. Dengan 

terhasilnya sudut pemandangan yang sesuai dan menarik ia mampu menjadikan 

subjek utama kelihatan dominan, lemah, hilang, yakin, besar atau kecil kepada 

penonton dan objek-objek lain. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Kamera adalah 'mata' 
kepada sudut pandang 
penonton atau watak 

dalam suatu 
pemandangan atau 

persekitaran 3D. 
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       Rajah 6.4.52: Jenis-jenis sudut kamera. 

 

 

 

 

 

 

 

 

 

Jenis-jenis sudut kamera 

Camera angles atau sudut kamera merujuk kepada kedudukan kamera 

semasa tangkapan atau rakaman subjek diambil.  

Sudut kamera yang berbeza dapat menambahkan dan mendorong makna 

dan tahap penglibatan yang berbeza bagi penonton.  

 

Sudut Info 
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Kebiasaannya sudut pandangan kamera menggambarkan persekitaran subjek 

atau menunjukkan di mana lokasi subjek berada tetapi tidak menunjukkan subjek 

itu sendiri. 

 

 

 

 

 

 

 

Berikut adalah beberapa contoh sudut 

pandangan kamera mengikut kedudukan 

kamera (camera angles) yang digunakan 

sesuai dengan jalan penceritaan yang 

diingini. 

 

• Extreme long shot:  

 
Rajah 6.4.53: Extreme long shot dalam Filem 

Animasi How to Train Your Dragon. 
 

 

 

 

Sudut kamera 
(Camera angles) 

Sudut Info 
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• Medium shot:  
 

Sudut kamera ini adalah setengah daripada karakter yang ditampilkan iaitu dari 

paras pinggang ke atas. Penonton dapat melihat wajah karakter lebih jelas serta 

interaksi antara karakter-karakter lain.  

 Rajah 6.4.54: Medium shot dalam Filem Animasi Cloudy. 

 

• Close-up: 

 
Rajah 6.4.55: Close up dalam Filem Animasi Brave. 

 

Kebanyakannya digunakan untuk menunjukkan emosi subjek dengan lebih jelas. 

Kedudukan kamera berfokus kepada bahagian kepala sahaja. 
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• Extreme Close-up: 

 

 
Rajah 6.4.56: Close up dalam Filem Animasi Brave. 

 

Extreme Close Up merupakan shot yang menunjukkan wajah subjek dengan lebih 

dekat seperti mata, hidung, atau telinga. 

 
 

Lihat rajah 6.4.57 bagaimana kedudukan kamera dan sudut pandangan kamera 

boleh digunakan untuk mengatur shots dan scene yang akan kelihatan apabila 

rendering dilaksanakan. 

 
Rajah 6.4.57: Kedudukan kamera (bulatan biru) menentukan apa yang dilihat 

penonton dalam adegan filem animasi ini dari A Bug's Life. 
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Rajah 6.4.58: Hasil medium shot. 

 

Dengan memilih sudut kamera yang sesuai bukan sahaja dapat menambahkan 

lagi suasana pada scene tersebut malah dapat mewujudkan hubungan yang kuat 

dengan orang yang melihat. 
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Jenis-jenis pergerakan kamera 

Kamera dalam persekitaran animasi 3D boleh berada di satu tempat, diputar atau 

diperbesarkan. Ia boleh melakukan banyak perkara yang sukar dicapai oleh 

kamera biasa. Cara kamera bergerak dapat memberi makna kepada apa yang 

berlaku di paparan.  

 
Rajah 6.4.59: Pergerakan Kamera dalam 3D. 

Berikut adalah dua contoh jenis pergerakan kamera yang diaplikasikan dalam 

scene 3D dengan menggunakan perisian Cinema 4D. 
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• Crane 

Pergerakan kamera maya dari bawah ke atas atau sebaliknya bagi      

menampakkan keadaan objek pada ketinggian yang berbeza. 

Rajah 6.4.60: Pergerakan kamera crane dalam perisian Cinema 4D. 

 

• Hand held 

Kamera bergerak secara dinamik seolah-olah penonton berada dalam 

pemandangan animasi tersebut. 

 

 
Rajah 6.4.61: Pergerakan kamera Hand Held dalam perisian Cinema 4D.  
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6.4.8 Menghasilkan Animasi Gerakan Kamera Dalam Persekitaran Animasi 3D 

Mengikut Kesesuaian. 

 

Animasi di dalam 3D adalah satu proses melakukan pergerakan-pergerakan 

sesuatu objek atau sudut pandangan dalam sesuatu jarak ruang mengikut arah 

tiga dimensi. Animasi di dalam aplikasi 3D lebih menarik jika dibandingkan dengan 

animasi 2D kerana ia kelihatan lebih realistik dan kompleks. 

 

Dalam dunia animasi 3D, animasi boleh dibahagikan secara umumnya kepada 

dua bentuk iaitu: 

• Animasi objek 

• Animasi kamera 

 

Kedua-dua bentuk animasi ini boleh dikategorikan kepada dua jenis iaitu: 

• Frame by frame animation 

• Tweening Animation 

 

Animasi objek berlaku apabila berlaku pergerakan sesuatu objek di dalam sesuatu 

ruang. 

 

Animasi kamera pula berlaku apabila berlaku pergerakan pada kamera (dalam 

hal ini ia adalah sudut pandangan pengguna) menampakkan seolah-olah sesuatu 

benda itu bergerak atau pengguna itu merasakan seolah-olah ia sedang bergerak. 
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Membuat Animasi Berdasarkan Pergerakan Kamera 

 

1. Buka fail cahaya_mejateko.max. 

 

2. Pergi kepada Command Panel dan klik 

panel Create. Klik ikon camera.  

 

3. Pada bahagian Object Type, pilih Target.   

4. Aktifkan Left Viewport.  

                                                                           

Rajah 6.4.62: Panel camera. 

 

5. Pada kedudukan atas sedikit dari aras permukaan meja dan jauh sedikit ke 

kanan, Klik kiri tetikus dan heret mendekati ke arah objek di atas meja. Lihat rajah 

di bawah. 

 

 
Rajah 6.4.63: Perletakan kamera dalam scene. 
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6. Satu prisma bergaris biru akan terbentuk.  Prisma ini mewakili pandangan dari 

kamera. 

 

7. Aktifkan Persepective Viewport dengan cara mengklik butang sebelah kanan 

tetikus. 

 

8. Tekan huruf ‘C’ pada papan kekunci. Huruf C adalah singkatan bagi 

perkataan Camera. Tekan huruf C pada papan kekunci, untuk melihat sudut 

pandangan kamera. 

 

 

  
Perspective viewport Camera viewport 

Rajah 6.4.64: Pandangan kamera 

 

9. Aktifkan Top Viewport.  

 

10. Buatkan pandangannya seperti rajah di bawah.  
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Rajah 6.4.65: Perletakan kamera dari pandangan top. 

 

11. Anda boleh membuat penyesuaian pada bentuk pandangan viewport anda 

dengan menggunakan butang          dan      .  

 

12. Pada bar Animation Control, klik pada butang Time Configuration yang 

ditunjukkan pada rajah di bawah. 

 
 

 

 

Rajah 6.4.66: Butang Time Configuration. 

 

13. Pada tab Animation, setkan Start Time kepada 0 dan End Time kepada 200. 
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14. Klik pada butang Auto Key pada Bar Animation Control.  

 

 

Rajah 6.4.68: Butang Auto Key. 

 

15. Ubah kedudukan kamera dengan menggunakan Move tool seperti rajah di 

bawah. 

 

 
 Rajah 6.4.69: Kedudukan kamera pada frame 0. 

 

16. Dalam kotak Current Time taipkan angka 50.  

 

 

Rajah 6.4.70: Tetapan pada kotak Current Time. 

 

17. Gerakkan kamera berpusing arah ke kanan dengan fokusnya menghadap 

meja. 
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Rajah 6.4.71: Kedudukan kamera pada frame 50. 

 

18. Ulang langkah 16 di atas dengan kedudukan kamera pada setiap frame 

• 100 

• 150 

• 200  

dengan memusingkan kamera mengikut arah seperti yang ditunjukkan 

dalam rajah di bawah. 

 
Rajah 6.4.72: Kedudukan kamera pada frame 100. 
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Rajah 6.4.73: Kedudukan kamera pada frame 150. 

 

 
Rajah 6.4.74: Kedudukan kamera pada frame 200. 

 

19. Klik semula butang Auto Key setelah selesai. 

 

20. Cuba mainkan animasi anda dengan menggerakkan slider bar.  

 

21. Simpan fail dengan nama animasi_kamera.max. 

 

22. Anda telah berjaya menghasilkan animasi gerakan kamera. 
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1. Komputer  

2. Perisian Animasi 3D 

3. Fail ‘permainanboling.max’ 

4. Fail 3D animasimejateko.max 

 

TUGASAN  

- Murid dapat mengetahui fungsi kamera dalam animasi 3D. 

- Murid dapat menggunakan kamera dalam menghasilkan   

   animasi gerakan kamera dalam persekitaran animasi 3D. 

- Murid menghasilkan tiga shot kedudukan dan sudut     

   pandangan kamera yang berbeza pada scene          

          ‘permainanboling.max’. 

 

LANGKAH KERJA (TUGASAN 1) 

1. Buka perisian animasi 3D. 

2. Kenal pasti dan terokai camera pada perisian animasi 3D. 

3. Buka fail animasimejateko.max. 

4. Letakkan dua kamera dalam animasi meja teko. 

5. Gerakkan kamera untuk animasi pergerakan kamera1 dan kamera2. 

6. Mainkan kamera1 dalam viewport camera dan simpan sebagai 

animasigerakankamera1.max. 

7. Mainkan kamera2 dalam viewport camera dan simpan sebagai 

animasigerakakamera2.max. 

8. Lihat perbezaan hasil gerakan kamera1 dan kamera2. 
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LANGKAH KERJA (TUGASAN 2) 

1. Buka fail ‘permainanboling.max’. 

2. Pergi kepada Command Panel dan klik panel Create. Klik ikon Camera. 

3. Pada bahagian Object Type, pilih Target kamera. 

4. Aktifkan Top viewport, klik dan seretkan objek kamera ke arah pusat objek yang 

disasarkan. 

5. Aktifkan Perspective viewport dengan cara mengklik butang sebelah kanan 

tetikus. 

6. Tekan huruf ‘C’ pada papan kekunci untuk mengaktifkan sudut pandangan 

kamera. * Perhatikan di sebelah kanan bawah pada bar Animation Control, 

kawalan navigasi viewport telah berubah. Terdapat kawalan yang berbeza 

untuk kamera semasa viewport Camera sedang aktif. 

7. Pilih mana-mana viewport. 

8. Klik pada objek kamera dan buatkan pergerakan yang sesuai pada kamera 

dengan menggunakan: 

8.1  Truck Camera Button  

8.2  Dolly Camera Button  

8.3  Orbit Camera Button 

9. Lihat setiap hasil shot pada Camera viewport bagi tiga jenis pergerakan kamera 

di atas. 

10. Simpan fail dengan nama ‘truckboling.max’,‘dollyboling.max’ dan 

‘orbitboling.max’. 
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LATIHAN/ PENILAIAN 
 

1. Pada rajah di bawah bulatkan ikon kamera (Camera icon) dan Object Type. 

 

2. Pilih dan tuliskan jenis kedudukan kamera (camera angle) bagi shot filem 

animasi ‘The Incredibles’ di bawah dengan betul. 

 

 

 

 
 

 

 

 
  

 

 

 

 
  

 

 

Full shot 

Extreme Close-up shot 

Medium shot Long shot Wide shot 
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3. Namakan jenis pergerakan kamera yang ditunjukkan dalam perisian 

animasi 3D di bawah. 

 
Kedudukan Asal 
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LAPORAN PENCAPAIAN MURID 
Nama Murid:  

Tahun:  

Kelas:  

 

Standard 

Kandungan: 

6.5 Animasi 3D 

 

Standard 

Pembelajaran: 

6.4.7 Menentukan kesesuaian kedudukan dan sudut  

pandangan kamera dalam persekitaran animasi 3D. 

6.4.8  Menghasilkan animasi gerakan kamera dalam 

persekitaran animasi 3D mengikut kesesuaian. 

 

Bil Perkara yang dinilai 

Pencapaian 

Catatan 
Terampil 

Belum 

Terampil 

1 
Memahami konsep gerakan 
kamera dalam animasi 3D. 

   

2 
Mengenal pasti jenis-jenis 
kedudukan dan sudut pandangan 
kamera dalam persekitaran 3D. 

   

3 
Mengenal pasti jenis-jenis 
pergerakan kamera dalam 
persekitaran 3D. 

   

4 
Meletakkan kamera ke dalam 
animasi 3D. 

   

5 
Mengerakkan kamera untuk 
menghasilkan animasi 3D. 

   

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 



140 

 

 

 

 

MODUL 6.4E 
 

Standard 

kandungan: 

 

6.4 Animasi 3D 

Standard 

pembelajaran:  

6.4.9  Menghasilkan persekitaran animasi 3D dengan 

membuat penetapan proses rendering 

menggunakan perisian animasi 3D. 

 

Objektif 

Pembelajaran: 

1. Memahami konsep proses rendering dalam animasi 3D 

2. Membuat tetapan proses rendering dalam perisian 

animasi 3D 

3. Menyimpan hasil rendering animasi 3D 

 

 

Masa: 

 

 

6 jam 

 

 

 

 

 

 

 

Nama Guru:  Tandatangan & 

Tarikh 

 

Disahkan oleh:  Tandatangan & 

Tarikh 
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NOTA RUJUKAN 
 

6.4.9  Menghasilkan Persekitaran Animasi 3d Dengan Membuat Penetapan Proses 

Rendering Menggunakan Perisian Animasi 3D. 

 

Rendering adalah proses mengumpul maklumat animasi yang telah diskripkan 

melalui perbezaan nilai-nilai kedudukan sesuatu objek di atas satah X, Y dan Z, atau 

satu komposisi 3D kepada rentetan gambar yang berbentuk 2D. Biasanya model-

model yang telah melalui proses rendering, boleh disimpan di dalam pelbagai 

bentuk fail animasi seperti fli, flc, avi, mov, mpeg dan lain-lain lagi. 

 

Proses Rendering 

Setelah berpuashati dengan hasil animasi, anda perlu melakukan proses rendering. 

Setelah proses rendering ini dilakukan, baharulah rentetan animasi ini dapat 

dipindahkan ke filem, pita video atau ke dalam pelbagai format untuk digunakan 

di dalam komputer. 

 

Proses membuat rendering mungkin memakan masa bergantung kepada tekstur 

yang digunakan, bentuk pencahayaan dan kompleksnya sesuatu animasi.  

Membuat Rendering dan Menyimpan Fail Dalam Format Animasi. 

1. Buka fail animasi_kamera.max.  

2. Aktifkan Viewport Kamera. 

 

 

 

                                           

 

 

                      Rajah 6.4.75: Pandangan kamera objek teko dan meja 
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3. Klik menu Rendering pada menu 

bar dan klik Render.  Kotak dialog 

Render Scene akan terpapar.  

 

4. Bagi bahagian Common 

Parameter, dalam bahagian Time 

Output pilih Active Time segment. 

 

5. Dalam bahagian Output Size pilih 

jenis resolusi yang dikehendaki 

misalnya ‘640 x 480’. 

 

6. Pada bahagian Render Output 

pilih opsyen Save File. 

 

7. Klik pada butang ‘File….’,  

 

 

 

 

 

 

 

 

 

Rajah 6.4.76: Kotak dialog Render Scene 
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Rajah 6.4.77: Kotak dialog Render Output File. 

 

8. Pada kotak dialog Render Output File: 

- Taipkan pada File Name : Render_Animasi 

- Save as type: pilih format *.avi 

 

9. Klik butang Save 

 

10. Klik butang Render. 

 

11. Buka folder yang menyimpan fail rendering. 

 

12. Dwi klik pada fail Render_Animasi untuk melihat hasil rendering. 
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1. Perisian Animasi 3D  

2. Komputer  

 

TUGASAN  

- Murid meneroka dan mengetahui tetapan untuk proses 

rendering animasi 3D.  

- Murid melaksanakan proses rendering untuk menghasilkan 

persekitaran animasi 3D. 

- Murid menyimpan hasil rendering dalam format *.avi 

menggunakan perisian animasi 3D 

 

 

LANGKAH KERJA (TUGASAN) 

1. Buka perisian animasi 3D. 

2. Menghasilkan satu projek animasi 3D berdurasi minimum 200 frame. 

3. Kenal pasti dan terokai tetapan Rendering pada perisian animasi 3D. 

4.  Buat tetapan proses rendering dalam perisian animasi 3D. 

5. Simpan hasil rendering animasi 3D sebagai animasi3d.avi menggunakan 

perisian animasi 3D. 

6. Melaksanakan proses rendering untuk animasi 3D yang dihasilkan. 
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LATIHAN/ PENILAIAN 
 

1. Berdasarkan rajah di bawah,  bulatkan tetapan Time Output untuk proses 

rendering. 

 

 
 

2. Nyatakan dua Output Size yang boleh digunakan dalam proses rendering. 

 

i. __________________________ 

 

ii. __________________________ 

 

 

3. Nyatakan dua format fail yang digunakan untuk menyimpan hasil animasi 3D.  

 

a __________________________ 

 

b __________________________ 
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  

Tahun:  

Kelas:  

 

Standard 

Kandungan: 

6.4  Animasi 3D  

Standard 

Pembelajaran: 

6.4.9  Menghasilkan persekitaran animasi 3D dengan 

membuat penetapan proses rendering 

menggunakan perisian animasi 3D. 

 

Bil Perkara yang dinilai 

Pencapaian 

Catatan 
Terampil 

Belum 

Terampil 

1 
Memahami konsep proses 

rendering dalam animasi 3D. 
   

2 
Membuat tetapan proses rendering 

dalam perisian animasi 3D. 
   

3 
Menyimpan hasil rendering animasi 

3D. 
   

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 

 

Nama Guru:  Tandatangan & 

Tarikh 

 

Disahkan oleh:  Tandatangan & 

Tarikh 
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MODUL 7 : 
 

PEMBANGUNAN  
PRODUK MULTIMEDIA 
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MODUL 7.1A  
 

Standard 

kandungan: 

 

7.1       Analisis Keperluan Projek 

Standard 

pembelajaran:  

7.1.1. Menerangkan Fasa Pembangunan Produk 

Multimedia 

(i) Analisis Keperluan 

(ii) Reka Bentuk 

(iii) Implimentasi 

(iv) Pengujian dan Penilaian 

(v) Pembungkusan dan Pengedaran 

7.1.2. Menjelaskan jenis produk multimedia seperti: 

(i) Kiosk maklumat 

(ii) CD/DVD Interaktif 

(iii) Berasaskan web 

(iv) Aplikasi mudah alih 

7.1.3. Menerangkan mod atau platform persembahan 

produk: 

(i) Dalam talian (on-line) 

(ii) Luar talian (on-line) 

 

Objektif: 1. Menerangkan secara ringkas fasa yang terlibat 

dalam Fasa Pembangunan Produk Multimedia. 

2. Menjelaskan pelbagai jenis produk multimedia. 

3. Membanding beza mod atau platform 

persembahan produk. 

 

Masa: 4  jam 
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NOTA RUJUKAN 
 

7.1.1 Menerangkan Fasa Pembangunan Produk Multimedia 

 

Analisis Keperluan 

Fasa ini merupakan fasa yang pertama dan yang paling utama kerana fasa ini 

membolehkan pasukan pembangun untuk menentukan fokus projek yang ingin 

dibangunkan. Pasukan perlu mendapatkan maklum balas daripada klien atau 

pengguna akhir untuk menentukan pernyataan masalah dan kertas cadangan. 

Pada fasa ini, satu kertas cadangan akan dihasilkan. 

 

Reka Bentuk 

Fasa ini merujuk kepada perancangan reka bentuk projek multimedia yang akan 

dibangunkan. Dalam fasa ini carta alir dan papan cerita akan dihasilkan. Carta alir 

merupakan satu aliran simbol yang dibuat untuk menggambarkan secara 

keseluruhan struktur produk multimedia serta urutan pergerakan proses atau aktiviti 

yang terlibat. Papan cerita pula ialah satu siri imej atau lakaran yang 

menggambarkan atau menjelaskan penyusunan, urutan dan perincian maklumat 

tentang persembahan multimedia yang dibangunkan. 

 

Implimentasi 

Dalam fasa ini, pasukan pembangun akan mula membangun produk multimedia 

berdasarkan pelan reka bentuk yang telah dihasilkan. Pembangunan produk ini 

merangkumi kerja-kerja untuk mengintegrasikan kesemua elemen multimedia iaitu 

teks, grafik, audio, video dan animasi. Satu perisian pengarangan akan digunakan 

untuk mengintegrasikan kesemua elemen ini. 
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Pengujian dan Penilaian 

Fasa pengujian bertujuan untuk memastikan produk multimedia yang dibangunkan 

berkualiti serta tanpa sebarang ralat. Beberapa orang pengguna terpilih akan 

menilai produk tersebut dan memberikan maklum balas agar produk tersebut 

dapat ditambah baik sekiranya perlu. Dalam fasa ini, satu prototaip produk akan 

diuji melalui pengujian alfa dan beta. 

 

Pembungkusan dan Pengedaran 

Fasa ini melibatkan proses penyerahan aplikasi kepada pengguna. Proses ini akan 

melibatkan penghasilan CD, penerbitan di laman web, kiosk, aplikasi mudah alih 

atau pelbagai medium lain yang boleh digunakan. Proses pembungkusan CD juga 

dilakukan pada fasa ini.  
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7.1.2 Menjelaskan Jenis Produk Multimedia 

 

Kiosk maklumat 

 
Rajah 7.1.1: Kiosk Tiket Terminal Bersepadu Selatan 

 

Sebuah terminal komputer yang menyediakan akses kepada maklumat untuk 

komunikasi, hiburan atau pendidikan. Biasanya disediakan di tempat-tempat yang 

sentiasa dikunjungi seperti kompleks pasar raya, pejabat, lapangan terbang serta 

tempat-tempat tumpuan pelancong. Paparan bagi sebuah kiosk maklumat 

interaktif perlulah berupaya menarik minat pengguna di samping memuatkan 

pelbagai maklumat penting yang diperlukan. 

 

CD/ DVD Interaktif 
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Rajah 7.1.2: CD Pembelajaran Interaktif 

 

CD/ DVD merupakan salah satu medium produk multimedia yang luas digunakan. 

Antara kelebihan penggunaan CD/ DVD adalah produk-produk ini mudah untuk 

dibawa dan biasanya tidak memerlukan sambungan Internet. Salah satu produk 

multimedia yang menggunakan CD/ DVD sebagai mediumnya ialah perisian 

pembelajaran interaktif. 
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Berasaskan web 

 
Rajah 7.1.3: Laman Web KPM 

 

Aplikasi multimedia berasaskan web digunakan secara meluas di seluruh Internet. 

Salah satu kelebihan multimedia berasaskan web ialah sentiasa dapat dinaik taraf 

sesuai dengan perkembangan semasa. Selain itu sebuah produk multimedia 

berasaskan web juga mudah dicapai di mana-mana sahaja asalkan mempunyai 

rangkaian Internet.  

 

Aplikasi mudah alih 

 

 

 
 

Rajah 7.1.4: Pelbagai aplikasi mudah alih 

 

Aplikasi mudah alih merujuk kepada produk multimedia yang boleh diakses melalui 

peranti mudah alih. Salah satu kelebihan utama aplikasi mudah alih ialah 

keupayaan memuat turun atau melihat kandungan seperti rancangan televisyen, 

sukan, atau laporan berita walaupun berada jauh dari rumah atau pejabat. 

Perkhidmatan pesanan teks, gambar, dan video ialah contoh aplikasi mudah alih. 
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7.1.3 Menerangkan Mod atau Platform Persembahan Multimedia 

 

Jadual 7.1.1: Perbandingan Mod Persembahan Multimedia Dalam dan Luar Talian 

Aplikasi 

Multimedia 
Dalam Talian Luar Talian 

Kelebihan 

Memberikan maklumat 

terkini kepada pengguna 

kerana dihubungkan 

kepada pelayan untuk 

mendapatkan data masa 

nyata. 

 

Persembahan multimedia 

boleh sentiasa digunakan 

walaupun rangkaian 

Internet yang terhad. 

Memudahkan pengguna 

mengakses persembahan 

tersebut di mana-mana 

sahaja menerusi pelbagai 

peranti yang ada. 

 

Tidak perlu memuatkan 

data dari rangkaian 

Internet untuk memulakan 

persembahan multimedia. 

 

Kelemahan 

Memerlukan sambungan 

internet yang baik dan 

stabil.  

 

Maklumat yang 

dipaparkan mungkin tidak 

menggambarkan data 

yang terkini. 

 

Bilangan pengguna yang 

terlalu ramai boleh 

mempengaruhi kelancaran 

persembahan. 

 

Tidak dapat digunakan 

pada peranti selain peranti 

asal melainkan ia dipasang 

/ disalin ke peranti baru. 
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LATIHAN/ PENILAIAN 
 

1. Nyatakan lima fasa pembangunan produk multimedia. 

i. _____________________________________________________________ 

ii. _____________________________________________________________ 

iii. _____________________________________________________________ 

iv. _____________________________________________________________ 

v. _____________________________________________________________ 

 

2. Nyatakan kelebihan serta kekurangan bagi aplikasi multimedia dalam talian 

atau luar talian dalam jadual di bawah. 

 

Jadual 1 

Aplikasi 

Multimedia 
Dalam Talian Luar Talian 

Kelebihan 

_________________________ 

_________________________ 

_________________________ 

___________________________ 

___________________________ 

___________________________ 

_________________________ 

_________________________ 

_________________________ 

___________________________ 

___________________________ 

___________________________ 

Kelemahan 

_________________________ 

_________________________ 

_________________________ 

___________________________ 

___________________________ 

___________________________ 

_________________________ 

_________________________ 

_________________________ 

___________________________ 

___________________________ 

___________________________ 
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3. Padankan jenis media produk multimedia tersebut dengan imej yang diberikan 

 

Kiosk 

Maklumat  
●   ●  

 

CD / DVD  ●   ●  

 

Berasaskan 

Web  
●   ●  

 

Aplikasi 

mudah alih  
●  

 

 
●  
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  
Tahun:  
Kelas:  

 
Standard 
Kandungan: 

7.1. Analisis Keperluan Projek 
 

Standard 
Pembelajaran: 

7.1.1. Menerangkan Fasa Pembangunan Produk 

Multimedia. 

7.1.2. Menjelaskan jenis produk multimedia. 

7.1.3. Menerangkan mod atau platform persembahan 

produk. 

 

Bil Perkara yang dinilai 
Pencapaian 

Catatan 
Terampil 

Belum 
Terampil 

1 
Menerangkan fasa pembangunan 

produk multimedia. 
   

2 
Menjelaskan pelbagai jenis produk 

multimedia. 
   

3 
Membanding beza mod atau 

platform persembahan produk. 
   

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 
 

Nama Guru: 
 

Tandatangan & 

Tarikh 
 

Disahkan oleh: 
 

Tandatangan & 

Tarikh 
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MODUL 7.1B 
 

Standard 

kandungan: 

 

7.1       Analisis Keperluan Projek 

Standard 

pembelajaran:  

7.1.4 Membuat analisis keperluan projek pembangunan 

produk multimedia 

7.1.5 Mencadangkan anggaran kos pembangunan 

produk multimedia berdasarkan masa dan 

keperluan ahli pasukan 

7.1.6 Menghasilkan kertas cadangan projek 

pembangunan produk multimedia 

 

Objektif: 

 

1. Mengenal pasti aspek yang perlu dipertimbangkan 

semasa analisis keperluan projek pembangunan 

produk multimedia. 

2. Membuat pengiraan anggaran kos pembangunan 

produk multimedia. 

3. Menghasilkan kertas cadangan projek 

pembangunan produk multimedia. 

 

Masa: 

 

 

12  jam 
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NOTA RUJUKAN 
 

7.1.4 Membuat analisis keperluan projek pembangunan produk multimedia 

 

Analisis keperluan merupakan fasa awal yang terpenting sebelum membangunkan 

sebuah produk multimedia. Peringkat ini juga merupakan satu gambaran idea 

tentang perancangan tindakan yang akan dilakukan dalam keseluruhan proses 

pembangunan projek. Peringkat ini penting agar proses pembangunan projek 

berjalan lancar dan tersusun seperti yang dirancang.   

Antara aspek yang perlu dipertimbangkan semasa membuat analisis 

keperluan ialah: 

Jadual 7.1.2: Aspek penting semasa membuat analisis keperluan 

Persoalan Aspek 

▪ Apakah projek yang ingin dibangunkan? 
▪ Tajuk projek 

▪ Jenis produk 

▪ Mengapakah projek tersebut ingin 

dihasilkan? 

▪ Pernyataan masalah 

▪ Objektif projek 

▪ Siapakah sasaran pengguna untuk projek 

yang dibangunkan? 
▪ Kumpulan pengguna akhir 

▪ Apakah elemen multimedia yang sesuai 

digunakan dalam penyampaian 

kandungan projek? 

▪ Elemen multimedia (teks, 

grafik, animasi, video, 

audio) 

▪ Adakah kandungan bahan tersedia atau 

perlu dihasilkan sendiri? 

▪ Kandungan dibeli/ 

dihasilkan sendiri/ sedia ada 

▪ Apakah keperluan perkakasan dan 

perisian untuk pembangunan projek? 
▪ Perkakasan dan perisian 

▪ Adakah pembangun mempunyai 

keupayaan dan kemahiran untuk 

menggunakan perkakasan dan perisian? 

▪ Kemahiran pembangun 

▪ Pasukan produksi 

▪ Siapakah yang akan terlibat dalam 

pembangunan projek? 
▪ Pasukan produksi 
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Persoalan Aspek 

▪ Berapakah masa yang akan diambil 

untuk pembangunan projek? 

▪ Tempoh masa 

pembangunan projek 

▪ Berapakah kos yang diperlukan untuk 

pembangunan projek? 
▪ Anggaran kos keseluruhan 

▪ Bagaimanakah projek akan diedarkan 

kepada penguna akhir? 

▪ Mod atau platform 

persembahan 
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7.1.5 Mencadangkan anggaran kos pembangunan produk multimedia 

berdasarkan masa dan keperluan ahli pasukan 

 

Jenis Kos 

Anggaran kos pembangunan produk multimedia dibuat bagi mengetahui jumlah 

wang yang perlu dibelanjakan untuk menghasilkan suatu produk multimedia. Kos 

yang perlu dipertimbangkan ialah: 

 

Jadual 7.1.3: Jenis-jenis kos 

Jenis kos Penerangan 

Kos buruh 

● Kos yang perlu dibayar kepada ahli pasukan 

produksi yang terlibat. 

● Kos biasanya dikira berdasarkan kadar upah per 

hari dan bilangan hari bekerja. 

● Merupakan kos yang paling tinggi dalam 

pembangunan produk multimedia. 

● Dirujuk daripada Jadual Proses Kerja dan Jadual 

Garis Panduan Menentukan Kos Buruh. 
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Jenis kos Penerangan 

Kos peralatan 

● Kos yang dibayar untuk pembelian atau sewa 

setiap peralatan atau perisian yang digunakan 

dalam pembangunan projek. 

● Pengiraannya berdasarkan harga pembelian atau 

kadar sewa dan bilangan hari digunakan. 

● Contoh peralatan seperti kamera digital, kamera 

video, komputer, mesin pencetak, perisian dan 

sebagainya. 

Kos sampingan 

● Kos yang dibayar selain kos buruh dan kos 

peralatan. 

● Sebagai contohnya perbelanjaan pengangkutan, 

perbelanjaan penginapan, bil elektrik, bil air, sewa 

premis, kos perjalanan, kos membuat salinan, 

pembelian CD/ DVD dan sebagainya. 

 

Jadual Proses Kerja dan Jadual Garis Panduan Menentukan Kos Buruh 

Jadual proses kerja memaparkan bilangan hari bekerja bagi setiap ahli pasukan 

produksi yang terlibat dalam setiap fasa pembangunan projek multimedia. Jumlah 

bilangan hari bekerja mesti tidak melebihi  jumlah hari yang diperuntukkan untuk 

pembangunan projek.  

Jadual 7.1.4: Contoh jadual proses kerja 

Proses Kerja Pengurus 
Projek (Hari) 

Pereka 
Bentuk (Hari) 

Pengatur 
cara (Hari) 

Pakar Isi 
Kandungan 

(Hari) 
Analisis keperluan 5 2 2 3 
Reka bentuk 10 10 4 4 
Pembangunan 15 10 10 2 
Pengujian dan 
Penilaian 

10 8 5 8 

Pembungkusan dan  
Pengedaran 

5 5 - - 

Jumlah Hari 45 35 21 17 

CO
NTO

H 
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Berikut ialah contoh jadual garis panduan untuk menentukan kos buruh. 

 

Jadual 7.1.5: Contoh garis panduan menentukan kos buruh 

Jawatan 
Rendah 

(RM per hari) 
Sederhana 

(RM per hari) 
Tinggi 

(RM per hari) 
Pengurus Projek 50 75 100 

Pakar Isi Kandungan 30 50 75 

Jurugambar 15 25 50 
Artis Grafik/ Pereka Bentuk 20 40 60 
Narator 15 30 40 
Ahli Muzik 15 25 75 
Pakar Video 15 30 200 
Pakar Audio 15 30 75 
Pengatur cara  20 35 50 
Arkitek Multimedia 15 30 40 

Juruanimasi Komputer 20 30 
500 (setiap 
model siap) 

 

Selain itu, kadar bayaran untuk kos buruh juga boleh dirujuk daripada 

pautan berikut https://www.payscale.com/research/MY/Job. 

 

Contoh Pengiraan Anggaran Kos Pembangunan Produk Multimedia 

Contoh Produk : CD Pembelajaran Interaktif “Mari Kenali 123”  

Tempoh Masa : 45 Hari 

i. Kos Buruh 

Pasukan Produksi Kadar Upah/ 
Hari (RM) 

Bilangan Hari 
Bekerja 

Kos 
(RM) 

Pengurus Projek 100.00 45 4,500.00 
Pereka Bentuk 60.00 35 2,100.00 
Pengatur cara 50.00 21 1,050.00 
Pakar Isi Kandungan 75.00 17 1,275.00 
Jumlah Kos Buruh  8,925.00 

Nota: Pasukan produksi dan bilangan hari dirujuk daripada jadual 7.1.4 

manakala kadar upah dirujuk daripada jadual 7.1.5 pada kadar tinggi. 

CO
NTO

H 

CO
NTO

H 
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ii. Kos Peralatan 

Butiran Kadar (RM) Jumlah Hari Kos (RM) 

Pencetak dan pengimbas 80.00 5 400.00 

Sewa komputer 120.00 30 3,600.00 

Kamera digital 100.00 6 600.00 

Jumlah Kos Buruh  4,600.00 

 

iii. Kos Sampingan 

Butiran Kos (RM) 

Bil elektrik 300.00 

Pengangkutan 500.00 

CD dan kulit CD 1,000.00 

Jumlah Kos Buruh 1,800.00 

 

 

iv. Kos Keseluruhan Projek 

Butiran Kos (RM) 

Kos buruh 8,975.00 

Kos peralatan 4,600.00 

Kos sampingan 1,800.00 

Jumlah Kos Keseluruhan  15,325.00 

 

  

CO
NTO

H 

CO
NTO

H 

CO
NTO

H 



165 

 

7.1.6 Menghasilkan kertas cadangan projek pembangunan produk multimedia 

Kertas cadangan merupakan satu dokumen yang mengandungi maklumat 

keseluruhan  tentang suatu produk multimedia yang ingin dibangunkan. Kertas 

cadangan juga menyediakan maklumat tentang latar belakang projek, skop kerja 

sehingga kos yang terlibat dalam pembangunan projek.  

Antara kandungan kertas cadangan projek multimedia ialah: 

 

Kandungan Penerangan & Contoh 

Tajuk Dipaparkan pada muka 

hadapan kertas cadangan. 

Contoh tajuk: CD Pembelajaran 

Interaktif “Mari Kenali 123” 

 

 

 

 

 

 

Pernyataan 

Masalah 

Penerangan ringkas tentang masalah atau isu yang ingin 

diselesaikan atau dibaiki yang menyebabkan suatu produk 

multimedia ingin dihasilkan. 

Contoh: 

a) Kurang CD pembelajaran interaktif untuk kanak-kanak 

yang menggunakan Bahasa Melayu di pasaran. 

b) ... 

Objektif Penerangan ringkas tentang tujuan atau matlamat yang ingin 

dicapai dalam penghasilan suatu produk multimedia. 

Contoh : 

a) Membangunkan sebuah CD pembelajaran interaktif 

untuk kanak-kanak. 

b) ... 

CO
NTO

H 
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Kandungan Penerangan & Contoh 

Skop Projek 

 

Penerangan tentang limitasi atau batasan projek yang 

dibangunkan. 

Contoh: 

a) Pembangunan CD pembelajaran interaktif ini hanya 

untuk kegunaan platform luar talian sahaja. 

Penggunaan produk ini secara dalam talian mungkin 

memerlukan sistem sokongan lain. 

b) ... 

Sasaran 

Pengguna 

Penerangan ringkas tentang siapa pengguna akhir untuk 

produk multimedia yang dibangunkan seperti umur, kumpulan 

usia, kelompok masyarakat dan sebagainya. 

Contoh: 

a) Kanak-kanak yang berumur 4 – 7 tahun. 

b) Guru-guru taska/ Ibu bapa/ Remaja 

c) ... 

Jenis Produk Penerangan tentang jenis produk multimedia yang 

dibangunkan seperti CD interaktif, kiosk maklumat, laman 

web, aplikasi mudah alih dan sebagainya. 

Contoh: 

Jenis Produk: CD interaktif 

Mod/ 

Platform 

Persembahan 

Produk 

Penerangan tentang cara atau kaedah produk multimedia 

dipersembahkan kepada pengguna seperti secara dalam 

talian (on-line) atau secara luar talian (off-line). 

Contoh: 

Mod Persembahan: Luar talian 
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Kandungan Penerangan & Contoh 

Keperluan 

Perkakasan 

dan Perisian 

Penerangan tentang spesifikasi perkakasan dan perisian yang 

digunakan untuk pembangunan projek multimedia serta 

keperluan perkakasan dan perisian untuk pengguna akhir. 

Contoh: 

a) Perkakasan dan perisian untuk pembangunan 

Perkakasan Perisian 

● Komputer (RAM: 

8GB, SDD 500 GB) 

● Drawing tablet 

● Pembakar CD/ DVD  

● Flash 8 

● Adobe Photoshop 8 

● Windows 10 (OS) 

 

b) Perkakasan dan perisian untuk pengguna akhir 

Perkakasan Perisian 

● Pemain CD/ DVD 

● Komputer/ Komputer 

riba 

● Televisyen 

● Flash Player 

 

Jadual Masa 

(Garis masa 

projek) 

Jadual yang memaparkan rancangan pelaksanaan setiap 

fasa pembangunan projek mengikut hari/ minggu/ bulan. 

Contoh: 

 

CO
NTO

H 
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Kandungan Penerangan & Contoh 

Senarai Tugas 

Ahli Pasukan 

Penerangan tentang peranan setiap ahli pasukan produksi 

yang terlibat.  

Contoh: 

Pasukan 

Produksi 
Tugas 

Pengurus 

Projek 

● Memastikan kelancaran kerja-kerja 

pembangunan projek pada setiap fasa. 

● Menyelaras tugas setiap pasukan 

produksi yang terlibat. 

● Memastikan persediaan peralatan, 

perisian, tempat, pengangkutan, 

penginapan dan keperluan setiap 

pasukan produksi. 

... ... 
 

Anggaran Kos Anggaran jumlah wang yang perlu dibelanjakan untuk 

pembangunan projek multimedia (Sila rujuk 7.1.5).  

Kos 

keseluruhan 

projek 

=  Kos Buruh + Kos Peralatan  + 
Kos 

Sampingan 

 

Kesimpulan Rumusan ringkas dan harapan pembangun tentang projek 

yang ingin dibangunkan. 
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1. Komputer  

2. Perisian Microsoft Word 

3. Kalkulator 

4. Mesin pencetak 

 

TUGASAN  

Murid menghasilkan kertas cadangan projek multimedia yang 

merangkumi tajuk, pernyataan masalah, objektif, skop projek, 

sasaran pengguna, jenis produk, mod/ platform persembahan, 

jadual masa, senarai tugas ahli pasukan, anggaran kos dan 

kesimpulan. 

 

LANGKAH KERJA (TUGASAN) 

1. Murid berbincang dengan guru tentang tajuk projek multimedia yang ingin 

dihasilkan. 

2. Murid menghasilkan kertas cadangan dan anggaran kos menggunakan 

Microsoft Word. 

3. Kertas cadangan disimpan dan dicetak. 
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LATIHAN/ PENILAIAN 
 

1. Tuliskan aspek penting dalam analisis keperluan yang sesuai dengan butiran 

yang diberikan dalam jadual di bawah 

 

Jadual 1 

Butiran Aspek 

● CD interaktif 

● Aplikasi mudah alih 
 

● Flash 8 

● Adobe Photoshop 
 

● Kos buruh 

● Kos peralatan 

● Kos sampingan 

 

● Remaja 

● Ibu bapa 

● Pelajar sekolah rendah 

 

● Artis grafik 

● Arkitek multimedia 

● Pakar video 
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2. Anda diminta menghasilkan satu tayangan video bagi Majlis Perasmian Program 

Jom Melawat Sabah dengan kos tidak melebihi RM 60,000. Jangka masa untuk 

menyiapkan projek ini ialah selama 60 hari. 

 

Jadual 2 ialah jadual proses kerja untuk menghasilkan persembahan multimedia 

tersebut. 

Jadual 2 

Proses Kerja 

Pengurus 

Projek 

(Hari) 

Pereka 

Bentuk 

(Hari) 

Pakar Isi 

Kandungan 

(Hari) 

Pakar Video 

dan Audio  

(Hari) 

Analisis keperluan 10 2 6 8 

Reka bentuk 10 6 4 8 

Pembangunan 20 8 4 16 

Pengujian dan 

Penilaian 
10 4 6 16 

Pembungkusan 

dan  Pengedaran 
10 4 - - 

Jumlah Hari 60 24 20 48 

 

Berdasarkan Jadual 2 tersebut lengkapkan jadual anggaran kos di bawah. 

a) Kos buruh 

Jawatan 
Kadar Upah/ 

Hari (RM) 

Jumlah Hari 

Bekerja 
Kos (RM) 

Pengurus Projek  60 18,000.00 

Pereka Bentuk 250.00 24 6,000.00 

Pakar Isi Kandungan  20 5,000.00 

Pakar Video dan Audio  48  

Jumlah Kos Buruh  41,000.00 
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b) Kos peralatan 

Butiran Kadar (RM) 
Jumlah 

Hari  
Kos (RM) 

Pencetak dan pengimbas 500.00 5 2,500.00 

Sewa komputer 500.00 20  

Kamera video 500.00  3,000.00 

Studio 1,000.00 2 2,000.00 

Jumlah Kos Peralatan   

 

c) Jumlah kos sampingan 

Butiran Kos (RM) 

Bil elektrik 700.00 

Bil air  

Pengangkutan 500.00 

Jumlah Kos Sampingan 1,400.00 

 

d) Cari jumlah keseluruhan kos projek tersebut. 
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  

Tahun:  

Kelas:  

 
Standard 
Kandungan: 

7.1 Analisis Keperluan Projek 

 

Standard 
Pembelajaran: 

7.1.4 Membuat analisis keperluan projek pembangunan 

produk multimedia 

7.1.5 Mencadangkan anggaran kos pembangunan produk 

multimedia berdasarkan masa dan keperluan ahli 

pasukan 

7.1.6 Menghasilkan kertas cadangan projek pembangunan 

produk multimedia 

 

Bil Perkara yang dinilai 
Pencapaian 

Catatan 
Terampil Belum 

Terampil 

1 

Mengenal pasti aspek yang perlu 
dipertimbangkan semasa analisis 
keperluan projek pembangunan 
produk multimedia 

   

2 
Membuat pengiraan anggaran kos 
pembangunan produk multimedia.    

3 
Menghasilkan kertas cadangan 
projek pembangunan produk 
multimedia 

   

KEPUTUSAN (CAPAI / TIDAK CAPAI) TARIKH 
 

Nama Guru:  Tandatangan & 
Tarikh 

 

Disahkan oleh:  Tandatangan & 
Tarikh 
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MODUL 7.2A 
 

Standard 
kandungan: 

7.2 Reka Bentuk Produk Multimedia 

Standard 
pembelajaran:  

7.2.1  Menjelaskan struktur reka bentuk persembahan 

produk multimedia : 

 (i)  Linear 

 (ii)    Tidak Linear 

 (iii)   Hirarki 

 (iv) Komposit 

7.2.2  Menjelaskan prinsip reka bentuk : 

 (i) Penegasan (Emphasis) 

 (ii) Corak (Pattern) 

 (iii)  Pengulangan (Repetition) 

 (iv) Keseimbangan (Propotion) 

 (v) kesatuan (Unity) 

 

Objektif 
Pembelajaran 

1. Menjelaskan konsep struktur reka bentuk persembahan 

produk multimedia. 

2. Memahami prinsip reka bentuk. 

3. Menyatakan maksud struktur reka bentuk 

persembahan produk multimedia dan prinsip reka 

bentuk. 

4. Menggunakan struktur reka bentuk persembahan dan 

prinsip reka bentuk dalam penghasilan produk 

multimedia. 

 

Masa: 
 
 

6  jam 
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NOTA RUJUKAN 
 

7.2.1  MENJELASKAN STRUKTUR REKA BENTUK PERSEMBAHAN PRODUK MULTIMEDIA: 

 

Struktur reka bentuk persembahan produk multimedia ialah satu proses mereka 

bentuk struktur atau corak perjalanan sesebuah produk. Proses ini juga akan 

menentukan tempat dan cara kuasa kawalan akan diberikan kepada pengguna 

bagi membolehkan mereka berkomunikasi atau berinteraksi dengan komputer. 

Perkara ini dilaksanakan bagi pelbagai tujuan seperti untuk menyampai atau 

menerima sesuatu mesej, menentukan  laluan penerokaan yang akan diambil dan 

sebagainya.  

 

 
Rajah 7.2.1: Contoh Produk Multimedia 

 

Reka bentuk ini secara ringkasnya melibatkan aktiviti-aktiviti yang berikut : 

 • Membina sistem panduan bagi membimbing pengguna. 

 • Mereka bentuk sistem navigasi dan laluan pencapaian. 

 • Menerangkan perkara yang akan berlaku pada setiap skrin. 

 • Mereka bentuk kuasa kawalan bagi tujuan interaktiviti. 

 • Mereka bentuk papan cerita 
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Oleh yang demikian, seorang pereka bentuk perlu merancang reka bentuk 

yang bersesuaian dengan keperluan, jelas, ringkas dan mudah untuk digunakan. 

Bagi membantu seseorang pereka bentuk merancang reka bentuk persembahan 

produk multimedia, beberapa pilihan struktur penerokaan atau navigasi boleh 

dijadikan panduan.  

Secara amnya, terdapat beberapa struktur reka bentuk persembahan 

produk multimedia yang boleh digunakan dan antara yang popular ialah : 

 

Linear 

Struktur linear hanya membenarkan pengguna meneroka sesebuah persembahan 

secara urutan sahaja. Ianya akan bermula dari awal hingga akhir persembahan. 

Contoh: Iklan TV, video, animasi dan laman web tinjuan. 

 
Rajah 7.2.2: Struktur Linear 

 

Tak Linear 

Struktur tidak linear menyediakan pautan atau hubungan antara setiap topik. 

Struktur sebegini memberikan kebebasan kepada pengguna untuk meneroka 

dengan lebih mudah dan fleksibel. Pengguna bebas untuk pergi ke mana-mana 

topik yang dikehendaki melalui butang navigasi. 

Contoh : Laman web media sosial, perisian pembelajaran pendidikan. 
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Rajah 7.2.3: Struktur Tak Linear 

 

 

Hirarki 

Struktur hirarki juga dikenali sebagai struktur pokok. Setiap paparan mewakili topik 

atau tajuk utama. Setiap topik utama pula boleh dibahagikan kepada beberapa 

topik kecil atau subtopik. Subtopik ini juga boleh mengandungi subtopiknya yang 

tersendiri. 

Contoh: Laman web pembelajaran, perisian pembelajaran pendidikan 

 
Rajah 7.2.4: Struktur Hirarki 

 

  

 

Topik 

Bab 1 Bab 2 Bab 3 

Subtopik 1  Subtopik 2  Subtopik 1  Subtopik 2  Subtopik 1  Subtopik 2  
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Komposit 

Struktur komposit ialah gabungan beberapa struktur seperti linear, tidak linear atau 

hierarki bagi melengkapkan sistem persembahan yang lebih fleksibel serta 

memenuhi keperluan produk multimedia. Keadaan ini bagi memastikan maklumat 

yang ingin disampaikan dapat dicapai dengan lebih mudah mengikut keperluan 

pengguna dan juga keperluan semasa. 

Contoh : Perisian Pembelajaran Pendidikan, aplikasi pembelian atas talian 

dan aplikasi permainan.  

 
Rajah 7.2.5: Struktur Hirarki 

  

 

Intro 1 Intro 2 Intro 3 

Menu 

Galeri 

Video1 
Audio  Imej 

Video2 
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7.2.2  MENJELASKAN PRINSIP REKA BENTUK 

 

Prinsip reka bentuk ialah konsep atau aturan yang digunakan pada elemen reka 

bentuk bagi memudahkan pembinaan sesuatu objek agar visual yang dihasilkan 

menjadi menarik, selesa serta memberikan kepuasasan kepada pengguna. Prinsip 

reka bentuk akan membantu kita membuat keputusan tentang cara untuk 

menggunakan elemen-elemen reka bentuk. 

Berikut ialah prinsip reka bentuk: 

(i) Penegasan 

- suatu penumpuan unsur seni atau imej yang kelihatan lebih ketara jika 

dibandingkan dengan yang lain.  

- Penegasan dan kontra mempunyai ciri-ciri yang hampir sama. 
- Dalam karya seni, unsur seni seperti garisan, rupa, bentuk, jalinan, ruang 

dan warna boleh mewujudkan penegasan. 

- Contoh:  

 

 

Rajah 7.2.6: Grafik Penegasan 

- Contoh antara muka 

                             Rajah 7.2.7: Perisian Pendidikan Huruf 

 
 

Penegasan 
untuk menu 
Kuiz 
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(ii) Corak 

- Susunan elemen seni yang sama berulang seperti garis, bentuk atau 

warna berulang-ulang menjadi corak. 

- Penggunaan corak mesti digunakan dengan bijak untuk mengelakkan 

susun atur yang rumit atau reka bentuk yang tidak menarik. 

- Contoh: 

 

  

Rajah 7.2.8: Grafik Corak 

 

- Contoh antara muka:  

 
                      Rajah 7.2.9: Perisian Pendidikan My Clothes 

 

  

Petak-petak kumpulan 
dan soalan diulang-
ulang untuk menjadi 
corak 
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(iii) Pengulangan 

- Penyusunan semula objek secara berulang-ulang dari segi saiz dan bentuk 

secara susunan bersiri, selari atau berjejari. 

- Contoh: 

  

Rajah 7.2.10: Grafik Pengulangan 

 

- Contoh antara muka: 

 
                      Rajah 7.2.11: Perisian Pendidikan Belajar ABC 

  

Pengulangan 
untuk  bentuk 
butang menu 
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(iv) Keseimbangan 

- Sesuatu objek yang mempunyai kesamaan dan sepadan dari sudut berat, 

tarikan, tumpuan perhatian atau berbentuk asimetri. 

- Terdapat dua jenis keseimbangan: 

i) Keseimbangan simetri mempunyai persamaan pada kedua-dua 

belah bahagiannya. 

ii) Keseimbangan tidak simetri tiada persamaan tetapi lebih menarik 

dan mempunyai daya tarikan sendiri. 

- Contoh : 

 

 

Keseimbangan simetri Keseimbangan tidak simetri 

Rajah 7.2.12: Grafik Keseimbangan 

 

- Contoh antaramuka 

 
                   Rajah 7.2.13: Perisian Pendidikan Fun Matematik 

 

 
Butang-butang menu 
disusun seimbang 
dengan antaramuka 
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v) Kesatuan   

- Hubungan antara unsur seni seperti garisan, rupa, bentuk, ruang, warna 

atau tekstur yang membantu dalam menghasilkan karya seni visual. 

- Ciri-ciri kesatuan wujud pada alam semula jadi, objek buatan manusia 

dan karya seni visual. 

- Contoh: 

 

 

Rajah 7.2.14: Grafik Kesatuan 

 

- Contoh antara muka:  

 
                      Rajah 7.2.15: Perisian Pendidikan Belajar ABC 

 

 

 

 

Kesatuan dari segi 
garisan latar 
belakang, reka letak 
butang, ruang 
antara menu dan 
warna yang 
digunakan. 
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1. Komputer 

2. Contoh Produk Multimedia 

3. Kertas A4 

4. MS Word 

 

TUGASAN  

- Murid membincangkan struktur navigasi dan reka bentuk antara 

muka pengguna produk multimemedia. 

- Murid menyenaraikan prinsip reka bentuk yang digunakan.  

 

 

 

LANGKAH KERJA (TUGASAN) 

 

1. Lihat contoh produk multimedia yang dipaparkan oleh guru. 

2. Bincang struktur reka bentuk dan antara muka pengguna yang digunakan. 

3. Melakar struktur navigasi pada kertas A4. 

4. Senaraikan prinsip reka bentuk yang digunakan dalam produk multimedia. 
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LATIHAN/ PENILAIAN 
 

1. Senaraikan dua struktur reka bentuk persembahan produk multimedia. 

 

a _________________________ 

 

b _________________________ 

 

 

2. Berdasarkan kepada soalan 1, lukiskan satu contoh struktur reka bentuk 

persembahan produk multimedia pada ruang di bawah. 

 

 

 

3. Tuliskan prinsip reka bentuk dalam ruang yang disediakan. 
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  
Tahun:  
Kelas:  

 

Standard 
Kandungan: 

7.2     Reka Bentuk Produk Multimedia 

Standard 
Pembelajaran: 

7.2.1  Menjelaskan struktur reka bentuk persembahan 

produk multimedia. 

7.2.2  Menjelaskan prinsip reka bentuk. 

 

Bil Perkara yang dinilai 
Pencapaian 

Catatan 
Terampil Belum 

Terampil 

1 
Menjelaskan konsep struktur reka 
bentuk persembahan produk 
multimedia. 

   

2 Memahami prinsip reka bentuk.    

3 
Menyatakan maksud struktur reka 
bentuk persembahan produk 
multimedia dan prinsip reka bentuk. 

   

4 

Menggunakan struktur reka bentuk 
persembahan dan prinsip reka 
bentuk dalam penghasilan produk 
multimedia. 

   

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 
 

Nama Guru:  Tandatangan & 
Tarikh 

 

Disahkan oleh:  Tandatangan & 
Tarikh 
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MODUL 7.2B  
 

Standard 
kandungan: 
 

7.2     Reka Bentuk Produk Multimedia 

Standard 
pembelajaran:  

7.2.3 Membuat analisis keperluan elemen multimedia 

dan interaksi antara pengguna dalam 

pembangunan produk multimedia. 

7.2.4 Menghasilkan carta alir produk berdasarkan struktur 

reka bentuk persembahan produk multimedia 

 

Objektif 
Pembelajaran 

1. Menjelaskan keperluan elemen multimedia dan 

interaksi antara pengguna dalam pembangunan 

produk multimedia. 

2. Menghasilkan carta alir produk berdasarkan struktur 

reka bentuk persembahan produk multimedia 

 

Masa: 
 
 
 

6  jam 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

  



188 

 

NOTA RUJUKAN 
 

7.2.3 ANALISIS KEPERLUAN ELEMEN MULTIMEDIA  

 

Sebagai pembangun produk multimedia, seseorang itu perlulah membuat analisis 

keperluan elemen multimedia dan interaksi antara pengguna.  

Tujuan analisis dilakukan adalah bagi memastikan produk multimedia dapat 

dibangunkan dengan lebih terancang dan sistematik. Ia juga membina 

kefahaman mengenai persekitaran pengguna sama ada produk yang akan 

dihasilkan dapat memenuhi matlamat dan mencapai objektif pembangun produk.  

Ini adalah contoh analisis keperluan elemen multimedia dan interaksi antara 

pengguna dalam pembangunan produk multimedia bagi CD Pembelajaran 

Interaktif Kanak-Kanak. 

 
 

 

 

 

 

 

  

  

  

  

 
ELEMEN 

TEKS 

 
Saiz teks boleh dibaca dari jarak yang 

bersesuaian. 

 
Menggunakan fon yang sesuai dan mudah 
dibaca. Pastikan fon sedia ada pada sistem 

komputer lain. 

 
Pastikan warna teks dengan warna latar 
adalah kontra supaya mudah dibaca. 

 
Gaya tulisan seperti bold, italic dan underline  

digunakan untuk memberi penekanan. 
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ELEMEN 
GRAFIK 

 

Pastikan saiz grafik adalah bersesuaian, tidak terlalu 

kecil dan tidak terlalu besar. 

 

Gunakan tetapan kesan shadow atau outline untuk 

memberi penekanan pada grafik. 

 

Pastikan kualiti grafik jelas dan pemilihan imej mudah 

untuk difahami. 

 

Pastikan kedudukan grafik adalah konsisten dan 

mudah dilihat. 

 

Memastikan grafik yang dihasilkan menggunakan 

prinsip reka bentuk seperti penegasan, corak, 

pengulangan, keseimbangan dan kesatuan. 

 

  

  

  

  

 
ELEMEN 
AUDIO 

 

Pastikan rakaman audio dan pemilihan audio yang 

digunakan adalah jelas. 

 

Pastikan tempo suara yang dirakam tidak terlalu laju 

dan beri penekanan ton suara. 

 

Pastikan kawalan volume audio rakaman suara lebih 

tinggi daripada audio latar belakang. 

 

Pastikan pengguna boleh mengawal audio untuk 

play, stop, pause dan repeat. 
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ELEMEN 
VIDEO 

 

Pilih kualiti video yang tinggi dan sesuai untuk babak 

skrin. 

 

Pastikan masa  tayangan tidak terlalu pendek 

supaya penonton dapat fahami dan pastikan masa 

tayangan video tidak terlalu panjang untuk 

mengelakkan penonton bosan. 

 

Pergerakan kamera serta pemilihan jenis-jenis 

pengambaran yang baik dan berkesan untuk 

menggambarkan situasi. 

 

Teknik kesan khas menggunakan skrin hijau (green 

screen) mampu menjimatkan kos. 

 

  

  

  

  

 
ELEMEN 

ANIMASI 

 Animasi yang dihasilkan perlulah ringkas dan padat. 

 

Pastikan animasi yang dieksport (rendering) berkualiti 

tinggi dari segi saiz. 

 

Animasi mempunyai pencahayaan yang baik yang 

disertakan dengan bayang-bayang. 

 

Objek animasi yang mempunyai tekstur dapat 

menarik perhatian. 
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7.2.3. INTERAKSI ANTARA PENGGUNA DALAM PEMBANGUNAN PRODUK MULTIMEDIA 

 

Antara muka (interface) sesebuah produk multimedia memainkan peranan dalam 

memastikan pengguna memahami cara untuk menggunakan produk yang 

dihasilkan. Susunan kandungan yang terdiri daripada bahan elemen multimedia 

penting dalam memastikan pengguna mudah untuk menggunakannya.  

 
Rajah 7.2.16: Contoh antara muka produk multimedia  

 

Penggunaan butang memain peranan dalam interaksi antara pengguna. 

Butang-butang asas perlu ada seperti butang ke halaman seterusnya dan butang 

ke halaman sebelumnya. Arahan atau manual pengguna perlu disediakan supaya 

pengguna tahu butang-butang yang sedia ada.  

Butang diletakkan di kedudukan bawah agar tidak menganggu 

pembacaan. Butang replay juga disediakan bagi pengguna membuat 

pengulangan. Animasi juga boleh dilihat sekiranya tetikus ditekan pada gambar.  

 
Rajah 7.2.17: Butang di dalam produk multimedia 

 

Susunan 
kandungan 
gambar & 
teks perlu 

tersusun dan 
sistematik.  

Kandungan 
perlu ringkas 
dan muda 

dibaca 

Kegunaan 
karektor dan 

animasi 
dengan baik 

dalam 
metafora. 

 

Butang kawalan 
audio dan animasi 

Butang 
disediakan 

dengan 
jelas 

kepada 
pengguna 
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7.2.5 CARTA ALIR PRODUK MULTIMEDIA 

 

Carta alir merupakan satu aliran simbol yang dibuat untuk menggambarkan secara 

keseluruhan struktur dan interaksi yang berlaku antara pengguna. Ini akan 

memberikan gambaran tentang perjalanan aplikasi produk multimedia yang akan 

dibangunkan. Untuk membuat carta allir, pembangun bentuk multimedia perlu 

membuat keputusan sama ada ingin membuat persembahan produk secara 

linear, tidak linear, hierarki atau komposit. 

Setelah keputusan dibuat, pembangun perlulah mendapat gambaran 

mengenai bilangan babak yang akan dipersembahan. Setelah semua babak telah 

diputuskan, barulah pembangun dapat menyusun kedudukan babak dalam 

bentuk carta alir. Setiap aliran babak dimasukkan anak panah sebagai simbol arah 

tuju sesebuah babak. Berikut adalah contoh penghasilan bagi produk CD 

Pembelajaran Interaktif Kanak-Kanak secara linear. 

 

 

 

 

 

 

 

Rajah 7.2.18: Carta alir linear CD Pembelajaran Interaktif Kanak-Kanak 

 

 

 

 

 

 

 

 

VIDEO 
INTRO 

MENU 
UTAMA 

BABAK 
KEDUA 

BABAK 
PERTAMA 

VIDEO 
TAMAT 

BABAK 
KETIGA 

BABAK KE 
EMPAT 
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 Setelah carta alir dibuat, maka proses penghasilan produk multimedia dapat 

dihasilkan dengan mudah. Ini kerana melalui carta alir, pembangun dapat 

mengenal pasti apakah bahan-bahan yang perlu ada dalam penghasilan produk 

multimedia. Berikut adalah contoh penghasilan produk multimedia yang telah siap 

dihasilkan menggunakan carta alir secara linear.  

 

                   
           VIDEO  INTRO          MENU UTAMA         BABAK PERTAMA       BABAK KEDUA 

 

                                        
                               VIDEO TAMAT            BABAK KE EMPAT         BABAK KETIGA 

Rajah 7.2.19: Contoh carta alir linear CD Pembelajaran Interaktif Kanak-Kanak 

 

Selain carta alir linear, pembangun boleh menghasilkan produk multimedia secara 

komposit atau secara hierarki. Berikut adalah contoh carta alir secara hierarki. 

 

 

 

 

 

 

 

 

 

Rajah 7.2.20: Carta alir hierarki CD Pembelajaran Interaktif Kanak-Kanak 

 

SELAMAT DATANG 

MENU UTAMA 

 

MAKLUMAT GALERI VIDEO PENGHARGAAN 
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 Rajah 7.2.21 adalah contoh hasil produk yang menggunakan carta alir 

hierarki. Anak panah perlu dimasukkan bagi memudahkan pembangun 

mengetahui di mana arah tuju babak. 

 
 

 

  

 

 

 

 

 

 

Rajah 7.2.4.21: Contoh produk carta alir hierarki CD Pembelajaran Interaktif Kanak-

Kanak 
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1. Kertas A4 

2. Alat tulis 

 

 

TUGASAN  

 Murid merancang dan membuat carta alir CD Pembelajaran Interaktif Kanak-

Kanak 

 

 

 

 

LANGKAH KERJA  

1. Merancang untuk menghasilkan sebuah produk CD Pembelajaran Interaktif 

Kanak-Kanak 

2. Memilih sama ada ingin membuat carta alir secara linear, tidak linear, hierarki 

atau komposit. 

3. Setelah keputusan dibuat, pembangun perlulah mendapat gambaran 

mengenai bilangan babak yang akan dipersembahan. Ia termasuklah 

gambaran babak mula awal, babak kandungan dan juga akhir. 

4.  Setelah semua babak telah diputuskan, barulah murid dapat menyusun 

kedudukan babak dalam bentuk carta alir. Setiap aliran babak perlu 

dimasukkan anak panah sebagai simbol arah tuju sesebuah babak.  
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LATIHAN/ PENILAIAN 
 

1. Nyatakan dua daripada analisis keperluan elemen multimedia dalam 

pembangunan produk multimedia 

Elemen 
multimedia Analisis 

Elemen Teks 

I. ________________________________________________

________________________________________________ 

II. ________________________________________________

________________________________________________ 

 

Elemen 
Grafik 

I. ________________________________________________

________________________________________________ 

II. ________________________________________________

________________________________________________ 

 

Elemen 
Audio 

I. ________________________________________________

________________________________________________ 

II. ________________________________________________

________________________________________________ 

 

Elemen 
Video 

I. ________________________________________________

________________________________________________ 

II. ________________________________________________

________________________________________________ 

 

Elemen 
Animasi 

I. ________________________________________________

________________________________________________ 

II. ________________________________________________

________________________________________________ 
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  
Tahun:  
Kelas:  

 

Standard 
Kandungan: 

7.2 Reka Bentuk Produk 

Standard 
Pembelajaran: 

7.2.3 Membuat analisis keperluan elemen multimedia dan 

interaksi antara pengguna dalam pembangunan 

produk multimedia. 

7.2.4 Menghasilkan carta alir produk berdasarkan struktur 

reka bentuk persembahan produk multimedia 

 

Bil Perkara yang dinilai 
Pencapaian 

Catatan 
Terampil Belum 

Terampil 

1 

Membuat analisis keperluan 

elemen multimedia dalam 

pembangunan produk multimedia. 

 

   

2 

Membuat analisis keperluan 

interaksi antara pengguna dalam 

pembangunan produk multimedia. 

 

   

3 

Menghasilkan carta alir produk 

berdasarkan struktur reka bentuk 

persembahan produk multimedia. 

   

KEPUTUSAN (CAPAI / TIDAK CAPAI) 
TARIKH 

 

Nama Guru:  Tandatangan & 
Tarikh 

 

Disahkan oleh:  Tandatangan & 
Tarikh 
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MODUL 7.2C 
 

Standard 
kandungan: 
 

7.2 Reka Bentuk Produk Multimedia 

Standard 
pembelajaran:  

7.2.5  Menghasilkan papan cerita berdasarkan carta alir 

yang dihasilkan.  

Objektif 
Pembelajaran 

1. Menjelaskan konsep papan cerita persembahan 

produk multimedia. 

2. Mengenal pasti elemen-elemen dalam papan cerita  

3. Melakar papan cerita persembahan produk 

multimedia berdasarkan carta alir. 

 

Masa: 
 
 

4  jam 
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NOTA RUJUKAN 
 

7.2.5  MENGHASILKAN PAPAN CERITA BERDASARKAN CARTA ALIR YANG   

          DIHASILKAN. 

 

Lakaran papan cerita adalah satu tugas yang perlu diselesaikan oleh penulis skrip 

sebelum proses pembangunan produk multimedia dilakukan secara 

keseluruhannya ataupun secara berfasa. Papan cerita hendaklah dilakarkan 

berpandukan skop yang telah ditentukan.  

 

Papan cerita bermaksud: 

● Papan cerita disediakan pada peringkat awal proses reka bentuk. 

● Papan cerita adalah himpunan lakaran rupa bentuk skrin-skrin paparan yang 

digunakan dalam produk multimedia. 

● Dalam melakarkan papan cerita kita perlu mengaplikasi konsep reka letak. 

● Papan cerita adalah lakaran imaginasi tentang apa yang hendak dipaparkan 

dalam satu persembahan produk multimedia. 

 
Rajah 7.2.20: Contoh papan cerita produksi 
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Papan cerita diperlukan untuk: 

● Membolehkan semua ahli projek terutamanya pembangun produk 

multimedia mengetahui apa yang perlu ada pada skrin serta kandungan 

yang dimaksudkan oleh penulis skrip. 

● mewujudkan satu sistem arahan grafik, teks, animasi, video, audio dan proses 

produk multimedia yang sistematik. 

● Memudahkan proses implementasi dilakukan di tempat yang berasingan 

pada masa yang berasingan. 

● Membolehkan pakar kandungan aplikasi, pakar grafik dan animasi, pakar 

video dan pakar audio memahami keperluan masing-masing tanpa 

memerlukan mereka berada bersama pada satu masa. 

● Membantu penulis skrip dan pembangun produk multimedia melakar dan 

membangun produk secara sistematik. 

 

Kelebihan papan cerita 

● Membolehkan pembangun produk multimedia mencambah minda dan 

idea 

● Dapat merancang jalan cerita pada peringkat awal 

● Membolehkan pembangun produk multimedia menzahirkan idea sebelum 

dipindah di atas paparan komputer 

● Perubahan dapat dilakukan dengan mudah 

● Menjimatkan masa dan kos pembinaan produksi 

● Mengurangkan risiko tertinggal jalan cerita yang penting 

Elemen-elemen pada papan cerita mengandungi perkara berikut:  

▪ Tajuk 

▪ No Skrin 

▪ Warna latar 

belakang 

▪ Jenis fon 

▪ Saiz fon 

▪ Warna fon 

▪ Teks 

▪ Audio / Suara Latar 

▪ Video 

▪ Grafik 

▪ Animasi 

▪ Skrip / isi 

kandungan 

▪ Interaktiviti 

▪ Catatan umum 



201 

 

Papan cerita persembahan produk multimedia 
 
TAJUK:   

 
 
 
 
 

NO. SKRIN: 
 

IMEJ / GRAFIK 

ANIMASI 
 
 
 

KLIP VIDEO 

AUDIO / SUARA LATAR Tentukan kedudukan elemen yang disenaraikan di bawah pada paparan skrin . 
 Ada Tiada 
Warna Teks    Perenggan  Animasi   

Jenis Font    Imej / Grafik  Audio   

Saiz Font    Warna Latar  Video    
 

CATATAN :  
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1. Carta Alir yang telah dihasilkan 

2. Papan cerita  

3. Alat tulis 

 

TUGASAN  

- Murid mengenal pasti elemen dalam papan cerita. 

- Murid melengkapkan papan cerita berdasarkan elemen yang 

telah dikenal pasti. 

- Murid menghasilkan papan cerita persembahan multimedia 

berdasarkan carta alir yang dihasilkan, 

 

 

LANGKAH KERJA (TUGASAN) 

 

1. Lihat carta alir yang telah dihasilkan 

2. Melakar papan cerita berdasarkan carta alir yang dihasilkan 

3. Mengisi maklumat untuk setiap elemen dalam papan cerita berdasarkan 

lakaran yang dibuat 

4. Membentangkan papan cerita persembahan produk multimedia 
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LATIHAN/ PENILAIAN 
 

1. Senaraikan tiga kelebihan papan cerita. 

 

c __________________________ 

 

d __________________________ 

 

e __________________________ 

 

 

2. Nyatakan tujuh elemen dalam papan cerita 

 

i) ____________________________________ 

 

ii) ____________________________________ 

 

iii) ____________________________________ 

 

iv) ____________________________________ 

 

v) ____________________________________ 

 

vi) ____________________________________ 

 

vii) ____________________________________ 
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  
Tahun:  
Kelas:  

 

Standard 
Kandungan: 

7.2     Reka Bentuk Produk Multimedia 

Standard 
Pembelajaran: 

7.2.5 Menghasilkan papan cerita berdasarkan carta alir 

 yang dihasilkan.  

 

Bil Perkara yang dinilai 
Pencapaian 

Catatan 
Terampil Belum 

Terampil 

1 
Mengetahui konsep papan cerita 

persembahan produk multimedia.    

2 
Mengetahui elemen-elemen dalam 

papan cerita .    

3 

Melakar papan cerita 

persembahan produk multimedia 

berdasarkan carta alir. 
   

KEPUTUSAN (CAPAI / TIDAK CAPAI) TARIKH 
 

Nama Guru:  Tandatangan &Tarikh  

Disahkan oleh:  Tandatangan & 
Tarikh 
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MODUL 7.3  
 

Standard 
kandungan: 
 

7.3  Pembangunan Produk Multimedia 

Standard 
pembelajaran:  

7.3.1 Mengenal pasti bahan kandungan produk 

multimedia. 

7.3.2 Membina bahan multimedia dengan 

menggunakan perkakasan dan perisian yang 

bersesuaian. 

7.3.3 Mengenal pasti fungsi alat dan fitur asas yang 

digunakan dalam perisian pengarangan. 

7.3.4 Membina dan menghasilkan babak 

(scene)dengan menggunakan alat dan fitur yang 

sesuai. 

7.3.5 Mengintegrasi babak (scene) dengan membuat 

pautan menggunakan alat dan fitur yang sesuai 

dengan menggunakan perisian pengarangan. 

 
Objektif 
Pembelajaran 

1. Mengenal pasti elemen multimedia yang terdapat 

pada produk multimedia. 

2. Membina bahan multimedia dengan 

menggunakan perkakasan dan perisian yang 

sesuai. 

3. Mengenal pasti fungsi dan fitur asas yang 

digunakan dalam perisian pengarangan. 

4. Membina dan menghasilkan scene. 

5. Mengintegrasi scene dengan membuat pautan. 

 
      

      Masa 40 Jam 



206 

 

NOTA RUJUKAN 
 

7.3.1 Mengenal pasti Bahan Kandungan Produk Multimedia 

 

Bahan kandungan dalam produk multimedia ialah elemen-elemen yang terdapat 

dalam sesuatu produk samada CD Interaktif atau Aplikasi berasaskan web. 

 
Rajah 7.3.1  

 

Elemen yang terdapat pada antaramuka Rajah 7.3.1 ialah teks, grafik dan butang 

interaktif. 

 
Rajah 7.3.2 

 

Elemen yang terdapat pada antaramuka Rajah 7.3.2 ialah teks, grafik, audio dan 

butang interaktif. 
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7.3.2  Membina bahan multimedia dengan menggunakan perkakasan dan    
perisian yang bersesuaian. 
 

Untuk menghasilkan produk multimedia yang interaktif, elemen-elemen multimedia 

perlu dibina dan diintegrasikan dengan baik antara satu sama lain. Untuk membina 

sesuatu elemen, kita perlu menggunakan pelbagai perisian bagi memperoleh hasil 

yang terbaik.  

 

Jadual 7.3.1 : Contoh pembinaan untuk setiap elemen 

ELEMEN CONTOH PENERANGAN 

 

Teks 

 

 

Membina elemen teks 

menggunakan  

Adobe Ilustrator 

 

Grafik 

 

 

 

Membina elemen grafik 

menggunakan 

Adobe Photoshop 

 

Video 

 

 

Membina elemen video 

menggunakan  

Adobe Primere 
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ELEMEN CONTOH PENERANGAN 

 

Audio 

 

 

Membina elemen audio 

menggunakan 

Sound Forge 

 

Animasi 

 

 

Membina elemen animasi 

menggunakan  

Macromedia Flash 

 

Butang 

Interaktif 

 

 

 
 

 

Membina elemen butang 

interaktif  menggunakan 

Macromedia Flash 
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7.3.3   Mengenal pasti fungsi alat dan fitur asas yang digunakan dalam perisian 

pengarangan 

 

Terdapat beberapa bahagian yang harus diketahui dalam menggunakan aplikasi 

Macromedia Flash, iaitu: 

 

Menu Bar 

Menu Bar merupakan barisan menu berisi kumpulan perintah yang digunakan 

pada Macromedia Flash. 

 
 

Toolbar 

Toolbar merupakan baris menu yang ditanda dengan beberapa pilihan ikon 

jalan pintas yang dapat digunakan untuk menjalankan menu. 

 
 

Stage 

Stage merupakan bahagian dari Macromedia Flash  yang digunakan untuk 

membuat persembahan atau meletakkan objek. 
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Timeline 

Timeline berisi pelbagai frame yang berfungsi mengawal objek animasi. 

 
 

a. Layer  

merupakan susunan atau lapisan yang terdiri dari kumpulan objek  atau 

komponen gambar, teks, atau animasi. Urutan posisi layer akan 

mempengaruhi urutan tampilan objek yang dianimasikan. 

b. Playhead  

merupakan penunjuk posisi frame pada saat dijalankan. Playhead ditandai 

dengan garis vertikal berwarna merah. 

c. Frame  

merupakan bahagian yang terdiri dari tahap-tahap yang akan dijalankan 

secara berganti dari kiri ke kanan 

Toolbox 

Toolbox terdiri dari pelbagai tool yang berfungsi untuk membuat gambar, memilih 

objek dan memanipulasi objek 

Jadual 7.3.2 : Nama dan Fungsi Tools 

Ikon tool Nama tool Fungsi 

 

Arrow Tool Memilih dan memindahkan objek 
 

Sub Selection Tool Mengubah bentuk objek dengan edit 

points 
 

Free Transform Tool  Mengubah ukuran atau memutar 

bentuk objek mengikut kesesuaian  

 

Gradient Transform Tool Mengubah warna gradasi 
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Ikon tool Nama tool Fungsi 

 

Lasso Tool Memilih bahagian objek yang akan 

disunting 
 

Pen Tool Membuat bentuk objek secara bebas, 

menggunakan titik sebagai 

penghubung 
 

Text Tool Menghasilkan teks, perkataan atau 

ayat 

 

Line Tool Membuat garisan 

 

Rectangle Tool  Membuat objek berbentuk segi empat  

 

Oval Tool Membuat objek berbentuk elips atau 

bulatan 

 

Pencil Tool Melukis objek secara bebas 

 

Brush Tool  Melukis objek secara bebas dengan 

ukuran ketebalan dan bentuk yang 

sudah disediakan  

 

Ink Bottle Tool Mewarna garis tepi (outline) 

 

Paint Bucket Tool Mewarna objek secara bebas 

 

Eyedropper Tool Mengambil contoh warna 

 

Eraser Tool Menghapus objek 

 

Hand Tool Menggerakkan paparan  

 

Zoom Tool  Memperbesar atau memperkecilkan 

objek atau paparan 

 

Stroke Colour Memberi atau memilih warna untuk 

garis tepi 

 

Fill Colour Memberi warna pada objek 

 

Option Tool Fungsi tambahan pada tombol yang 

sedang aktif 
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7.3.4  Membina dan menghasilkan babak (scene) dengan menggunakan alat 

          dan fitur yang sesuai 

 

Membina babak(scene) pertama 

1. Buka perisian macromedia flash. 

2. Tukar latar belakang kepada warna hijau turquoise (#33FFFF). 

3. Klik Modify>Scene untuk menamakan scene. Tetingkap scene akan terpapar. 

 
4. Klik berganda pada perkataan Scene 1 dan namakan scene sebagai ‘menu 

utama’. 

5. Dengan menggunakan text tool, taipkan ‘MENU UTAMA’ di atas stage (pentas 

kerja) 

-Jenis Fon : Showcard Gothic 

-Saiz Fon : 38 

-Warna Fon : Merah (#FF0000) 

6. Namakan layer tersebut sebagai ’MENU UTAMA’. 

 
7. Bina satu layer baru dan namakan sebagai ‘KENALI 123’. 
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8. Klik text tool, taipkan ‘Kenali 123’ di atas stage (pentas kerja) 

-Jenis Fon : Minion Pro Med 

-Saiz Fon : 38 

-Warna Fon : Biru (#F0F0F0) 

9. Bina satu layer baru dan namakan sebagai ‘MARI MENYANYI’. 

10. Klik text tool, taipkan ‘Mari Menyanyi’ di atas stage (pentas kerja) 

-Jenis Fon : Minion Pro Med 

-Saiz Fon : 38 

-Warna Fon : Biru (#F0F0F0) 

11.  Bina satu layer baru dan namakan sebagai ‘KUIZ’. 

12.  Klik text tool, taipkan ‘Kuiz’ di atas stage (pentas kerja) 

 -Jenis Fon : Minion Pro Med 

 -Saiz Fon : 38 

 -Warna Fon : Biru (#F0F0F0) 

13.  Bina satu layer baru dan namakan sebagai ‘GAMBAR 1’. 

14.  Klik File>Import to Library. Tetingkap Import to Library akan muncul. Pilih   

gambar yang sesuai dan klik Open. 

15.  Klik Windows>Library>Klik gambar yang dikehendaki di dalam ruangan  

library dan seret gambar tersebut ke atas stage (pentas kerja). 

16. Bina satu layer baru dan namakan sebagai ‘GAMBAR 2’. Ulangi langkah 13 

dan 14. 

17. Bina satu layer baru dan namakan sebagai ‘GAMBAR 3’. Ulangi langkah 13 

dan 14. 
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Membina babak(scene) kedua 
1. Klik Insert>Scene. 

2. Namakan scene sebagai ‘kenali 123’. 

 

Cara menetapkan grafik sebagai latar belakang projek 

1. Klik File>Import to Library. Tetingkap Import to Library akan muncul. Pilih 

gambar yang sesuai dan klik Open. 

2. Klik Windows>Library>klik gambar yang dikehendaki di dalam ruangan 

library dan seret gambar tersebut ke atas stage (pentas kerja). 

3. Klik Free Transform Tool untuk kecilkan atau besarkan saiz gambar 

bersesuaian dengan saiz stage(pentas kerja). 

4. Namakan layer tersebut sebagai ‘LB’. 

 
5. Bina satu layer baru dan namakan sebagai ‘KENALI 123’. 

6. Klik text tool, taipkan ‘KENALI 123’ di atas stage (pentas kerja) 

-Jenis Fon : Showcard Gothic 

-Saiz Fon  : 38 

-Warna Fon : Biru (#0000FF) 
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7. Bina satu layer baru dan namakan sebagai ‘NOMBOR’. 

8. Klik File>Import to Library. Tetingkap Import to Library akan muncul. Pilih 

gambar nombor 1dan klik Open. 

9. Klik Windows>Library>klik gambar nombor 1 di dalam ruangan library dan 

seret gambar tersebut ke atas stage (pentas kerja). 

 
 

10. Pada layer ‘NOMBOR’, pilih timeline 20, klik kanan tetikus>Insert Keyframe. 

 
11. Ulangi langkah yang sama untuk layer LB dan KENALI 123. 

12. Pada layer ‘NOMBOR’ di timeline ke 20, murid boleh menyisip gambar 

nombor 2 dengan mengulangi langkah 10 dan 11. 

 
**Ulangi langkah yang sama untuk nombor 3 sehingga 10 
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7.3.5 Mengintegrasi babak (scene) dengan membuat pautan menggunakan alat 

dan fitur yang sesuai 

 

Membina butang pautan 

1. Bina satu layer baru dan namakannya sebagai ‘HOME’. 

2. Klik oval tool dan lukiskan bulatan kecil di bahagian bawah sebelah kanan 

projek. Tetapkan warna biru (#0000FF). 

3. Klik text tool dan taipkan ‘MENU UTAMA’ di atas bulatan tersebut 

-Jenis Fon : Showcard Gothic 

-Saiz Fon  : 12 

-Warna Fon : Kuning (#FFFF00) 

4. Pada layer ‘HOME’, pilih timeline 20, klik kanan tetikus>Insert Keyframe. 

 
 

5. Klik layer HOME>Insert>Convert to Symbol. Tetingkap Convert to Symbol akan 

muncul. 

 

 

**Lihat nota tambahan pada penghujung nota 

  

Name : HOME 
Behaviour : Button 
 
Klik OK 
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6. Klik pada butang MENU UTAMA dan klik pada tetingkap Action-Button.  

7. Klik berganda pada butang goto di bawah Actions>Movie control. Pada 

ruangan scene klik pada butang anak panah dan pilih menu utama.  

 
 

8. Bagi mengelakkan scene yang dibina berfungsi tanpa berhenti apabila 

diuji, bina satu layer baru dan namakannya sebagai ‘STOP’.  

 
 

9. Klik berganda pada butang stop di bawah Action>Movie control. Tutup 

tetingkap Actions-Button. 

 
 

10. Kembali ke scene menu utama.  

11. Klik layer KENALI 123>Insert>Convert to Symbol. Tetingkap Convert to Symbol 

akan muncul. Setelah menetapkan tetapan seperti langkah 19, klik OK. 
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12. Klik berganda pada butang goto di bawah Actions>Movie control. Pada 

ruangan scene klik pada butang anak panah dan pilih kenali 123. 

 
 

13. Bina satu layer baru dan namakannya sebagai ‘STOP’. Klik berganda pada 

butang stop di bawah Action>Movie control. Tutup tetingkap Actions-Button. 

 
14. Bina scene baru untuk ‘mari menyanyi’ dan ‘kuiz’ bagi melengkapkan projek.  

15. Masukkan fail audio yang sesuai ke dalam scene yang telah di bina untuk 

kelihatan lebih menarik (rujuk nota tambahan cara menyisip lagu ke dalam 

projek pembangunan pada penghujung nota). 

16. Uji fail anda dengan klik Control>Test Movie/(Ctrl+Enter). 

17. Simpan fail anda sebagai persembahan. 
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**Nota Tambahan  

Cara menghasilkan butang pautan dengan menggunakan teks, grafik dan 

Comman Libraries 

 

a) Dengan menggunakan teks 

1. Bina satu layer baru dan namakannya sebagai ‘HOME’. 

2. Klik text tool dan taipkan ‘MENU UTAMA’ di atas bulatan tersebut 

-Jenis Fon : Showcard Gothic 

-Saiz Fon  : 12 

-Warna Fon : Kuning (#FFFF00) 

3. Pada layer ‘HOME’, pilih timeline 20, klik kanan tetikus>Insert Keyframe. 

 
 

4. Klik layer HOME>Insert>Convert to Symbol. Tetingkap Convert to Symbol 

akan muncul. 

 

 

 

Name : HOME 
Behaviour : Button 
 
Klik OK 

 

Teks dijadikan sebagai 
butang pautan 
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b) Dengan menggunakan Common Libraries 

1. Bina satu layer baru dan namakannya sebagai 

‘HOME’. 

2. Klik Windows>Common Libraries>Buttons.  

3. Tetingkap Library-Buttons akan dipaparkan. 

4. Klik berganda pada Arcade buttons dan pilih 

arcade button-blue, seret ke stage (pentas 

kerja). (Anda boleh memilih apa-apa jenis button 

mengikut kesesuain. Arcade buttons hanya 

dijadikan sebagai contoh). 

 

5. Pada layer ‘HOME’, pilih timeline 20, klik kanan tetikus>Insert Keyframe. 

 

 

 

 

 

 

 

 

 

 

 

6. Klik layer HOME>Insert>Convert to Symbol. Tetingkap Convert to Symbol 

akan muncul. 

 

 

 

 

Name : HOME 
Behaviour : Button 
 
Klik OK 

 

Butang pautan dari 
Common Libraries 
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c) Dengan menggunakan grafik 

1. Bina satu layer baru dan namakannya sebagai ‘HOME’. 

2. Klik File>Import to Library. Pilih grafik yang  ingin dijadikan butang pautan 

dan klik Open. 

3. Klik Windows>Library>klik grafik yang dikehendaki di dalam ruangan library 

dan seret grafik tersebut ke atas stage (pentas kerja) 

4. Pada layer ‘HOME’, pilih timeline 20, klik kanan tetikus>Insert Keyframe. 

 

 

 

 

 

 

 

 

 

 

 

5. Klik layer HOME>Insert>Convert to Symbol. Tetingkap Convert to Symbol 

akan muncul. 

 

 

 

 

  

Name : HOME 
Behaviour : Button 
 
Klik OK 

 

Grafik dijadikan 
sebagai butang pautan 
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Cara menyisip audio ke dalam projek pembangunan 

a) Bina satu layer baru dan namakannya sebagai ‘LAGU’. 

b) Klik File>Import to Library. Pilih audio berformat mp3 dan klik Open. 

 
 

c) Klik Windows>Library>klik audio di dalam ruangan library dan seret audio 

tersebut ke atas stage (pentas kerja). 
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AKTIVITI 
 
BAHAN DAN PERALATAN  

 

1. Perisian pengarangan  

 

 

TUGASAN 1 

      Murid menghasilkan satu projek ringkas multimedia 

       mengenai ‘Diri Saya’ yang mengandungi muka depan dan        

       pautan antara babak (scene). 

      TUGASAN 2 

Murid menghasilkan satu projek multimedia berdasarkan kertas 

kerja yang telah dilaksanakan pada Standard Pembelajaran 

7.1.6 (Analisis Keperluan Projek). 
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LATIHAN / PENILAIAN 
 

1. Nyatakan jenis elemen yang terdapat pada Rajah 1 di bawah 

 
Rajah 1 

 

a)………………………………  b)…………………………… 

 

 

c)………………………………  d) ………………………….. 

 

 

2. Lengkapkan jadual di bawah : 

 

Jadual 1 

Ikon tool Nama tool Fungsi 
 

  
 

 Menghasilkan teks, perkataan 

atau ayat 
 

 Mewarna objek secara bebas 
 

Eyedropper Tool  

 
a 

b 

c 

d 
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3. Bina satu bahan pengajaran dan pembelajaran interaktif bagi satu mata 

pelajaran yang anda pilih dengan memasukkan elemen teks, grafik, audio, 

video, animasi dan butang pautan dengan menggunakan perisian 

pengarangan yang sesuai. 
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  

Tahun:  

Kelas :  

 
Standard 
Kandungan 
 

7.3  Pembangunan Produk Multimedia 

Standard 
Pembelajaran: 

7.3.1   Mengenal pasti bahan kandungan produk multimedia 

7.3.2   Membina bahan multimedia dengan menggunakan 

           perkakasan dan perisian yang bersesuaian 

7.3.3 Mengenal pasti fungsi alat dan fitur asal yang                                                                                                                        

 digunakan dalam perisian pengarangan    

7.3.4  Membina dan menghasilkan babak (scene) dengan 

 menggunakan alat dan fitur yang sesuai 

7.3.5 Mengintegrasi babak (scene) dengan membuat 

pautan menggunakan alat dan fitur yang sesuai 

dengan menggunakan perisian pengarangan 
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Bil Perkara yang dinilai 
Pencapaian 

Catatan 
Terampil Belum 

Terampil 

1 

Mengenal pasti elemen multimedia 

yang terdapat pada produk 

multimedia 
   

2 Membina bahan multimedia     

3 
Mengenal pasti fungsi alat dan fitur 

asas yang digunakan     

4 
Membina dan menghasilkan babak 

(scene)     

5 
Mengintegrasi babak (scene) 

dengan membuat butang pautan    

KEPUTUSAN (CAPAI / TIDAK CAPAI) TARIKH 
 

Nama Guru:  Tandatangan & 
Tarikh 

 

Disahkan oleh:  Tandatangan & 
Tarikh 
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MODUL 7.4  
 

Standard 

kandungan: 

7.4        Pengujian dan Penilaian 

Standard 

pembelajaran:  

7.4.1   Menguji prototaip produk multimedia melalui: 

i. Alfa 

ii. Beta 

7.4.2 Menambah baik produk multimedia. 

7.4.3 Menghasilkan produk multimedia akhir berdasarkan    

           mod atau platform persembahan yang dipilih. 

Objektif: 

 

1. Menjelaskan dua jenis pengujian prototaip produk 

multimedia. 

2. Menjelaskan penambah baikan produk multimedia. 

3. Menghasilkan produk multimedia akhir berdasarkan 

mod atau platform persembahan yang dipilih. 

Masa: 32  jam 
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NOTA RUJUKAN 
 

7.4.1  Menguji Prototaip Produk Multimedia 

 

Ujian ini dilakukan bagi memastikan produk atau prototaip memenuhi kehendak 

yang telah dirancang.  Setiap produk perlu menjalani ujian sekerap mungkin 

sehingga tiada kesalahan ditemui terhadap produk tersebut. 

 

Pelbagai pendekatan pengujian perlu digunakan: 

1. Pengujian konsep oleh kumpulan sasaran. 

2. Prototaip 

3. Semakan semula oleh rakan atau kajian luaran terhadap dokumen reka 

bentuk. 

4. Ujian kepenggunaan 

5. Percubaan lapangan 

6. Ujian penerimaan 

 

Terdapat dua jenis ujian yang biasanya dilakukan untuk menguji prototaip 

iaitu Ujian Alfa dan Ujian Beta. 
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Jadual 7.4.1 : Ujian Alfa dan Ujian Beta 

 
Ujian Alfa  

 

 
Ujian Beta 

● Ujian Alfa adalah ujian fasa 

pertama untuk pengujian produk. 

● Ujian Beta adalah ujian fasa kedua 

untuk pengujian produk selepas Ujian 

Alfa dilaksanakan. 

 

● Ujian dilaksanakan di laman web 

pembangun produk. 

● Ujian Beta dilaksanakan melibatkan 

pelanggan atau pengguna produk. 

 

● Aspek fungsi dan keboleh gunaan 

produk akan diuji. 

● Aspek keboleh percayaan, 

keselamatan dan kekukuhan akan 

diuji. 

● Ujian Alfa adalah untuk 

memastikan kualiti produk sebelum 

Ujian Beta dilaksanakan. 

● Selain aspek kualiti produk, input/ 

maklum balas daripada pengguna 

turut diambil kira untuk memastikan 

produk boleh digunakan dalam situasi 

sebenar. 

 

● Masalah atau pembetulan kritikal 

dapat diperbaiki oleh pembangun 

produk dengan segera semasa 

Ujian Alfa. 

 

● Sebilangan besar masalah atau 

maklum balas yang dikumpulkan 

daripada Ujian Beta akan 

dilaksanakan pada versi produk yang 

akan datang. 
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Contoh Borang Pengujian Alfa  

 

BORANG PENILAIAN CD PEMBELAJARAN INTERAKTIF  
 
Panduan: Bulatkan respon anda. 

                  ‘1’ adalah respon Lemah; ‘3’ adalah respon sederahana;  ‘5’ adalah      

                  respon Terbaik. 

 
1 Teks jelas dan boleh dibaca. 1 2 3 4 5 

2 Grafik jelas dan sesuai. 1 2 3 4 5 

3 Warna yang digunakan berkesan. 1 2 3 4 5 

4 Audio yang digunakan sesuai dan berkesan. 1 2 3 4 5 

5 Pergerakan animasi menarik. 1 2 3 4 5 

6 Interaktiviti ( seperti roll over, klik bebutang ) 

mudah dan berfungsi. 

1 2 3 4 5 

7 Pautan pada setiap topik dan laman yang 

dikehendaki mudah. 

1 2 3 4 5 

8 Ikon dan panduan jelas serta mudah 

difahami. 

1 2 3 4 5 

9 Panduan aplikasi jelas dan mudah difahami. 1 2 3 4 5 

 

 

  

CO
NTO

H 
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Contoh Borang Pengujian Beta 

 
 
 
 
 
 

PENILAIAN CD PEMBELAJARAN INTERAKTIF  
 
 
 
 
 
 

Dengan menggunakan CD pembelajaran interaktif yang dibekalkan, sila  
beri respon terhadap soalan berikut dengan jujur dan ikhlas. 

 
 
 
 
Panduan: Bulatkan respon anda. 

                  ‘1’ adalah respon Lemah; ‘3’ adalah respon sederahana;   

                  ‘5’  adalah respon Terbaik. 

 
 1 Arahan jelas dan mudah difahami. 1 2 3 4 5 

2 Penyampaian menarik perhatian. 1 2 3 4 5 

3 Susun atur paparan skrin menarik dan sesuai 

dengan tahap kumpulan sasaran. 

1 2 3 4 5 

4 Maklumat disusun dengan teratur. 1 2 3 4 5 

5 Butang pautan pada kedudukan yang sesuai 

dan berfungsi. 

1 2 3 4 5 

6 Kesan bunyi yang menarik dan sesuai dengan 

isi kandungan CD interaktif. 

1 2 3 4 5 

 

  

  Logo 
organisasi 

Terima kasih kerana membantu kami dalam penilaian CD 

pembelajaran interaktif ini. Oleh kerana pendapat anda amat 

dihargai, kami meminta anda mengambil sedikit masa untuk 

menjawab soalan-soalan berikut. Respon anda sangat penting dalam 

usaha kami untuk meningkatkan mutu reka bentuk CD pembelajaran 

ini. 

CO
NTO

H 
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7.4.2  Penambahbaikan Produk Multimedia 

 

Penambah baikan boleh dilakukan setelah proses pengujian & penilaian 

kepada produk yang dihasilkan.  Contoh penilaian dari : (5 elemen multimedia) 

i. Reka bentuk skrin menarik  

ii. Teks jelas dan boleh dibaca  

iii. Grafik menarik dan berkesan  

iv. Warna yang digunakan berkesan  

v. Audio yang digunakan berkesan  

vi. Interaktiviti (seperti roll over, klik bebutang) mudah dan memadai  

vii. Pautan pada setiap topik dan laman yang dikehendaki mudah 

viii. Ikon dan panduan jelas dan mudah difahami 

ix. Panduan aplikasi jelas dan mudah difahami 

 
 
7.4.3  Mod atau Platfom Produk Multimedia 

 

Terdapat dua [2] jenis mod atau platfom persembahan produk iaitu dalam talian 

(on-line) dan luar talian (off-line). 

 

Mod atau platfom persembahan dalam talian ialah penggunaan 

teknologi maklumat dan komunikasi atau peranti yang disambung dengan 

rangkaian internet untuk memudah cara persembahan dijalankan. Contoh 

Youtube atau Google Drive. 

 

Manakala mod atau platfom persembahan luar talian merujuk kepada 

penggunaan peranti yang tidak disambung dengan rangkaian internet. 

Contohnya CD atau DVD ROM. 
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Menjadikan Persembahan Dalam Format .fla kepada Format .exe. 

Hasil kerja yang telah disimpan dalam fail Flash dengan format .fla masih lagi 

boleh diubahsuai atau disunting. Untuk suatu hasil kerja yang dipersembahkan 

dalam bentuk multimedia, ianya hendaklah di publish dalam format .exe. 

 

Hasil kerja yang di publish dengan format .exe tidak boleh diubahsuai atau 

disunting.  Format .swf dan .html memerlukan Flash Player yang terdapat dalam 

Flash MX untuk memainkannya manakala format .exe tidak memerlukan Flash 

Player dan anda boleh memainkannya pada mana-mana komputer. 

 

Langkah-langkah : 

a) Sebelum hasil kerja tersebut di publish, anda perlu menetapkan settingnya 

terlebih dahulu dengan memilih File > Publish Settings 

b) Tetingkap Publish Setting kelihatan dan lengkapkan seperti berikut. Sila 

buat pilihan pada : 

● Windows Projector untuk format .exe 

 
c) Setelah Publish Setting ditetapkan, anda boleh publishkan dengan cara 

memilih File > Publish 

d) Anda boleh melihat persembahan anda dalam format .exe dengan 

mencari lokasi fail tersebut di dalam folder komputer anda. 
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e) Bahan produksi multimedia yang telah siap boleh diedarkan melalui 

compact disc (CD) atau digital versatile disc (DVD) menggunakan 

format.exe untuk dimainkan melalui CD atau DVD player. 
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Langkah Kerja Burn CD Tanpa Perisian 

Langkah-langkah : 

1. Buka File Explorer CD/DVD Drive 

 
 

2. Masukkan CD / DVD ROM 

 
 

3. Berikan Title dan pilih With a CD/DVD Player 
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4. Copy and Paste file yang dikehendaki 

 
 

5. Klik kanan dan pilih Burn to Disc 

6. Klik Next untuk proses Burning 

 
 

7. Proses Burning akan berjalan dan tunggu sehingga selesai. 
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8. Proses Burning selesai (Finish) 
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AKTIVITI 
 

BAHAN DAN PERALATAN  

1. Bahan Elektronik 
2. Capaian Internet 
 
 

TUGASAN  

Murid dikehendaki mencari maklumat mod atau platfom 

persembahan produk multimedia berikut:  

 
(i) Luar talian (off-line) 
 

 

LANGKAH KERJA  

1. Murid mencari maklumat berkaitan mod atau platfom persembahan 

produk multimedia secara Luar talian (off-line). 

 

2. Murid membuat persembahan Powerpoint untuk menerangkan: 

a) Kelebihan mod persembahan secara Luar talian (off-line). 

b) Contoh-contoh mod persembahan secara Luar talian (off-line). 
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LATIHAN/ PENILAIAN 
 

1. Nyatakan dua jenis pengujian produk multimedia: 

i. ................................................... 

ii. ................................................... 

 

2. Nyatakan tiga ciri pengujian Alfa dan Beta yang dijalankan terhadap produk 

multimedia: 

 
 

Ujian Alfa  
 

 
Ujian Beta 
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  

Tahun:  

Kelas:  

 

Standard 
Kandungan: 

7.4 Pengujian dan Penilaian 

Standard 
Pembelajaran: 

7.4.1   Menguji prototaip produk multimedia melalui: 

i. Alfa 

ii. Beta 

7.4.3 Menambah baik produk multimedia 

7.4.4 Menghasilkan produk multimedia akhir berdasarkan 

mod atau platfom persembahan yang dipilih. 

 

Bil Perkara yang dinilai 

Pencapaian 

Catatan Terampil 
Belum 

Terampil 

1 
Menjelaskan   pengujian   prototaip produk 
multimedia.    

2 
Menjelaskan   penambah   baikan produk 
multimedia.    

3 

Menghasilkan   produk   multimedia akhir   
berdasarkan mod atau platfom  
persembahan yang dipilih. 
 

   

KEPUTUSAN (CAPAI / TIDAK CAPAI) TARIKH 
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Nama Guru: 
 

Tandatangan & 
Tarikh 

 

Disahkan oleh: 
 

Tandatangan & 
Tarikh 
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MODUL 7.5 
 

Standard 
kandungan: 
 

7.5 Pengurusan sumber dan edaran 

Standard 
pembelajaran:  

7.5.1   Menjelas kepentingan pengurusan fail dan folder    

           bahan pembangunan produk. 

7.5.2 Menyediakan manual pengguna. 

7.5.3 Mencadangkan reka bentuk edaran produk 

berasaskan: 

i. CD interaktif 

ii. Laman web/kiosk 

iii. Aplikasi mudah alih 

7.5.4 Menghasilkan reka bentuk edaran produk yang 

dipilih berdasarkan kertas cadangan. 

7.5.5 Menyediakan dokumentasi projek pembangunan 

produk multimedia yang dibangunkan. 

 
 

Objektif 
Pembelajaran 

1. Menjelaskan kepentingan pengurusan fail dan folder 

bahan pembangunan produk. 

2. Menyediakan manual pengguna. 

3. Menghasilkan reka bentuk edaran produk 

berdasarkan kertas cadangan. 

4. Menghasilkan dokumentasi projek pembangunan 

produk multimedia. 

 
Masa: 
 
 
 

28  jam 
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NOTA RUJUKAN 
 

7.5.1   Menjelas kepentingan pengurusan fail dan folder bahan pembangunan 

produk. 

 

Membolehkan maklumat yang terkandung di dalamnya dikawal dan dicapai 

dengan cepat dan tepat apabila diperlukan. 

 

 
 

 

 

 

 

 

 

Mudah dicapai Mudah dicari 

Kepentingan Pengurusan 
Fail 

Menjimatkan masa Fail disimpan lebih tersusun 

Menjimatkan ruang storan 
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7.5.2  Menyediakan manual pengguna. 
 

Panduan yang mengandungi maklumat untuk melaksanakan sesuatu dengan 

cara yang teratur. Perkara yang perlu ada di dalam manual pengguna produk 

multimedia adalah : 

Keperluan Sistem 

Jadual 7.5.1 :  Contoh Keperluan sistem 

Komponen Spesifikasi Minimum 

Sistem Pengoperasian Windows 7 

Pemproses Pentium atau AMD 

Memori Utama (RAM) 1 GB 32-bit 

Ruang Storan 256 GB 

Paparan LCD Monitor 

 

Rangka asas manual pengguna 

Berikut merupakan beberapa contoh paparan yang terdapat dalam perisian 

multimedia CD interaktif bertajuk Mengenal Rangka Manusia dan Deria. 

Paparan Menu Utama 

 
Rajah 7.5.1 : Paparan Menu Utama 
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Jadual 7.5.2 :  Contoh manual pengguna 

Butang Navigasi Keterangan 

 

Untuk ke scene Menu Utama 

 

Untuk ke Uji Minda 

 

Menghentikan atau memainkan muzik latar 

 

Keluar daripada CD interaktif 

 

Untuk ke scene Rangka Kepala 

 

Untuk ke scene Rangka Badan 

 

Untuk ke scene Rangka Bergerak 

 

Untuk ke scene Mata 

 

Untuk ke scene Telinga 

 

Untuk ke scene Hidung 

 

Untuk ke scene Lidah 

 

Untuk ke scene Kulit 
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Untuk ke scene Sendi Gerak 

 

 

 

 

7.5.3  Mencadangkan reka bentuk edaran berasaskan:  

 

(i) CD Interaktif  

 
Rajah 7.5.2 : Contoh reka bentuk CD interaktif 
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(ii) Laman web/kiosk  

 
Rajah 7.5.3: Contoh reka bentuk laman we 

 

(iii) Aplikasi mudah alih       

 

 

 

 

Rajah 7.5.4 : Contoh reka bentuk aplikasi mudah alih (icon) 
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7.5.4  Menghasilkan reka bentuk edaran produk yang dipilih berdasarkan kertas  

cadangan. 

 

Reka bentuk edaran produk boleh dihasilkan menggunakan perisian 

manipulasi imej seperti Adobe Photosop.  

 

  
Rajah 7.5.5 : Contoh reka bentuk Label CD/DVD dan label kotak  

  



250 

 

7.5.5  Menyediakan dokumentasi projek pembangunan projek multimedia yang 

dibangunkan. 

 

Jadual 7.5.3 :  Senarai semak  

Bil Keterangan Ada / Tiada 

1 Kertas cadangan projek 

a) Tajuk  

b) Pernyataan masalah  

c) Objektif  

d) Skop projek  

e) Sasaran pengguna  

f) Jenis produk  

g) Platform persembahan  

h) Jadual masa  

i) Senarai tugas ahli pasukan  

j) Anggaran kos  

k) Kesimpulan  

 

2 Carta alir  

3 Lakaran papan cerita   

4 Borang hak cipta yang lengkap dan betul  

5 Produk multimedia interaktif  

 

 

6 Borang Pengujian :  

i) Alfa  

ii) Beta 

 

7 Manual pengguna  

8 Pembungkusan produk multimedia ( Label CD/DVD 

dan label kotak )  
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AKTIVITI  
 

BAHAN DAN PERALATAN  

1. Perisian manipulasi imej  

 

TUGASAN  

 TUGASAN  

a)  Murid menghasilkan reka bentuk edaran produk yang dipilih 

berdasarkan kertas cadangan. 

b)  Murid mempersembahkan hasil kerja di hadapan guru dan 

rakan-rakan. 
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LATIHAN/ PENILAIAN 
 

1. Nyatakan dua kepentingan pengurusan fail: 

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________ 

 

 

2. Nyatakan tiga reka bentuk edaran produk: 

a) _____________________________________________________________________ 

b) _____________________________________________________________________ 

c) _____________________________________________________________________ 
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LAPORAN PENCAPAIAN MURID 
 

Nama Murid:  

Tahun:  

Kelas  

 
Standard 

Kandungan: 

7.5 Pengurusan sumber dan edaran 

Standard 

Pembelajaran: 

7.5.1 Menjelas kepentingan pengurusan fail dan folder    

           bahan pembangunan produk. 

7.5.2 Menyediakan manual pengguna. 

7.5.3 Mencadangkan reka bentuk edaran produk 

berasaskan: 

iv. CD interaktif 

v. Laman web/kiosk 

vi. Aplikasi mudah alih 

7.5.4 Menghasilkan reka bentuk edaran produk yang dipilih 

berdasarkan kertas cadangan. 

7.5.5 Menyediakan dokumentasi projek pembangunan 

projek multimedia yang dibangunkan. 
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Bil Perkara yang dinilai 

Pencapaian 

Catatan 
Terampil 

Belum 

Terampil 

1. 

Menjelaskan kepentingan 

pengurusan fail dan folder bahan 

pembangunan produk. 

   

2. Menyediakan manual pengguna.    

3. 

Menghasilkan reka bentuk edaran 

produk berdasarkan kertas 

cadangan. 

   

4. 
Menghasilkan dokumentasi projek 

pembangunan projek multimedia. 
   

KEPUTUSAN 
(CAPAI / TIDAK CAPAI) 

TARIKH 
 
Nama Guru:  Tandatangan & 

Tarikh 
 

Disahkan oleh:  Tandatangan & 
Tarikh 
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A 

Adegan Bahagian kecil sesuatu babak(drama) 

yang bermula dengan tampilnya 

pelakon baru. 

 

C 

Cahaya yang tertrumpu Cahaya yang berpusat atau berfokus. 

Close-up Tangkapan yang diambil dari jarak 

dekat untuk memfokus bahagian-

bahagian tertentu seperti kepala, 

bahu, muka atau sebarang objek lain 

secara dekat. 

 

D 

Drawing Tablet Peralatan input yang membolehkan 

pengguna melukis imej, animasi dan 

grafik menggunakan pen khas iaitu 

Stylus Pen sama seperti pengguna 

melukis di atas kertas. 

Dominan Berkuasa atau berpengaruh. 

 

 

E 

Extreme long-shot Kaedah menagkap gambar atau 

objek dari jarak terjauh. 

 

 

 

 

GLOSARI 
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F 

Flash Player Perisian komputer yang digunakan 

untuk memainkan kandungan yang 

dibangunkan menggunakan platform 

Macromedia Flash/ Adobe Flash. 

 

H 

Hand-held camera Kamera yang digunakan untuk 

membuat rakaman filem atau video 

yng dipegang dengan tangan tanpa 

menggunakan alat pencagak. 

 

K 

Kesan khas Efek. 

Koordinat Titik kedudukan dalam sistem grafik 

yang menggunakan rujukan sudut 

dan jarak dari satu titik pusat sebagai 

cara untuk menentukan kedudukan 

titik. 

Kompleks Rumit, Sulit (Tidak mudah atau tidak 

jelas). 

Kotak dialog Komponen skrin yang membolehkan 

pengguna membuat pertanyaan 

atau mendapatkan maklumat 

tentang sesuatu sistem. 
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L 

Laluan Lintasan tempat sesuatu objek 

bergerak. 

Lensa kamera Kanta kamera. 

Long shot Kaedah menangkap gambar atau 

objek dari jarak jauh. 

 

M 

Medium shot Teknik menangkap gambar yang 

memperlihatkan seseorang berada 

dalam bingkai yang besar, 

contohnya, dari paras kepala ke 

pinggang. 

Mensimulasikan Mneghasilkan semula kedaan tertentu 

untuk tujuan latihan atau kajian. 

 

O 

OS Singkatan untuk Operating System 

yang merujuk kepada perisian sistem 

operasi yang digunakan oleh sebuah 

Komputer. 
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P 

Paksi-x Paksi yang mengufuk dalam koordinat 

Cartes. 

Paksi-y Paksi yang mencancang dalam 

koordinat Cartes. 

Paksi-z Paksi ketiga yang serenjang dengan 

paksi-x dan paksi-y dalam system 

koordinat Cartesan tiga matra. 

Penskalaan Penjelmaan yang melibatkan 

perubahan saiz imej berbanding saiz 

objek. Bentuk imej tetap sama seperti 

objek. Perubahan saiz imej 

berbanding objek menurut skala 

tertentu dan mempunyai pusat atau 

titik tetap. 

Putaran Penjelmaan yang berlaku apabila 

setiap titik pada rajah berputar pada 

pusat putaran melalui sudut tertentu 

dan arah tertentu. 

 

 

R 

Realistik Berhubung dengan kenyataan atau 

menunjukkan keadaan yang 

sebenarnya. 

Rentetan Rangkaian beberapa benda yang 

dikaitkan. 
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S 

Satah Permukaan yang rata. 

Sempadan Tanda yang menunjukkan had 

sesuatu kawasan atau batas. 

 

T 

Transformasi Proses mengubah kedudukan, 

orientasi atau saiz sesuatu objek 

melalui translasi, pantulan, putaran 

dan pembesaran. 

Translasi Pemindahan semua titik pada satu 

satah mengikut arah dan magnitude 

suatu vektor. 
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